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SubrnitAerutriangulation“ NewReconstructiDn‘ ‘ Export“ <

v Capture
[ Block_1
~ | Block_1-AT

(Il 297 photo(s), 0 control point(s), 0 user tie point(s), georeferenced

Overview Photos PointClouds Surveys Additional Data 3D View
~ Reconstruction_1
@ productio... =

N Complete data
@ Productio...

The block is ready for reconstruction.

- N

Productio... Photos positioning level: georeferenced
@ Pproductio...

& productio... 297 photo(s) in 1 photogroup(s), 4.7 gigapixels
@) Productio... 297 photo(s) in the main component
,:\ . 297 known position(s) and 297 known rotation(s)
& Productio... 0 control point(s) (0 full point(s). 0 horizontal point(s), 0 vertical & among which 0 check point(s)
@ Productio... 0 user tie point(s)
. 87167 automatic tie point(s). View
7 A"alys“ Resolution ranges from 0.037 meters to 0.057 meters
# 3D Segmentation_1 Block has blockwise color equalization

Splats: available. Recreate

& Ground Extractio...
@ Ground Extractio...

Aerotriangulation

This block has been edited after aerotriangulation.

View settings | View acguisition report | View quality report
> |ob Details

Review data alignment anchcreate new reconstructions. *_
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L ProjectWise Project Chooser O X
+ Register Project O Refresh View : ‘ * Favorites I @ Recent | _E—- All )

Select a project ©
Number Name Location Industry Asset Type
Prod Test 20121125 EA Prod Test 20121125 EA Buildings and Facilities Airports
001-Dec PWDM 101 Southbank Communications Telecommunications
12012016 Vilnius proj 5 12012016 Vilnius proj 5 Buildings and Facilities Airports
OPModeler_Imperial Bentley Pune Pune India Other Cther
11.25.2015.8.1.1 Windows 8.1 x64 - MS 10.0 Exton Buildings and Facilities Airports
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Job queue
Define the directory where jobs must be submitted for ContextCapture Engine.

C:/Users/Sylvain.Lotteau/Documents/Bentley/ContextCapture Center/|obs3

UNC paths
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When using ContextCapture on a computer cluster, Universal Naming Convention (UNC) paths are required

for distant access to input, project and output file locations.

] Warn when a non-UNC path is used {advised when using a computer cluster)

[ Use proxy UNC path for the project file:
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Reference manager

Check resources, repair or update links.

Filter:

filter paths.

Type
= Image Collection

Local Status

Unknown

+ Local Path Cloud Location  Cloud Status

D:/TESTS,/Tuxford_Scan+photos_Light/Photos 5 pwics (7]

Apply changes  Cancel changes

Update status

Update status and retrieve cloud
properties

Clean database

Removed locally unused entries

Replace in paths...

Apply changes in file paths.

Close
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Replace in paths

Make changes in file paths.

Find what:
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Details...
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"New Capture" H
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MNew Block
Import Block...

Impaort Block from PWCS...
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o cllOI0 2 Bil =0l M Basemap manager 1 &4

ContextCapture 38 AEX} 10/ =



Basemap

2 Basemap_Dam

£ 3D F 0l Ol 0l M Basemap managerS & LI Ch.

s Basemap manager =

Basemap manager

Manage project basemaps.

Name Descripton P Add...
Basemap 11

Globe ¥ Delete
Basemap 20

Basemap 21 |

Basemap 22

Propertes

Basemap 21
Basemap ID: Basemap 21

More detals

Close

ContextCapture 39 AEX} 10/ =



Basemap manager &
N HI0I A8 D16t M, Basemap manager & Hl Al AddE 22/t 4L 3D F 0l A= 2l 012l B0l A Add

basemap= X & I &g L|C}.
Name
HIOIAQH Me | A

FIH HIOIAYO UHol 8 Sot= 0152 L LICH

¥ Add basemap » IEH

Add basemap
Add basemap using Bentley GeoCoordination Services.
Name | | Name
Region of interest Enter basemap name and description.
Data selection 1D: Basemap_23

Neme |Basemap 23

Descrption

<Back &) Next Dowrdoad and import Cancel

IOl A 84 ==Jt: Name I O] X
Lt= 0l Basemap manager CHSHA XM OIS 2 HEE =& JUSLICH

Region of interest

MO HIOIAMO HHRY AL E S & B4 S LICH Region of interest= GeoCoordination ServicesOl A I OIE1 €
QTG HEEH A OOIEHE 28 EH22 A== O Ar=2E LICH

ContextCapture 40 AFEXF 0/ =



v Add basemap » IEH
Add basemap
Add basemap using Bentiey GeoCoordination Services.
Name Region of interest
‘ Region of interest | Enter the geographic extent
Data selection Bounding rec! Import from KML...
X (meters) min | 451582540921 max 4634117720520
Restore default bounds
Y (meters) min 3155814575770 max 3158182.561552
1825,229555 meters x 2367.985782 meters
Spatial reference system: |WGS 84/ UTM zone 17N (EPSG:32617) M
<Back & Next andimport | Cancel

JIE AL 2RI U=
2

SHELICLOIEH

Data selection
HIOIE =52 =& LICH U0l == 0l = GeoCoordination Services Jt

HIOIA S MAES= O ASEH = = deE
KNHE 2ta FANAM 22 32010 IF EEHE 0 ASLICHOFH 010X & X).
41 AMEIL L0/ E
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Add basemap
Add basemap using Bentiey GeoCoordination Services.

Name Data selection
Select layers from avallable data. Data will be downloaded from remote servers then imported, operation time will
depend on the quantity and size of the data,

L.

Layer Number of fles Resolution (m) Date Sze

() FSA 10: 1 NATP Tmagery m_2808. . : 2 filels) 1.061.0 18/12/201301:00 42 M8
[T USGS High Resoluton Orthom... b file(s) 0.1500x0.1500  01/12/2011 01:00 781 M@

g

Teman

Layer Number of files Resoluton (m) Date Sze

USGS NED n20w082 1 arcseco... 1 filels) 27120153087  01/01/201301:00 37MB
[] USGS NED n29w0B2 1/3 arc-sec . 1 file(s) 9.043x10.29 01/01/201301:00 316 MB

© et @ Download and import | Cancel

HI Ol A 24 =D} Data selection HI O X|

FOIOIEIS IR E ¥ 24D More detailsE 22 & LILCH

>.

r
]@
ron

o EH
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v ContextCapture Master [ x |
Selected dataset details

Source Torm of use Stz Preview
SGS NED 129082 1 arc-sexnnd 2013 1x 1 degree IMG ey e s

5 3,75 x 3 75 mnute JPEG2000 Som The National Map . 21 Mot avadable
FSA 10: 1 NAIP imagery m_2008120_sw_17_1 013 20131205 3,75 x 3.75 mnwste PEG000 Fom The Natons Mao ks 21 Nt gvaiable

_1&/ 17: Selected dataset details
{—

o YA ZHR: LIS EAO Lt SEE HEH I U= HAH DTM: GeoTiff, IMG, ASC

e O|0IXIS 2 A0 A8 SEE HAEHIF U= 0l01 Xl IHY: GeoTiff, JPEG2000, JPG, ECW.
SH:
24 FH 2 UI0IH ANOI=28: 83tE): B #2-dstolH deist 2= 248 O0IE It S XIS LICH
LA A MU0 st =0l HFXOI2h B3 ol=H): 2 S MU0 (st =0l #XE HESLICL RS
YA MAS HANS+HS IIBICZ SHAICH=0IE NS M BLE =4S LX) 200 WGS84 EFIA OBt
A MLS A2 XS AEEULC
HOIAHE MH5t= Ol AHEE IO === & &5t] Download and importE 226t H & LICH

ContextCapture= Z & 22 A AHUNM HOIHE TI2Z S0t AI XS OIS S92l E | 3D 9
QU HAIE Mel&LICH &S Al2t2 I0IE 2l 2t AD[0f et Zet& LICH
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CIZHNESF(EZHECIAE W)U 0IRA LEEZ HES 210 "Free up disk space"E S EGIH & |
CHatat XS 6 Al2(OfFeH OI0I Kl & X&), HeloiOF o= S Al I JtEl 12l E M A6t "Delete files"S
HENSIY Al 2.

W Free up disk space *

Free up disk space

' You can delete cache files from your project to free up disk
space.

Files to delete:

Image previews
Aerotriangulation temporary files
Reconstruction temporary files

0 folder(s) to delete &) Delete files Cancel

= e

= M
EA 223D MAN MEE= LA HOIHMER AHX /L= EQE SetRES 2elgLIth 2 g=22
A Lo SLAE D8 S4: 44 320, =8 Hel, =8, d X =/ X: X, &) L AEH HoIE
ScREE 28U
S SSSIIELZ oL £= K H2 MHS M8 = UsLIt
AEIOI FECH 3D THAU AMEE == USUICLUS ZHS SHGHEH ALROI - E A LITH
o OI0IX YOI XN = MY SA(LS AE TS SA FX)0IH &4 &N (2 3R
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New Reconstruction

Submit Aerotriangulation
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Lot AIL.
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J&19: £&

3D View

Additional Data

JO0IA). =5 Ot LT
Z dogLIth

H

(o]
Surveys

Point Clouds

ATE

=13
o
) (0 full point(s), 0 horizontal paint(s), 0 vertical point(s)} among which 0 check poini(s)

)

ition(s) and 2413 known rotation(s)

ic tie point(s). View

Recreate

b=
—/ T

Photos positioning level: georeferenced

The block is ready for reconstruction.

View settings | View acquisition report | View quality report

2413 photo(s) in 1 photogroups), 57.9 gigapixels
Resolution ranges from 0.021 meters to 0.042 meters
Splats: available

This block has been edited after aerotriangulation.

2413 photo(s) in the main component

@ Complete data

2413 known po!

0 control point(

0 user tie point:

562616 automa

Aerotriangulation
> Job Details

Block - Block_1-AT

Overview Photos
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Capture
[ Block_1
i Aerotriangulation
| Block_2 (Block_
> | Block_2 (Block_
L&l Block 2AT
Analysis
Import
Export
New 3D Reconstruction
Clone
Delete
Rename (Edit Name and Description)
Unload
e Import: XML It 0N =2 It SLICH
o Export: CtAEHIIY Aoz 32 HWEYE = ASLICH
e Clone: S22 SHolH SLSHZHOZ TIISIEH M EBE JIsSt S8HS 22 £~ UAsLITH
e Delete: 0|2 Soll A L &S Z86lH RE £ ZH=E MAHELUICH
e Rename: 22 0|2 M&&oID 222 8H2 HISLIC
o Splitblock: 2 &&8 =2 0 FE2 2 LisLUICH
o Extractblock: S8 SS= FE&LIC
e Load/unload blocks: & ZZ2HENA EHES 2E/AZ2ELICH
o Merge blocks: 8118t SEHZ SILI2I M S22 = He LI

Share on ProjectWise ContextShare: ProjectWise ContextShareOll Al 0|0 K|, A2H, gtsF YL HEESS

S=ELICHL

|
ool

>

AN
(=)

ro
4O

I ESYLICL =HE SHoto s2et £d22 T)|ateEl M BE Jtsst

R
ol

o

i
[eZ]
=

$0 X
Oy 0

o %
Lich,

e o
n o
oz

ContextCapture 46 AEX} IH0I &



X
SE0IA Jts8 =2 S& 2 Block Item View2| & & B 0l A OIS It & LICHOtH OIDIXI & X).
X

MEX=SS S S HME, M2 HABD 4, BALAIY S) =0HL =52 W2UWI|I 7ot =
22 (=M, A E g = AsUICh

[SubrnitAerotriangulation“ NewReconstruction‘ ‘ Export“ <

A M = Xl Submit AerotriangulationS 2 2 5™, ContextCapture Engine £ = 22tREUHA 222 HelE &l
g t

C=HE MU OESE L/E= MR EZXRJESE M S Ml AIFELICHE2URE0AM Hel #X).
S0 26t &E &2 SO0 HMHAEN= M2 2SS ML = UASLICL M 4 L 220 2toH
O XEAISEALE 2 A S HXR0IE AL

JEL
S22 General S Sl =3 HAIZEEQ S WA S5 = 2l LI

HAIEE

General Photos Pointclouds Surveys Additionaldata 3D view

Complete data

The block is ready for reconstruction.

Photos positioning level: georeferenced

940 photo(s) in 2 photogroup(s), 18.8 gigapixels

940 phota(s) in the main component

840 known position(s) and 940 known rotation(s)

0 control point(s) (0 full point(s), 0 horizontal point(s), 0 vertical point(s)) among which 0 check point(s)
0 user tie point(s)

35354 automatic tie point(s) View

Resolution ranges from 0.024 meters to 0.027 meters

Splats: not available Create

&/20: 259/ General & [JA/Z =

KNeE 282 HQE MSELICHE S UOIH, &t S).

Cl= 32 =S92 General 812 2LIHYE M= LICL
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AHE

Photos &2 A& MIE ¥ A2t 4 S 2telot= O ASELICH
H1: S0 H2A0l otLE £= 6 i 20 AS S Photos 82 S| M LICH
General Photos Pointclouds Surveys Additionaldata 3D view

Important notice on photogroups: For optimal precision and performance, please check that your input data fulfill these conditions.

HH

4 Check image files...

Photogroup Status MNo. of photos Main compon Camera Sensorsize  Focallength 35 mm ~
Photogroup 1 @ 267 photo(s) 267/267 ph... DJI FC6310 13.2 mm 879769 mm  23.993 Name l:l
Photogroup2 (@) 673 photo(s)  673/673 ph... DJI FC6310 13.2 mm 8.81842 mm  24.050 Directory I:l
= = Multi-camera rig
Photo Pose Pose metadata Component S |:|
Number of photos l:l
Image dimensions l:l
Camera model type
940 photo(s). 2 photogroup(s). 18.8 gigapixels i
&/ 21: £&/ 9/ Photos &
AHEL =D}
FHo dsS A= AHE S O Eﬁ AN S22 LHHEOF & LICH A 52 s 28t LS e 010] Xl
==, dA 301, =8 el 6)5 0ot S2e SclX JtillctZ 2 SE 2| ALK MEJUICH ALY
I AFSE SHHI 2ol T2k 8P-r| Ela—*la ol 2850 UA2H ContextCapture I Al 28 AFR &S
sz 2EE = UASLICL
o2 ALK IF BAIS B EBHYAIR.
OIOIXI CICIEHMIES 0= OiCI&0 Tet MetE = UAsUICHL AZER 0 HICES FXLotYAIL.
» %4l Add photos... j %l Add photo selection...
LS AR IS FEIEILICH
AEIS el i SE4Gted S Shift £= Cerl 1S ALE&HLICH
‘Jﬁﬂ Add photos... 3 ‘ng Add entire directory...
ANE & L/2EC/ S 2= AMTE FIFEILILH=E O F 2 A &
OlBE 2 MEE LA E ROI2ED NEE = EACZ 0l CIAHZIU UAs E= MES FIHELICL
23 M Y SHAS EXGHYAIL.
B:H Import videos... ‘
02 DI 0A Zd| &S F=o010f &0 =1L LY
HICIQ TP IHLIIE AT AIL.
ContextCapture 48 AEX} IH0I &



[T-_'] Remove photosl

HIOIE WA &L E et AN EEE AKX IEE A EHLICE
Ocd i & ERGHE & Shift L= Ctrl 21 S AFEEHLICH

ARl &

AR OE &4
AN JZ 542 Jt0lete] LR 2es HoSLICL3D A= AHY Q8 49 =6 =F X0t
ZegLICholdet =EXe st &S = AsUb

o SEZ &2 S0l 2loH, EXIF D1IEH:'||O|E101|H Mt 2 A FEXRH AIRNA £=
ContextCapture F+ 02t GIOIE{HI 0| A E ArE 0t ContextCapturel Al XS 2 FAHE =~ USLICH
e JIHE &= UASLICHEHE NS M, DHHIEP GIOIEHIOI AU A = OPT IHL Ol A).

e =30z UEE £ UASLILCH
CH= Stoie FHi
AR S 0| CHE ot0iict 212 2201 Jthiet X2 2

£ =MainZ LICH TS Jthiict 28| 280 R=0tdH ==
Olcdet &I I8 25" €32 R+ AtetS Sl 0F &LICH

JtHct 22 R

o SASE: MSEQI Brown2 2= 22 ZEet FASYE FI22, AW HlX L= HH= Al =0
X EetLIct

o O{QtellX:ellx H=20] At Z2 E= et el =0 e st

ContextCapture F+0{l2t 22 0l CHEF XAl SH LHE 2 ContextCapture It 2t S 2 & EGHA Al 2.
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ContextCapture= Jt0ilct A2l IS LO0L0F & LICHL B RE &4 ZJ/= M2 JtE 2 X= LICH
CIOIEAHIOI A0 AFS RE] Jthict 2201 OFS LIS &0 JUX RS 0l ZES ol OF & LICH It 2t
M S &2t K| =otH Digital Photography ReviewE & 2 6t H Lt Bentley Systems J|= X2 0fl

Z 26t Al 2.

A

b oo r

&30: OIS HIOI AN ItHIct 2E O LIE & O }UKX ZSEH QIE H 0l A0l A Bentley Systems0il R&E S
St Mot LICH HAI0 AFSXHS] Ol &2 0l 21 &6t =& & Stillct 22 = CHS ContextCapture
el X CIoIeol AN Zate A LICH

1: HOIT X &2 MA IOt EXIF Ol EHCIOIEH 0l A 35mm0il o &ot=E =& Helot 2 &l 2R
22 2F S IR0 HEE = UASLICH
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M=Z MAE AHE 152 22 ContextCapture= 2 B © 2 EXIF HIEHHIOIE MM =& 7/2/(mm) 2| CHEFA QI
FEXNEFEL > USLILL DZN RS2 2R 0l I FEXE HE L AoH0F &LICH LIS 0l ContextCapture=
SIS AL BUHECH £ I/ Z/E NS FHE = USLICH
2t AFE & 0fl CHol “'/\-I INY/E= =B AHCIENEE XS ATELILCLOIHE 40| =&2E E=R
ContextCapture= 35mm0i|l ol & 6t= =& Hel )t 50mmet 200 JFEELICH A &6 =& Hel 30l A Eal
CE 3 s a2 é%ol AINE = JUSLICL OIS 2R =522 =D Ftilct 82 XIZoH0F &LICH
Ot X Jtlict 22 B et el X =& A0l 2T H U2 =8 Hel ot RAIE LICHOtH & X).
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HotZE It 22 SEO AL HIHA ot X RES D6 RoH ool X =& 0| =& Hel
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2ottt 2LE0ll= AES X 2SLICH

=3
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LIS 0l ContextCapture= &3 A2t SHO 2 B HESHH FHS UNS22 FTHE == USLILCH
H=

MzZ M8 E AL TJE 2| & ContextCapture= J| =X Z &lX A =0] LD 2=
ContextCapture= &3 &2 SHCOZ B HEoIH dE Q=2 M2 FHE &= USLICHL

Oletel = Jtiiet L& 0= ArS & Xl 2 &LICH
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Oetell = Jthict 228 A= 2L S LICH
2ot 220l MESE A EsLICH
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U pPrivwus... |v| Qef UTIPUTL VIUEUS... g RKEIMUVE pruws HCODEL Uuwinisarmnpinny... | e

togroup  Status No. of photos Main compon Camera & Sensor size
jroup 1 (G2

Foup2 @ Add camera model to the database...

joup3 (& : :

Jroup 4 [@ Import optical properties...

Jroup S @ Export optical properties...

jroup 6 ‘Q

jroup 7 y@. Ungroup

jroup 8 @ Set pose from metadata

joups @ Clear pose

Set metadata from pose
Clear pose metadata

Pose Set mask...

3-1210151633189-Cam2;j... @ Compld
$-1210151633203-Cam2.j.. @ Comp!HIEEES

&/ 22: AFX IS0 A ZHH CF GI 01 E 8 O] £ Off 25 Al 2
IOt GIOIE B0l A MF AtStE B0t Al 2.
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MEQ EE L2 0l PEAQAYULILL S =R FHAN H&HAN, = HA 2 X2 MHE
AEL(OHl: ContextCapture I M = EFAF AT EAHUHAM L &3 &2 S2)8H3D HA L

OrA3

AISZ0UA 0I0IX1S SEE 2201 PAIES AR OtATIFHZBE &= UASLICH
sgdset X2 EWTIFFO|0I XIS LICH OtAZ S Z2M4 HAN cHEots ALY HA2 g3 42 S S A
St 2AIELICHL

OtA3=oig ot

o DIAE BHAIRIO HZ: OIS0l "fileName.ext"9! AHEI Q] B OtA 3 MY 2 "fileName_mask.tif "= 0| S0l
NEE DY AN D S L6 CI2E 2l 0l BHXIZ LICH

Oll: "IMG0002564.jpg" M& 2l AL oY Ot A= "IMG0002564_mask.tif "4 OF &F LI Ct

« OIAIS MA CIH2I0N HAZ(SLE X2 AHN 2e): CIEH2I0l [ 22 "mask.tif" L2
Ol CIEhE el 2= 2= At Ol CHet OtA3 2 AtESELICH
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SAE HWE A AN A & 2] & I 2T/

Ol SES AISotH HAE A2 MEE EtALOIOIE 2 OI0IX /X R 3l 8E 283 = UAsLICH
Ol tNMLI|l= MMl S22 S XML £= Excel HAI22 It 29| CHRH LICH

Import positions HE 2 2101 HI0 AKX 2= 02 2dFLICL Ol =722 E-= M2 AXE
LIEtHLH= SIAE Mo M1t 2 =2 AHX S HOEote 22010 2 LICH

AtAlet tHE2 AL L) BEE XY AIL.
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[1#' Set downsampling...]

S48 =E b2 59
MM O2MEEdS Mg EE AS S0|22 2 FEN S¢S SLICLOI JIs2 =3D 22 M4
ZE S JISESGHALL GLEAN 2 -E0I EHLE MEtE AZE N HICIE2 ZFEHUA 2 0101X
CIOIEHNIEE HMelot= O AFSE &= JASLICHL
MIOD2MEES RS [ YA M2 =L X ZSLICH
2= UN2s8S Y6t Z2ELICL
MAE C2MEYS 2D R0 SE2 SLICL

OI0I Xl m< &fol
['ﬂ Check image files...
0/0/ X1 It e 24 20/
Ol =7 SHEHL &4 & 001X IE S A 86| ?lol 2= E AN S HIAEELICH
MetE &= JHXl =2l 2 & Check image file header only (faster) 2/ Load the entire image file (slower).
HolE 2ol 2 E 0I0IX TILO0| BME B oY LS S 0NA MHSHES MCtE LICH

OlI0I Xl Olel £7I
A& S HEIGHD ViewE S& 6t S & & Image viewerZ At S Al 2r st LICH

e inage yiewer - IMG_1192.9G - ol
Zoom w7111 | Weve viewing avem kot 29| Quolty=orgre &
_7&/23: Image viewer
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o LAS/LAZ I} &
e POD Bentley 0! E 22 E Al (pod)

f—\
—
QL
g
—
QL
N
—

S HIE LOE SUREMLS IS M S FXZ AAES XNESHYAIL (e S & Bl JtHS
- ASLICHL

ContextCaptureE AIS0t0 3D A S oI EotAE AW 2IXE 20t0F ELICH &= T 0IA A0 2 XI0

BNAE +==dR AU AXNE 522 Aot HU Y %ﬁ% I E4GHX ContextCapture Ol A S22
e = ASULLOI 32 g8 W2 et e Deet /AXN0A &=t e JHe A0 ol &ot= 2 S0l
SIGHYAIL. AU X E NS2Z 2 XotedSH AH0 X D2 O BHHE 22 &6 d2l& AU
—rI XIQHIZSoHOF 8 LICH B B0l e S HMLE IS ZX JIs2 HS ASE = UKL E !X
StLIEH 2t XIEFLICH
HOIE SR Jl= AMeES HXGHYAIL.
Do AN
HOIE ZetREEs 2HIY AMUAM TS IHE SALZ IHHS &= USLICHL

o ASTMES7 It SA|(e57) - 71X Il L&
e LAS/LAZ It ¥ Al(las, laz) - A& O L&t
e NavVis PLY & 4! (.ply)

ContextCapture 54 AEX} IH0I &



SHAO| ot AR AT HAE Q% AU XIS HYoHs BEO| HAE T (ixt T csv)2 MIBHOF
BHLICH ContextCapturel= 1A E T+ JbY 20| DHEAFS SEHGH0] 0121 SIAE A0 THEH 1% GIOIEIS
=saL0

CO3pE AHAM HESHH HZ2 A2 OIOIE S & ol OF & LICH

[e)
e
= NS BXotYAL.

Impoet point douds from a mobile scanner

Import pont douds nd taeciores cbtaned uing 8 moble sarner

Input ey Input files

Poetoumit Define the Input point cloud aad trajectory fles.
Trajectories and point couds are Inked Shanks to time stamps in both sets of files.

Port douds

A g douds.

JE24: ZHIE AZHOA O/ E S2HFE LT/

Input files

File format
A =S = DS H2ASLICH
NHLI| O H+-E =8GO CI0IE OlI2] EJ1 HIOIZ2 2 €0l 20| U= B2 EHLYEE & =
USLICH

e Number of lines to ignore at the beginning of the file: It &Il 20| & & 2ot A= SO
LAl LICH

e Delimiters: 2 =2 JISE HELICLHH E2NHE XNEFE == ASLICH

o JYMAIAAIN RE IS ZE AEE = & 2= Combine consecutive delimiters & 0| 2 L& 4
USLICH

e Decimal separator: & (123.456) £ = & H(123,456)2 LI Cl.

Data properties

DHIY AMYAM E HEES TOE 2ARE DIUS IIHS [ Hetst B2 &F AIAHES NFHIAIL.
HOIE 22tRC U XS SUSH B2 AT AIAH0 04 0F BHLICH
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Fields
HAA COIEHN CHet 2 9
C|

1&/25: SZ CI0I L L2H0NA I &2 ZOIE ZCFRES 0

SEEMNE AN £= HEO| U= CrLst AH AAN W0t AM MEZ REELICH

oao'm|

Coly wode

_1&/ 26: Point Clouds &/

FIX= =22 3D F BOlA ZAl OtsELICH

J
e
o
Hel
e
Im
iy
o
40
In
=)
| >
E3
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1827 2 ZOIE FofRPE IE9 AW £ AT E3D L/AZ4)0/

A RE
Ol S4S AFSGHRI DI EOIE SRt WM AHS JHs et 4 0fl et H2HE 3D 220 HQIE 2212

3DCIAZSHOI K A et Mat AAS HdEE = JASLICH

=

e Use color: RGB 2H &b gf
e Useintensity: 2% 22 AIE0dt 12
e None: LQIE MAS 2

B Soil =50 R SEE L AN XNE Met 2240 22 ZZ U0IHE 8ot AU ZAIE =

0 =20 MAH0| MAHEH Surveys &0 210 8 LICH

ContextCapture
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RO & FOt
1. Add Survey PointE 2& &L|Ch.

= Add Survey Point

2. Name= &2 &LICH

Survey Point X
Name: |Control Point L
Enter known 3D coordinates of one point
Type: | Control Point v located on photos. Used to register the
3D scene.
Coordinate:
WGS 84 N
Longitude: Latitude:
Height:
A Flease enter 3D coordinates, Create l Cancel l

Survey Point CH 3t Xt 2| Type0il Al "Control Point"E & B4 &t LILCH.
3. 3D MHHS LHELICH

b2 3D M ESE AEELICH

i
H
i
>
2
.
e
Je
I
b
=
o

=
"Local coordinate system” A|AEIS AFE0H0 2o &P L= 2HE HRAZ2 & HFXEK E2 MHES
OlE:loE!- A OlAthl.

4, CreateE 22/ &LICH

M HAH &0l ==0il LIEFE LICH

5. B2 MM FIHHOIE SH(EF, B2E, 28 )8 #TE + USLICL

(= = ) T = =

6. ALZIOI S E S BHXIELICH
SO HEAIE ALY S HE6HD St DFHZ2 AR 91 XIS & 2|8t CHS Accept positionS
S SLICHE = shift+ 222 AFE0HH AN OIA 2 E X £ F).
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Y

1&/29: At OIA #/ X &</

O ZO ARG IXIS BTG53 919 B &M E BI=GHIAIL,

#1: =2 2 UI0IH0IM HHZ DDl Mel SEE WEM o SUCHL"ZE 2 BAl £2°,"0l0IX EAl S&°,
2 "UIBIAOIE U BEZ J1)I"E EESHAIAIL.

RIOTE JHE 2]
CHS & JHXl 2 o2 MBS NS 4 ASLICH

e SHIIAIIAIS: HOE2 =28 22 €22 = ASULLL =5 M2 E X0 AIL.

O =2 "7 ©

e Surveys & (Import HE)HIM It 2 HHE SIAE T AFEZ
K& &= 842 TXT/CSV & ContextCapture Surveys(XML) & LI Ct.
NEE = MOE IE2 )2 s XYZ HEI SHe2 22E MW E 3D RAXE LhEot= & TXT
ol LICh
HOE A E @Y ME:
GCP_A 315796.627695945 4869916.09237971 627.8
GCP_B 315332.029686681 4870703.80261219 738.9

GCP_C 315483.66078491 4870210.48269584 833.2
GCP_D 315399.200463097 4871212.13895964 906.5

DPI:IQJI OLHEAIE Sol H8T2 22 15 €3S Z80t0 AENZ A= ¢t ENASEN 2 HAE

A= JPH%#%‘QLIEL

HOESIIHS [ SHIE 32 HX AAE(SRS)S HEM =X SHQIGHYA (S &L AIAE HX).

ContextCapture 60 AEXL IOl =



& Google Earth
| Eichier Edton  Affichage  Outis  Ajouter  Aide
| ¥ Search D M

l! Rechercher

| Itinérawe Mntonque

Lat 48 8248° Lon 241403°
EMipsoid height 94 5546 m
49 measurement(s)

Minérae Vo3 co ey - A
Rank de ce ey

» Lioux

» Col Galerte Google Larth >

7&/ 30: Google Earth 0| A2/ 9/ X/

HMOE &4

AL
=5

HOE 540 HMAGHAH EditSE 2 & LICH

Name:
9001

Type:
Control Point -

Coordinate:
WGS 84 >

Longitude: 6.53589498

Latitude:  46.65644157

Height: 573.32500000

Check Point: [

Category:
Full v

Horizontal accuracy:  0.01000000

Vertical accuracy: 0.01000000

=

JE31: HolE =4
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Name
MOHE el AL

Coordinate

A EMEEMAHEY ER S X ANALNH A INEEH0 SHo| ZEIXN L2 R M= =0II}
Ol BRI Ml =012 XIZHOFSHLICH 0E S0, WGS84 & X A AEC AR EIR M =012 2206l 0F & LICH
AAE0] WGS84 + NAVD 88 KNI 20|E =0/l AR oll&=H =05 AF=0lOF & LICH

AAHS HE2 22c 2SS X0t A2

HE ZEWAM HHE 3D RXE HEELILH ZHE &R= S8 ZHEAN Tet CHELICH

e Local coordinate system: X, Y & Z0fl CHolf S &t &<

o WGS84: AZ 2 BT (&), EF A =0I(0IE).
e Other: OIH &2 X, YL =0|(H 4B ZLHE A0 [HS).
Check point
HHES ZAN2F AISOIHH O SES EHSELICLOI ERES AU 2 SOHHAHEO DX
orAuu
Category

e Full: XYZ ZEIt MEBELICHOIEZD).
e Horizonta: X ¥ Y X &
e Vertical: Z R HE 0+ At ELICH

Horizontal accuracy

HMOHES XL YMEO CHoH =& &S E =HAELICH

FECIIH =2 MOHE0 €3 42U SHUM O X2 ISXIE 2 SLIChL

Vertical accuracy

HMOE ZEHEN ol FHE HEEE ASELICH

FETIH =2 MHE0 &3 &L SSUMH X2 IISXIE 20 LIt
HEE

&1 =0 20| MAEEH Tie points & 0| | &S LIC

Survey BHOIA= MEL BEE, S AMENI =522 st B&tE 2 22| & LICH ContextCapture il A =
S UL SHOIZANASH RS = NS ESES NS e = AsULL"ANS EEE"S

BEES S FIGHAHL It E = USLICL ESE M| A8 S FXGHY A L.

ContextCapture 62 AEX} IH0I &



=2

Al
<0
m 0
X0 100
0 Ol

Ho Ol
00 O]
o1 0%
OF <+
R0 o
7o) 040
o <
™ 3

) oD
= KD

|E ol Zot= CIOI2E AL

X

il3

ar

K

-

<0
00

K

oF

KJ

ioll
s

-

oJ
E

N

g Xl S0l SHHE AtE S

KIr

YLICHL ?IX X E Mg £AHe2

}

2 %)

3

e

I Xl XIE Xl
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o
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2D B0l A 3D &

MH5

ol
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2 L2 LD & X)),

=
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USLICH

22
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AMELEHEE FII
1. Add Survey PointE
= Add Survey Point
_I

ContextCapture
2. Name=

ol JHE MEX &

A E2 S0l

i

_.u_
iK0

—

AFE A} IF0]

] Cancel
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Create

Identify one point on photos. Used to
v | create positioning/scaling constraint, or

to stitch photos.

10l 2 =0l LIEFE LICH

User Tie Point 2|

Tie Point

Name:
Type:

Survey Point

3. Type Tie PointS & &4

ContextCapture



5. APRIO HE &S BRI LICH
HES HZAotE S AR S HEioHtD St M OFAHZ ALXIOIA fIXIE &2l CH2 Accept position=
S LICHE = ShiftE =210 SEI6HH AN UM 2E 2K £ ).

Ol &2 ALMOIA 2K

”—r
2-||_|
(1
B
H1
i
I
=
%
A
-
[w)
f
il
NO
ua]
=
H1

=" "0I0I Xl HAl S4",

1: &= & UIO0IHOIE BHZ I =
= "L1|t||31|0|’q 2 BIZ OP|"E & Xotd Al 2.

FEE AR

s Tl 2oz 388

= o

o
A=)
=
Mo

= ASLICHL

e Survey & (Import HE

Ol M Dt X 2 ContextCapture = & It (XML) AHS
o SYIIHLII AIE: AMER E

= =g Ite
Hetd0l =2 322 2R = USLICL =2 A LI E HXGHYAIL.

X XE M x=A

PIXNKNE Met ZH2 ASXH ZEE0 JIetet AR /et /AHY M AFZRJLICHL OIS Mgt ZH2 &3
a2 =S S22 NE SES +dot= 0l AEELILL
X XS Met ZH2 &E &2 =& S0t "Use positioning constraints on user tie points" 2= 5 AIE &

=

paS |
=

o
0
e

FEH/E=E Y /RS (FEsEE ) = AsUICL

ContextCapture 64 AEXL IOl =



+ Add Constraint

% Onentation Constraing 4
% Origin Constraint F
& Scale Constraint Fd

& 32: X A E Het X2 F=9 0

AN HE =AH
Add constraint type > Origin constraint
MOE AT HME =20| EMote 2 2 & NSt ZAHS FIHE 2= ASLICL 2 F 0=(0,00)0 ol Zdot= B S
SEBLICH
A Mg xA

Add constraint type > Scale constraint

T AR BE Hd8iot) &= 8 At0I2] HelE NEELITH

2D A= B el HRIE HEioD, &R0 Z2 & Xl &2 & &E S "units (arbitrary)"E AtE & LICH
Ol AL et £2AHE FIOHE = ASLIT

Add constraint type > Axis constraint Orientation = J| 8t M &t =2 2 LI C.
SO B AL B = &K, 00 50| & ABH(AWA BZ g8t SIhH= & LIC

cC

4

r
L

]
rin
ot
ul
=
ro
P
ry
=)
r
=
ol
rr

\J

A

22(

rr
OEJ

N

r&"
+>+

)= RIS EZAS FIhe 4 AL
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3H Hst =
Add constraint type > Plane constraint Orientation
g Bt Ajat 2218/ LICH

OIS NFOAN & M N S F NS destLich

Export HES S0t S OhYst It A2 LHEYWLICH
# Export surveys - oiEl

*  Export surveys

Export control points, tie points and constraints.

Output file and format

Format:  ContextCapture surveys file (*.xml) v
File: |_quarry_switzerland/mining quarry/Block 50pc - Surveys.xml
Options

| Control points
Tie points
tial reference systen ocal East-North-Up (ENU); ongin: 46.654( ~

Constraints

© Export || Cancel

_J&!33: Export Surveys [} 3t &/ T}

ContextCapture 66
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M ELE HMAHE L= &8 & (ContextCaptureHl Al 3D AXE FHE = UA=FR)SKML 2 E LHE L
= USLICHL JH8 0l Y S AMESHH ol & S E&E GIS &+ £ = Google EarthOll Al Al 2f3HE &= JUSLICH
& Googletath T -
| Fichier Edition Mﬂc:aqe Outis  Ajouter Aide
| ¥ Search
" Rechercher
Lat 48 8248 Lon 241463°
Elipsoid height 04 5546 m
49 measurement(s)
Mﬂil..w-ﬁ
|
» Lioux
» Cal Galerte Google Larth »)
=
HAE Y
MOHE £= & & (ContextCapturel 4 3D RIXE FHE = A= ZR)2 0N HEXK Y, Z)0t Z&t= e
BAENIYZ WEY &= JASLICH
SYHYAE Y ME
GCP_A 315796.627695945 4869916.09237971 627.8
GCP_B 315332.029686681 4870703.80261219 738.9

ContextCapture =& I} 2! (XML)
CESZUOIHEEE S8, MR AX L /X XE M =H Ze)= XML EACZ LHEY &= JUSLICH
ZHYL EIANETR

=2
— oo

=Pl

Jon

=5t
/=

o

ContextCapture

Photo's filter

Oleigt SE = ALSotE AL S50 2HE 58 = ASLICL

ContextCapture 67 AEX} IH0/ &



Status filters

ct
S

H

KIr

0

In Use

Potental Matches

All

&0l CH
Potential Matches

KIr

o)

7

LICH.

=

S

ALESHH Al

=

=2

S=H2 AMEItsE AKX XE oIy
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al
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S HOE MEE 20

s
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i10J
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K KIr
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0l0

10: Potential Matches Z! &

F

o

PN

A& 2 MelZl Xl & s IC

I=R=%|
="

0
il

-/

HOZ U B RE).

3

JEL
& 2AI).

k=l

LI CH

y

=

AELICH

1T
e

G =20

Distance from point: M & 2| B Jt& JH)H2 AFE 0l H A

Alphabetical: At

ContextCapture= &M S 0UI0IH Z& 0|

In Use
Filter by name

i

ioll

—

AFE A} IF0]
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OI0IXI EAl &
AIDAEZEMNEN F2AE = A= Z LA 001X HEAl SESLICH

S E2 EMA X EAl/S D10

SHH BAE 24eot 3 MHE X S9S 2X HAIGHHL SEHE S22 88 LICH

View Settings

On Position Accepted

Move to next image: disabled

Display
Potential positions for other surveys: enabled

Magnifier window: enabled

"Move to nextimage" S&0| 243 E AR S ARG HEHIAS W OI0I XDt S22 A ELICH M
OI0IXI= 01212010l EAlS= TS O0I0INLLICLHE S0, B XIS ZATD= B3R U222 2EE
OI0IXl= ChS &M= 0HXI Ot ELICH

"Potential positions for other surveys"Jt 2 &8 3t= 2 S AN EHESZ HA

HERSt ZSEOl AR A XX OtAH (et et &H EAIELICLOE SS2HE2 32 A 2 X0t
TS O 2 N EAIZLICH

D2 YHS I|FO2 o6t M DS BEGIAM X M 2 AU S X

Ol ot ISR EEES Hoote T2 HASE MR HH JSE =~ JUSLICH

HIBIAHIOIE & BEZ J1D|

Ot MO SHE S gl S2otd® Z Ot BIZ2 I E MEE &= JASLICHL BIEZ2 EAIZ2 UIHIAH 01 &
HE Ol 25 XtAlISl €8 =0 ASLICH
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+

B Surveys Mining

Block - Block_1 (Blockimport_Q

Submit Aerotriangulation‘

uarry)

v Capture
Active Il er tie point eoreference
Block_1 (Blockimport_Quarry) -
Block_1 (Blockimport_Quarry) - ... Overview Ph x
Survey Points
Add and edit control points, tie points and positioning constraints
SHORTCUTS
Manipulate the image
+and - keys Zoom infout on the image
e Zoom infout on the image
F Zoom reset
Modify the measurement
Shift + Click Move the current measurement position to the clicked position and
accept it
Shift "’E%E] Move Up/Down/Left/Right the current measurement position
Enter Accept the current measurement position
Delete Delete the current measurement position
Esc Reset the current measurement position
Change the current image
@ Move Up/Down/Left/Right in the thumbnails view to change the
O selected image
Change the current survey
Alt+ % Move to the previous/next survey
l Add and edit control points, tie points and positioning constraints. @)
IEE SHCZ WE ?IX N8 € &8s =28 80| JtsELICh
S SEE2Alt+ ?5/0tHE statdz HEE = UASLICL 0t I Z 012/ 20| MOIE St H JI2
Ol=ot0d M OIDIXIE Nl &8E &= ASLILH
=& 2t
S A= 2 HUE BEIIE AMEoH ?IX NE SES 22lotAU X E AEE = UASLICH
2 ASEE=2Z AN UE SHE INNMLALI =2Z2E SHE JIIAS = USLICL
S 2INMUANS2L SHE IIHS = UsLI
=2tAN S22
Qoo o=/
A=PHYZH 20| ol SHEINNS 4 YSUCL HES R0/ T2} 22 ZH O M40
NEEUD(MEE 2 HX)
S= =R 2F0AN FOtSHE =g = ASLICH
» |9011
» | 9016
» | 9017
S S0 32X B0 NFE 2 L =7 &)
70 AFEAL IO/ =

ContextCapture



=2 YA
ReportE 22! 6t Survey reportS E A& LICH
Report [ %]
Control points User the points
Number of points: 7 | Number of ponts: 0
-~ RMS of repro). error: 0.03 px
RMS of 3D erroe: 0.003 m
= RNS of 3D horontal error: 0.002 m
RMS of 30 vertical erroe: 0.001 m
Control points 2
Po: 2 Coordnate MS of 3D eror 3D hon al 3D =
Name m‘) Caeegory (L:r(\o) (l:() (Heght) ::'sw: ac’c.:::‘[‘:v] Kc\::gj[m eror [:.;']u) [m] enor"[':: «vm
1 %017 S LT ] 6.5426002 4665364415 465,026 WS 84 o0 00 00885161 0.0041865) 0.00410087  0.00021762¢
2 9016 3 Ful 65006580  46.65305217 455,266 WGS B4 0.0 on 0.0101632 000176346  0,0012488 000125891
3 9012 s Ful 654184116 466532532 460 996 WGS 84 00 o 0.034153¢ 020310791 0.00292581 000104828
4 9011 3 Ful 654370093 466553795 473329 WGS 84 001 o 00256742 000218388 0.00175522 0.001294
5 9004 L] Ful 653314731 46A3ARI4TE 65059 WGS B4 o001 00 00077504 0000346626 0.000295391 0000181366
6 9002 3 ol 653511384 4645058875 568.726 WGS 84 oo o0 0.0081386 0.0022435 0.00223462 0.000199373
7 9001 4 ol 650560458 4665644157 s WGS 84 oL 00 00332343 000255622 0.00207885 00015554
S XE
MES 2Kt
HEY X &)U LICH
SLEEFUH=C2 720 M 0l 8t (E= 0l 8t RMS)0l (et A4 40| XI & = LICHH
Reproj. error{px] Accuracy Co
level code
[ unknown|  unknown| blue|
| <1 px| high|| green|
| [1 px, 3 px[|| medium||  yellow|
| > 3 px|| low| red|
3D Xt
KN&EE 3D XA F=HE 3D AKX 2t2 HEl(0IE E£= )2 LI
A IE! Q i|-
XN&EE 3D XA F=HE 3D AX 2t =8 Hel(0IH L= &) LI
A Il 9 il.
XN&EE 3D X2t =FHE 3D AKX 2te =& He| (01 L= SN LI
ContextCapture 71 AEX} IH0/ &



S243p

3D 7 EE Soll AEX= EE

S8 3D/ BH== %@.EI AtZ Jtset CIOIE Ol et EctELICHL 2= HA

Display Styles

> Photos

Survey Points

» Generated Tie Points

ContextCapture 72
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Display Styles
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Display Styles

V' Annotations T

Types: | Al v ]

Classes: | All v I

> Photos o
Survey Points =

> Generated Tie Points =

> Splats Not available. Create &
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Lock on Photo

Lock on Photo:

Activate this mode to view the scene through
photos.

W rhoto Overlay

Opacity:
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Photo Navigation

Photo Navigation:

Activate this mode to browse the scene and
photos by selecting points of interest. Best
suited with 3D view and photo panel displayed.
H Auto-Sync 3D View
M Auto-Sync Photo Panel

B Fast filtering (ignore occlusion)
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View Settings

Camera

@ Perspective O Parallel projection

Background

® Gradient (default) © Color

Color: -

Display

Grid/Axis: enabled
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Measurement
o Location

& Distance

= Area

= volume

e Location: A & & ZHE H Ol A

e Distance: & & AI0|2| 3D Hel &
Area: (A& HE L S0 20
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Quality Metrics

v Scene (3)

Quality Metrics

Current Metric:

Coverage Resolution

Surveys (2)

Resolution
Colors represent the resolution for each point
position.

Position
< S ntrol point
Automaticaly setlayer visibility uncertainty Cd?stngu%?)n

Photos (5)

L":’CE;S;;:: Tie points number Camera distance  Input rotation error  Connection graph
ty to input positions

Current Metric: Resolution

— A EHULS S220t0 N E2 &M SF 0l HAIAELICH
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Quality Metrics LH31 A/ A= S X H L A8 Jtset 2

HieteE XI5

1. Scene
e Coverage: 2t HHE S 2 = Y= ME =2 UHEHHLICHL F10: AHO0| AL D, BEH2TE
S0l ool sHX EHE AN AIOHH A= ZBR E0l= 3192 2t=&LICH
e Height: 38 & &80l oS =& X0 et Mats XZ U
e Resolution: & 2 &t &E 0l CHEH X & oA S (3D &R/ HANE HAIRLICH
2. Surveys
e Position uncertainty: 2t S & 2| 0|0 Al 2 X0t S0tLH ZEEHKIE AMAEZ HSSHLICH
Z2E =22 &F A= AXOL S0tL RFEEEXE HEHHLICOISE S floi 2902
ZE). M0 XNEE B2 I RE&st ger A olE 212 ZAILICHL &0 ZE

t
. Controlpomtdlstnbutlo MAE jé*é.”é.* Ol HIHEOIAM L0t Hel B0 A=K E LIEHELICL
Ol HelS HlAtSAS, AHY L AR 2F 23S DASUICL E0: ZHU MAHE 0l U= K02t
018 Jts&LIth

3. Photos
e Position uncertainty: ContextCapture Z & ot 0t FHE ALY IXIHM HE K etk E
LIEFRHLICH AFR =22l £ A= 9IX2 SEEEE LIEHLICGOISAE S fIof AAH L
SEE). MM NEe B2 Ot 2 et e Y olled 2IIE EAIZLICH

e  Number of tie points: At8 0l A Z = HEE =0 et ArM Ol MaE XIEELICH
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e Distance to input positions: 212 2| X| 2+ H| &HE AHE A
*ﬁ”’\*g FIJIE UHEHHD A2 2K HE SefsS LIEtELICH & 10: &= !Xt HZE
SL02olZ JtseLICh

. Dlstance to input rotations: 2= 3| M 0} Hl AtE AL S| M ALOI S| XHOIE LIEFHLICH M al=2
2t& XHOIE LIEHHLICHL & 10: 2= 3| ™0l S 3<R02 018 Jts& LIt
e Connection graph: At&! 2t @32 EAIELICL S AN 2 EEE0 SSH2Z J=ZR M
HOHEELICH
4. Tie Points

e  Number of observing photos: 80| 20|= ALE HIE W CHoll REH 2}
HO|ot= Ol AAEE AFX =5 LIEFHLICH 230l CHE 28 st 32 E M35t = 01=
CIOIEHE ZEEolJ| ?ol Hz gt0l AHZSE LICH

e Reprojectionerror: 2! Z&tE 0| (& HE HEH LA E LHE

e Position uncertainty: 80| 20| = AF&I0fl CHoll B2 HIAE JHE HEHE XS 2EHEEE
LIEFRHELICE Ol X HE= M4 E & & &0l ContextCapture Z X3t 0| F HOtLE & BIXIE
A=Kl et JIXIE 20 SLICH

e Position uncertainty vector: 't 2 &0| & & X2 Y S Y& E BHF1,
HIE O 20l X MA2 0| REEEC R2E LIEHELICH

=< o

=JHdl0lH

Additional data i = Soll &3 &2 S0 AIESEl= &S0l e ot XA S BESH AU HEAE = UASLICHL

&0 S0 MAH 0| MH ™ Additional data 80| 40| 8 LICH.
General Photos Control points Tie paints Additional data 10 vie

You can specfy here additional knowledge on the acqusition n order to help the asrotrianguation,

Block type: Structured aenal dataset v Structured acral dataset with vertical and oblicue views
Mnimum viewing dstance: 0 units Leave this field smpty if unknown.
Maximum viewing distance: 150 units Leave this field empty If unknown.

7 &/ 38: Additional data &/

B2 o
=/ TT

o

i

Ol D sHS MESHH 2 JHA et HQ0 &5 R = XY = USLICH

o Generic(J122): W2 Z2| OI0I Xl HIOIEIME N A& ELIC
o Vertical views only: =& S22t 28 & &3 0|0/ Xl HIOIEHMEN HEELICHOIANE S &8.

A E2E 20|t D& LI
e Structured aerial dataset: # X 3}

3| 8ot =8 =8 L AE B

SZ 0I0IXI CIOIHMENS HEZH BHLHCZ2 SAS FIIHS 2
d & 20t As dA I ASLICH
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kJ o
0z

o

s 2 |KE0I12t0 S &L

e Orbit around thin vertical structure: 2 7 X2 FH L= M FUHA =0 &= &F2 =& LIALXI(S4! EH,
2E, SEHU S)FHY AT EII2 RHEE UIOIHMEN H&ELICH
A 28 280l2tDE SLICH
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9 Aerotriangulation definition

Aerotriangulation definition

Define parameters and submit aerotriangulation processing.

.ﬂnmm-_l Output block name
Choose the name and the description of the aerotriangulation output block.

Compenents
1D: Block_28

Name |Block_1 - AT - ATl

Result of aerotriangulation of Block_1 - AT (2021-5ep-30 15:29:11)

Positioning/georefere...

Settings
Description

< Back Submit
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=2
=
Ol HOIXl= S0l THE 24240 &Sot= ANl 28 E 3R US AHE JtsE LI
S a2 S0 AIESE AN S S ELICH
o Useall photos: &3 &2 S =2 A AN £0HA = AHMS ZSELICL S0 MZ FIH=
THA AKOILE Ol &2 & E &2 S0l 2ol MHE A0 S&ot=s Ol KR8 = ASLIT
o Use only photos of the main component: 2 R LA 222 A2 &S &2 SN M A= LICH
OlMe &8 &2 =SS0 M OHXIE AHE MEO CHol M2 2& 6t 2E S sdol= Ul 8 = UASLICL
W Aerotriangulation definition - O *
Aerotriangulation definition
Define parameters and submit aerotriangulation processing.
Output block name Components
Components Select photos to consider for the aerotriangulation according to their component.
Positicning/georefere... .
Not all the photos belong to the main component.
Settings Phato selection
® Use all photos
Include photos not belonging to the main component in the aerotriangulation.
(O Use only photos of the main component.
1 photo(s) wil be ignored by the aerotriangulation.
< Back € Next Submit Cancel

1E/39: gz &=t S Y24

x
BN
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o| T X /8] Ab Xb
= > = [ = St = = S
S TS0l =2HS 2ot Y= N 8otes YdEHS dHUICH
] Aerotriangulation definition — O X
Aerotriangulation definition
Define parameters and submit aerotriangulation
processing.
Output block name Positioning/georeferencing
Positioning/georef... Choose how the aerotriangulation should adjust and orient the block.
SStines Adjustment constraints
Control points
[ photo positioning metadata
Point clouds (scans)
Einal rigid registration
O Positioning constraints on user tie points
(O Control points
® Photo positioning metadata
Point clouds (scans)
Custom Advanced...
[ Use targets (QR Codes, AprilTags or ChiliTags)
Using selected data for adjustment (1) and for rigid registration (2)
The block is first adjusted to selected data (Adjustment constraints) and then rigidly
registered to selected data (Final rigid registration).
| < Eack‘ |@Next ‘ | Cancel |
= — = s . .
&/ 40: & F &/2} =& Positioning/georeferencing Of 74 &1
= A = = =
g == sS40 Oet ?IX NE 220 2detE LI
=5 = = = = = = =t
ST AU SO0 VX NS S EZHOZ ASE 4 UNQ 0| B2 22 AR LS LAFYLICH

ContextCapture 89

Adjustment constraints:

Control points(F &6t HHE ME E2R): =2 MHEN X == ot SEFESLIOHIHE 22 &0t
23 AMES A XS [ HER).

Photo positioning metadata(2 & S0l ¥ Xl XI & HEHIOIEH It U= AFRIO|I 3 014 A= B0 201 E
Jts): =22 X HEH0IeH 2 AR 2IXI0l et H&otAl 2 E8 S LICHE =8 BIEHHIO )

Point clouds (scans).

AFEAL IF01=



Final rigid registration:

» Positioning constraints on user tie points(& & S 0ll /Xl A& HE 2240] U= Z208t 018 Jts):
s 0lel e Mt 220 et DBOZ Bl /2&E = /A0 ZFELICH

e Photo positioning metadata(2 & =210l *IX| X & HELHIOIE It Y= AFRIO0| =4 3& A= JRUCHOIS
ts): =582 ZXHIEHHIOIE S AFY 2IXI0l et DECE SSELICHEEGHA &2 HIEHHIOIE ol 2 & E).

. Controlpom‘cs(-,—rszC>F HHE NE Z2Q): S22 32 g4 Q=2 Melotl D MUHEN nE2=2
SEELICH(ZE =N Z2 MoEu 2 & E).

e Point clouds (scans)
e Custom: =50| 15 et At CHet HIEHHIOIEHE VBt 22 6t DI 22 X & 4, & e & A 0|
ZEELULCL

'utput block name Positioning/georeferencing
ositioning/georef... Choose how the aerotriangulation should adjust and orient the block.
ettings

Adjustment constraints
Control points

Rigid registration

Position: | control points v |
Orientation: | Position metadata v |
Scale: | User constraints v |
Point clouds (scans)
@ Custom (ControlPoints | PositionMetadata | UserConstraints) |Advanced...

[ Use targets (QR Codes, AprilTags or ChiliTags)

Use targets (QR Codes, AprilTags or ChiliTags)
MEUHM ==t HAHM AX XS st 2HE= HHE
HIOIEH = At=Z = LICH

nio

ANESIH =812 SEE = UASLILLE =

CHAF A0l CHol XEAISI & 0FE JI: ContextCapture Target Creator.

HOHES ALZote X XNE RE R, XS SES 2ot HdEE AHNN &8 HOHE NE =, 2=
FW 0148 SF0| 2= FHL A WS HOIE 0l 2EHLICH
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ﬁ Aerotriangulation definition

Aerotriangulation definition

Define parameters and submit aerotriangulation
processing.

Output block name Settings

Components Choose aerotriangulation settings.

Positioning/georef...
Poses and tie points
Settings
O Extend Lock

@ Compute Adjust

Computing poses and tiepoints.

Optical parameters

® Adjust main parameters (O Lock all parameters

distortion.
Keeping aspect ratio and skew unchanged.

Targets extraction: None

Blockwise

«©

Automatic color correction:

Create splats:

Parameters: normal keypoints density, default pairs selection mode.

Adjusting focal length, principal point. radial distortion and tangential

=8

Advanced...

Advanced...

<Back‘ 3 |@Submit”Cance\|
J&8/41: 8Z 42 S LE

Poses and tie points
IAFEHSEU AISS MM M2 S ELICH

o Compute: B2 &2t S0 A JI= H& O H45 AIE5I01 ZXQ HEHS HABLICH

o Adjust &S M2 =SUHM IS HAM O H-E MESIH EEES HMOI D SEM EZXAE ZHELICH

e Extend: &3 &2 SSFUHA JI2 HA N HSE AIE6HH OIS =2 FHARAL AdEIH 0L ZXE

HAGID, E8tE S Ao, B TXE ZHEHLICH

o Lock: &8s M2 SSUMN EZXA HEES HEGHA 210 FAELICH

ContextCapture 91 AEX} IH0/ &



Advanced HES M E0IH 2= 222 &8 HAM I L 0HH H+=E 0N 28 = AsUIC

Poses and tie points

Policies
Position: | Compute v |
Rotation: | Compute hd |
Tie points: | Compute v |

Computation parameters

Keypoints density: | Mormal v |

Pair selection mode: | Default v |

e Compute: 28 =X AIE6IAl &0 =HELICH
o Adjust: 23 FHXIE TG0 THELICHEZEE 40 et MRS 226 /s Fohs6sS
Hieter &= AS).

+ Adjust within tolerance: AtE Xt 2| ZAMA &5 X0 JZH RXGHHEAM 28 =X E &GN
FHELICL
o Keep: 2 FEXIE QU=Z AAEELILCH
Keypoints density
ST UOIHMEE 2elol)| /ol I ZE LT g2 HEE & ASLICH
e Normal: CHE2E2| OI0IXI HIOIHN EO HEELICH
o High: TIAMMIS| 1A XD S26HA 2 0
HOl £ESLICL O dES AtE0tH &3 AU =S Mel St =& LICH
HM Normal 2EE ANETE X2 HAEELICHL

Pair selection mode

CIE M8 2 eSS AIE0t0 &8 A= Hlatg 2= ASLICH

e Default: 8842 & JtX| J|&, 1 = 010|

e Similar images only: 7| £ 9I1E SALA 0l et 2ted A= FHELICL OI0IX RAHE0l &
el Mol HM Az E2 Z2UE MSE

o Exhaustive: A& 2t2] QU 0| HistE R0 HEE = 2= Jtsst A2 AFSELICHO: It 2t Z ]2
d2). XNt 88 HA2 2N H HLHOIBZ(IXEC= 23 B2 =2 AR (=24 JH)0f Ol 26l OF
LI Ch.

iy

ol IEXR B

HL
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e Sequence: A& E JHel LS @l LICt. Default 2 &It ’\'_Hé.J AR L AIMAIEAE
Helots 240l ZESLICH AL é,“?:,' =Mes AEA =M LXI60F &LICH

e Loop: FZO N EE Hel LHol /= o1& Aot AHE & LICH Default 2EIF AIHE 2R, HL ALK RTEE
Helol= 200l ESLICH AR £ =AM 2t 2 XIoloF &LICH

A
UM Default 2= A& 2= 2EELICHL

it
10
i
x
i
>
o
>

Optical parameters
SO H= FEHU AMEE 8N HefS A LICH

Advanced HHE = AISotH 2= S HM I X L 0 B2 0IM =2EE &= UASLICL

Optical parameters

Enable pre-calibration stage: C)

Focal length: | Adjust v |
Principal point: | Adjust v |
Radial distortion: | Adjust A4 |
Tangential distortion: | Adjust v |
Aspect ratio: | Keep b |
Skew: | Keep v |

Pre-calibration stage

Pre-calibration stage= Z=J| OHOf H==Jt A M S (0: € = 8l= =& Hel =& =+ 815 2 A=) Heldt
HI| 20l &3 &2 S0 AIHYS [ RESELICL Ol 2E= HlAH A0 X O 20l ZEUICHL JtsS6HEH

0
2 FXUOHMEZ =8& AU Fd= H =0 Z=s &80l &S FLICHL

2

Target extraction
OIDIXINAM =2 & RE2 EoJ&LICH
o Disabled: (&0l ==& Xl & SLICH
e QRCodes: 28t QR ZE & ContextCapture AtE A & & QR
AEZE LICH ContextCapture MIHE QRZE= MBS M4
o April Tags: A EX B&ES MY HU IIE HAHE S ZAIGH= Ol ArEE LICH
o Chili Tags: AFZEX HEE S MHotHL IIE MO E S EAIok= O A2 ELICH

FEIAI SN BEE s ddote
ot= Ol AFSELICH

=2

=
=2
=

ContextCapture 93 AEX} IH0/ &



s My WE
Blockwise, Machine learning (in tech preview) £= None S0 A OIOI X0l HE S Ma WA S X
X o|&HL|C}
o = .

Targets extraction: MNone hd
Automatic color correction: * Machine Learning (tech previ
MNone
Create splats: Blockwise
© Machine Learn...tech preview)

Blockwise &4} 7= 3f
SHSIEH s A S2 O S0t 2E 2 AFXN Ulol Ats A #S3Hot HALELICE Ol #S38t=
OIDIX 2t AL SEH X0 2 ER0 T SE AIE 2t HEQ 22AH2 B&E6t= & E2 22
H AHEFLICE.

Ol 28t Z2NIAOIH TGS S IHXIJL 25 2 2ELITH

AtAleH LHEDHOIK Z20="TH2H Xl &8"S F Lot AIL.

Machine learning (tech preview),% o/|&at 4 I
SHSEH HA HY 20252 0180t0 2 0I0IXIJt SSA QEL’éﬂ%‘LlU Ol Y2 ME WololXI2
SEHOHAU LS M, E=detaoz (HHIJFE SI/US M 2 EELICH

Ol 284l Z2AIAOIH OGS F IHXIJ 25 2R LITH

o WE 243t

0

Al
o -/
MA SHAHUAN MA WS 2E 2 "Automatic (Machine learning)" & €.

AbAlet LHE D OIK Z2ot="TH2H X2l €8"S B XoHEAIL.

=

i
O
Q
|>

SO0 M2IELICL AZSH23D RUAN == 2SS S2oHH LI

Low-level settings
Low-level settings= S =& AL 882 &
Mg = AsLICH

SSYASH NI IE2EY 2HMEZoI] Aol Jl= XN& B0A MSE = AUsL

oF M

e =ASLILLZESS A S Ml 2= A8

H

x

e

ol

o

Aerotriangulation definition Ot AF2| OFXI 2 HIOI XI Ol Al SubmitS 2&6t0 £ =SS Mot &3 &2

sg "og MBSO

£35S MY D IB YA S HYS NSELIT
BT AASY0 NELN FT ALY AVS 02 B 220 4SO
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Block - Block_14 - AT Submit Aemtriangulatlnn“ Remove Block | ‘ Expm‘tl‘ <

photol(s). 0 control point(s). 0 user tie point(s)

General Photos PointClouds Surveys Additional Data 3D view

—

@\ Partially complete photos

The block s ready for Youcan g phots lation.

Photos positioning level: relative

Warning: 1 photo(s) cannot be used for reconstruction.

4 photo(s) in 2 phatogroupls). 49.5 megapixels

3 photol(s) in the main component

3 known position(s) and 3 known rotation(s)

0 control point(s) (0 full point(s). 0 horizontal paint(s). 0 vertical point(s)) among which 0 check point(s)
0 user tie point(s)

394 automatic tie point{(s). View

Resolution ranges from 0.0094 units to 0.01 units

Splats: available. Recreate

Aerotriangulation
This block has been edited after aerotriangulation.
Warning: Potential issue with the acquisition.

View settings | View acquisition report | View quality report

> Job Details
JE42: gdFZ &2 SE =SS HAIZ=S 0

SZH SIS HA L2 2= M ARt S HAHOF &ILICHL 25 ME2 &= TH2H SHE Il
TR FEA0 EEE 0k ZLICH
CHEBOl SEotA EHL SH UOIEHI EH Bt B s 24 S22 2ol AAMOI 24 E &= JASLICH
Ol Z2RUS SotUHE =g = UsLICL
e YHEHCZ EOINIAN EQE IR SHdEFHot A M2 S YA SES AMEULT
e F=ZEE SHESUH ZUZ MNEGHL 0 SHUA M EB 824 ZSE A0l S sS4

H &t C
20 et ZE ME0l 28 =82 F2 74240 43822 ZFEH0HetT ME22 g3 o2 SE=
Sol = HEE = UASLICLME S0, ME22 MOS0l 22 S50 =8E 10 =5S o FX01J] ?lol
MEZ2 8 &2 S0 ASE = UAsLIt

Z0 EAl
StE 42 = 2UE3DZ 2Efol HAIGHAEH £ =22 3D R B = AISELICH ALY AX, 21 & & AIOF,
823D ?X L AMas AZete &= UASLICHL
g 8 242 ?ol 3D R0IA AFEE &= U= Quality MetricsE AHS &S LICH

ContextCapture 96 AEX} IH0I &



FEHE AMAS AEot) FEHE 54 S =06t H Photos BE AMEELICH

YA
View quality report 235 S 0otH &= &2 =& SH It HAIELICH

BOMUE B2 4222 F2 &5 U SHIFEASUC

o

W Quality report O ®

Open file | Export to PDF

QuauTy REPORT Bentley
Contents
Project Summary
a Calibration
Positions
For mare information, please see our online manual: hitps acute3d.com/QualityReportManual/en/v2.0/index.him! !ﬂ

Project Summary -

Project: Bourgst
Number of photos: 251
Ground coverage: 1.113 square kilometers

Average ground resolution: (f)  34.7374 mm/pixel

seale: (@) 1:104

Camera model(s): Unknown camera model
Processing date: 25/10/2021 15:58
Processing time: 1min 53s

Quality Overview

Dataset:@ 251 of 251 photos calibrated (100%)
Keypoints: @ Median of 16514 keypoints per image
Tie nnints: A3R4R noinfs. with 2 median of 1062 naints ner nhato v

T2 14: B &2 S EE E49 0

SENC N
LS HOIHS S EIHE SH O st 2 E HEAlISte] M View acquisition report & A& 2= & LICL O]
BINES3 4A S22 AN AZHME 2PERAE 0] | EAIStD A& AHK D 2 DF A0l S
STHCL A0 CHst NIRAIES HSELICHLE6 RAE AX NS LEQ AT M AHEdt= & X 2=0
et N2 AL S MISELICH

ContextCapture 97 AEX} IH0/ &



Acquisimion RepoRT 3 Bentley

Project Summary

Project: Beynac
Number of photos: 53
Number of calibrated photos: 30(57%)

Number of lost or disconnected photos: 23 (43%)

Adjustment constraints: none

Rositioning: Rigid registration: photo positioning metadata

Not all photos are connected.
You may try to improve the result by adding more photos or user tie points that overlap between the disconnected components or isolated photos below.

Components

Component 1: 30 photos (30 kept in the final result)

SE 22 E +HOHLU LFE AE0)| floll IS ZeE BM4II0A s EE88s =g
o| Sk
AN =

HMOHE S AL=ZE [ Surveys Ei2] HIOE S AHE0HH SE 2t2|E =o)L QX E AEE &= USLICHL

SH oz
SIS AU MU= ZRI= N BN S HAZTH 2 IMES HEUHES REE = ASLICH
Ol Z2ME E2| 2|2 S8 AYAE HFHAM LHEL 2= JASLICL Export [ Export log file for technical
A EHSH

ContextCapture 98 AEXL IOl =



0

HI

00
010

A O
LD VN

H

=

=u
Ct.

i

L
L

==

ol
=
o

AN

F

I

Ol AFSE =

—

i XML & = KML

0

Ol A X el

o
T —

EtAFAZEAU A ALS S 2
ContextCapture0il Al 3D 21 S <= ot

ct
ZZHE Hel
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=
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ioll
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ContextCapture St & M2l MUl A2
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E
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ol
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| SOt AIL.
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H XEA

0l

SHE=2URE Mel MES o 8otJ|

o

dl & JHH 2]

1T

LI Ch.
2t 2 E ContextCapture 22t E Ml AHIA O CH

ContextCapture Cloud Processing Console

HICIL

=
=

I
5%
3+

oll
}
KF
ar

o
0l

i0J
i
KF
ol
ol

tatXHE AtZotH BICI 2 L OIA 2l

2

HICIQ0M 2l S ==otcd s

Import video frames CH

g

Start time/end time: & & H|C| 22| & &0k It

Extract a photo every:

—

AFE A} IFO]

&= O LT
99

Photo output directory:
ContextCapture



# Import video frames u
ﬂ Import video frames

Extract video frames and add them to the block photos.

Input video file:  C:/VIDEOS/Drone_video.mpg [ ‘
Settings
Start time: 0,00 |3/ seconds
End time: 72,94 |3 seconds
Extract a photo every: |0,330 3 seconds
Photo output directory: i C:/VIDEOS/Drone_video_frames/
Imported video frames

Approximately 222 photo(s), 1 photogroup(s), 460.34 megapixels
image dimensions : 1920x1080 pixels

&) Import Close

_J&/45: Import video frames [ 3} &/ A}

M =F el #sts NS X YL

JIHE BE Ty 8 Hol DRet AR D0 ZIHELICH ContextCapturell A= JHH 2 RE AR A SOt

SUBH It LY (SYE FE £ AR)0| ABEC D IIFBLICLUICIR AIRA SO 50| 2ot B

I @IIS AR/2 SHS MBS0 UHE E MEOR HILIQS 25D 2 MEAZ B R OB

IR AIAIR

HICIQ TS £E5tD 201524 0 ImportE 22 &HLICH

P =& ALEIS 2219 Photos HIOIXII A HE X2 2 AHE 4 ASLICH

HICI IOIA P 2 T el0] 2 + el Sfiet @Ol USLICH BB a2t SIS NXGHI H0f AR
S0l FQ Bst 24 (WA 20|, 28 Il LIt 2Y RS FolE NS AFELICL OIS RIS 8 IHX

S 310121 CIOIE 10| A GI0ler HIOIEIHIONA % ALK & )0 M SE e Il 2 QB 2MsI=

211U T,

JHHIHOl B Et 302t 20| CIOIE HI Ol A0 8l Z 2, ContextCapture®l & A2t S M 28 =4S

NS0 T2 DE 245 2 & USLICLHS0 218 s SAH HelJf B0| HBEN ESHOR

ST AT O CHEt 360° HICIQE AR S AR ELICL XA 23 S0l 22 3hoiet 010K B4 Jtoiet

GIOIEIHIOIAN HEE 2 O SXe TRHEW HALSE 4 UASLICH

ContextCapture 100 AEX} IH0I &



A& RIX I 20|
Import photo positions IS A XIS AIZ6IH HIAE AWM AFR X L SIS IIHE &= USLICH

Ol 8= AtSotd ELALOIOIE 2 OI0IXI /Xl H/E=E s 888 &= UASLICHL

Ctefet ST HAE 0 NEELICL 2= A0 UHet S X242 2 M0 & =2 ZSE 0O U=
AL
P2 UI0IE0le & At AbY Z X S AR A X0 CHEt 3002 R EIF Z S0 0F ELICHL 3l E2 &=
A LICH
*< Photo_File >< Easting_  ><__ Northing_ >< Height_ ><_
_ Omega__ >< Phi >< Kappa___ >
f:\project\images\4655.tif 47268.5080 -517764.1880 1514.7160
-0.2352 0.2168 -2.3779
f:\project\images\4656.tif 46434.1570 -517745.9920
1513.0090 0.0662 1.1163 -2.2503
f:\project\images\4657.tif 45618.8710 -517748.2010
1516.4190 0.0227 0.6976 -1.2857
f:\project\images\4658.tif 44815.0070 -517756.2330
1520.3310 0.6212 0.1720 -0.6776
f:\project\images\4659.tif 43971.6950 -517762.4530
1519.1290 0.3699 0.2398 -1.9075
f:\project\images\4660.tif 43116.7510 -517767.1580 1518.0000
-0.4866 -0.4373 -2.8745
f:\project\images\4661.tif 42266.8970 -517754.3210 1519.9090
-0.3243 0.8787 -2.6415
f:\project\images\4662.tif 41407 .34560 -517763.1880
1525.5080 0.0320 0.2612 0.0047
f:\project\images\4663.tif 40520.2080 -517783.6610 1523.6580
0.1627 0.7922 -2.7976

Jtolict 2E, MHE SH N XM =53 IIHd2HE XML £= Excel @A S MEELILL =E5 ML E
I

ContextCapture 101 AEX} IH0/ &



Import positions and rotations from text file

Import positions and rotations from text file

amport pustions and rotabens for & set of photographs. Each photo 15 reprezentad by & bre in & text file

Input filc | Input file
File format Fnter the input baxt file
318 IORErE: File name: | Ci/photo_pesitions_ratetions.od ] I

< Back & Nexr Tmpart Cannel
72/ 46: Input file H O/ X/
ot &4
g IgsE &&= 8EE FoEL/LY
QMo 2=L ™ ContextCaptureOHA-I Ol Mt el ZEI=0ll CHoll X B === A& LICH
INESEEE

=0l 2t 0fl 20| Y= B2

Number of lines to ignore at the beginning of the file: It

e Delimiters: € 2= JISE H2ASELICL HH 2XMNE XNEHE = U

SWAIZAI R Z2 IS E MEBE = B 2= Combine consecutive delimiters & 0| 2 2 &
o Decimal separator: &(123.456) &= = & H(123,456) & LI Ct.

ContextCapture 102

AFEAL IF01=



Import positions and rotations from text file

Import positions and rotations from text file

Import postions and rotabons for & set of photographs. Each photo 15 reprezentad by & bne in & text file.

Input file

Data properties

Fields

File format

Deafine how the input file must he read

Humber of ines to igneee gl the begining of Lhe fie LB

Daimtars

| #d =

[Soaue""]

Combing conscutive Geiimiters

Tike preview

-

Decimal saparatar

[123.256 ~/

Dava pravtaw

2.6086
-L.2083
26439
-3.8100
2,5585
-3.1394
-a4577

3.0167
-4.831%
“7.6635
-3.80555
-0.5711

1.2467
=3 10Ra

193,81
8.0
5.5157
6.//50
8,705

6.055¢
2ITI
;H

A 2 Fhoto ID_ =< Eastng =< Morthing =< Haght =< #hi =< Oma =
ORIA 020803, TTF 692890783 6170956401 455277 2
URVA 0 Z0804.TIF  BY3000.684 G170834.192 452.828

ORIA D_20805.TTF 693136367 6170851068 450,350
URA 0 2080610 6Y3320.828 S1/UB/A152 A48.617
ORIA  D_20807.TIF  693464,060 6170906094 447,340
ORIA  0_20808.TH 693615168 5170928598 £44.889
NRTZ N INAMITIFE  ROITARO 433 A17NC4= AN &aa :lj

Row2  ORIA
Row3  ORIA

Column 1 Column 2
Row 1 CRIA 0_20803.11F
0.20804TIF 603000684
\0.20805TIF 603156367

Column 3

BEZH90.781

Column 4
(B1709565.451
6170834142 45282
:5170851.068 450361

Tmpar

Colu®]

45527 —

i

a: 8l =2 RAIELICH

cold &4
It E GI0IEE & <S/&tL/L.

ItHE /X

ContextCapture

MER 5T ) B0l 22 A

-/

&/ 47: File format 1 0/ X/

Y
>
>

i
o

103

AFEAL IF01=



v Import positions and rotstions from ext file

Trmiport pusitiors and rota.lons from texl file

Trmaort posions and rotations F o act cfphetoyopha, Bocrphetain sepreacaiee bralreine ot e

Ingatie Data propertics
Tile fcemat Celime b argortwd il4la
1 Deta propestes | S retersncs exstar
Fiekds Sueld choome sk | Harvouzfoors) u o) wsrdicles srslos

¥ ‘mpeermtaton

Ingles: ‘Yaw, Bitdk, Rol -
Camerc onientatiore X right, ¥ down -
Ande unts Decress =
Qular s

[ %t prmee metacata orly (rep arted ¥ pos= inforration undagecd

<Bocx ©F Next

_J&/48: Data properties H 0/ X/

A EE PRI HIOIEC B2 22 HEM (LB E S| £

Ol SE=S dEot] 28 MU AL S| M0| 2 E B3R N SLHS dEE
I Sd=2 s st

SAO2 HZ2E T2 HIIAM XE X LSLICH
o Camera orientation: L= 3| XM 2 2|8t It 2t MMl xy= AFF LI CH.

Jt S8t 8t Xright Y down(D1 238%), Xright Yup(AHE SEUA O X3 ALS

X down Y right, X down Y left, X up Y right, X up Y left.

o Angle units: Degrees 5= = Radians.

ContextCapture 104

rr
e
1o
10
ra

Conc
2 AHE)E M EBHLICH

Angles: 2t &= 2 &: Omega, Phi, Kappa, Yaw, Pitch, Roll % = Heading, Pitch, Roll( A} &%/ 1] ZS). &

&), Xleft Y down, X left Y up,

AFEAL IF01=



=g
ZILOIOIH =4 AL

+ Set pose metadata only: & M| 3D &
A& X HIEHHIOIH =408t H
= UASUCLII2 SEHSIIIN2 AR L T Z AN I X 2410 ZX HEIHIOIEH 3EE RS
2 O0IEst= LI

e =0 A ZFELICLUE S0, HIOIEHN 2/ &0l ZSEH UK 2 H

L Import posmons and rotations from text file [ x |

Jmport postions and rotabons for & set of photographs, Each photo 15 reprezented by & bne in e text file.

I
’ Import positions and rotations from text file

Input file Fields
File format Specify columns corresponding to the imported data
Data properties Cesect o line For dests presdew
m£=‘| Column 1 Column2  Column3  Columnd4  Colu”
‘ Row1 CRIA 0_20803TIF 692800783 6170956481 45527
Row?  CRIA 0_2080<4TIF 693000684 6170834142 452382
Row3 CRIA 0_20E05TIF 693156367  §170851.068 45036
Row 4 CRIA D Z20e06.011F  BYIZINE2E 810877152 4dBe)
| Row5  CRIA 0_20807.TIF  693464.060  6170905.084 44734
< >
Fizkds selection
Column Role Preview 4
Colurn 1 [N/A - 0RIA
Colurmn 2 |Photo reference ~ |0
Column 3{X * 69739078
Column |:N, 35,277
?v
‘/
oA Mot all reguired | Omcga . Please spedily the missing robe(s).
}Phl
IKappa saclf &) Mexr Tmpart Cannel

&/ 49: Fields #/ 0/ A/
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gigr £ ASLICH 18 O3 ContextCapture= 2 S
= HEFLICLAINGHH @7 £= Z 10 AKXt
|

[l

&0:" /X & o/ H 2T
EU OHXIAIZ == ASLICH
OlE =01, 0150l img 0.tife! AtM 2| HR o & AP X = img 0 £ img 0.ext0 OF & LICH I A ext=

oo & LICH

1
o
%
0p
Iy
=
r
!
>
&
o
o
S
)
0ol
rth
oy
10
=
)
i
Jv

S A S HE

o

AE

o
ol
J

|_

== M|

I = MHUA 8M f= 2 =25 82 E Ot sLICH

&1 MM =22 2 Ot 2| = ContextCaptureE AFEGHH 1R =2 =2 AHY S XM elots 7L &t
LI
Gt A0 A& ELICH

e BlocksExchange XML/XMLZ &4!: 2 H2E JIIH 2 HUL LHE W] 20K BentleyOll A X &8t SOH W&t
A LICH

BlocksExchange XML/XMLZ & Al 2 & X5}
e MS Excel XLS & A!: Microsoft Excel XLS I} J|&=2| £ | L|C}

MS Excel == HO|E F X0 AIL.

e ProjectWise ContextShare & & 0l M 2| ContextCapture 2 &t &! L|Cl.

ContextCapture 106 AEX} IH0I &



gt XA= JtdsLICH

2 CIOIE JEH 20
S8 Y 2AX XNE Mt XA

=08 o <

& OIOIE XML EAI0IA S0 A= MAHE, ALSKHE
2 HI0IH LHE WL

o Split block
Splitting a block into several sub-blocks is needed to handle mported block of aerial imagery

containing a large number of photos (typically > 5000).

Target number of photos
Maximum number of photos per block: rSOOO

~Height interval
Rough estimate of the height of the scene (WGS34 elipsoidal height in meters).

Minimum height: |0
Maximum height: | 100

Output block base size
The horizontal dimensions of output blocks wil be multiples of the base size,

Base size: | 1000

~Spatial reference system (SRS) -

Choose the SRS in which splitting must be performed. If a custom SRS is requrred for a later
reconstruction, it s recommended to choose it, so that reconstruction ties can be made to

conform exactly to block boundaries,
=

[Local East-North-Up (EN); onign: 48.843930N 2. 3660608

—~Splitting ongin -
Define the spitting orign In the SRS speafied above. A custom orign may be needed to make
later reconstruction tiles conform exactly to blodk boundaries,

x [0
¥: o

spuuockl Cance!

_7&/ 51: Split block [} 8} & A}
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S HZNANAE Aot ot?l =238 S0 et HRE MM 2E U RS 8 KML

Fichier Edtion Affichage  Outils  Ajouter  Aide

¥ Search m

» Lieux

» Cal  Galerie Google Earth )

LEX HE 20 A "Extract.."S & &g LICH
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K ContextCapture Master

@I Extract block
Extract a sub-block which covers a given region.

Extract mode
®) Extract photos that view a given region (requires complete poses)

| Extract photos whose position is inside a given region (using photo positions)

Region
Enter the path of a KML file defining the region to extract.

KML file:
Rough estimate of the height of the scene inside the region (WGS84
ellipsoldal height In meters).

Minimum height: 0

Maximum height: 100

Cancel

Extract block

_7&/ 53: Extract block [} 3t &/ X}

=543
8 QC
(S S HX 22 22 A £ ABUT
e Extract photos that view a given region (requires complete poses)
e Extract photos whose position is inside a given region (using photo positions)
s 43
HEiet =ZE P00 et 2Re 9 0 -2 LS ELIC
« KMLfile
FEE JYZ2 oot KML IS H2E LS ELICH
GIS =+ L= Google EarthE AFE6t0 KML It 2 S M E == JAsLICH
Height interval
ZXE LA St

ool | B E
dyofl+=H =01E XI&otH ot ELICL IMAMSt g2 226!
e Margin (in meters)
HESH HAS 2t TGt (S Y ELICHL
110

ContextCapture
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1]
Pl
o

F& MelE Al & 6ted ™ Extract blockE 2 & LICH
OIS Soil KML It 20l 2 2D NSH2=Z HISHE Mot E22 M4 LICH
AD: XSS S0 47 S2US A2 S0 N2 2E/ME AZS BAE 4 ASLICHIIRA 2ES
B = 2¢ > Unload)
S L /HZEE FEROHAAL
LHE LH D
=H UEUDI
0l % Block > Export > Export block
Clost Aoz 231 =4S LYWL ICH
W Export block — O 4
~  Export block
‘ Export block properties in various formats.
Qutput format: BlocksExchange XMLZ format w
Output file: [D:/TESTS Block_1 - AT - exportommlz | [1.]
Options
Spatial reference system: Hot georeferenced
Rotation format: Rotation matrix ~
Camera orientation: X right, ¥ down -
Export automatbic tie points: No b
Export photos without lens distortion: Ho o
&) Export block | Cancal

_J&/54: Export block [ 2t &' A}

g oA, =29 IHE & 58 = d80t4, Export blockS 26t XML It = & & LICH
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e
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~
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=
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o ATExportXML &AL XML EAICZ 23 =2 49| J|2 WEWHIIYLICH ATExport XML A S
T REAAD.
ATExport XML S A2 EfAL AZEYHZ HELHD| fIoH SHE S=3stE A LICHL LIS
ContextCapture 0l M S = CtAl It 224 BlocksExchange XML & Al S AtE0H0

e Google Earth KML: A& 2/ X & E 2 JIEt SES KMLIMEE HE-HUICHL WEW KML I 2 E& GIS
T &£ = Google EarthOil A AtY 2| XIE Al 3totes Ol HE e LIC

e TREND-ONE XML: TREND-ONE M & AIEZ At 2| 2 S A LI

EH

-/

x

HEHEZH0 G US I SEE MEE = JASLICH

o
oar

Iz

Spatial reference system: 3D /Xl & 3| M= 2 H&6t= O AIED = MHHEHE S LICHEY H#XE
S0t o).

Rotation format: 3| & &4 28 3| ™M #HE & = Omega, Phi, Kappa 2 & (A& S| HO| A= S 012t
HEE LS LICH

e Camera orientation: 2| M0f| (et = A &S S LICHYE AN 21 80| A= = 0ICHHED)

o Export automatic tie points: |2 LWEWI| IY L= J/2 Tl 2o 2 2E2 It S SHUE
LHEWII 2 I A= &S 2Lt II2 o s HeE8s WEUWH e £H2 XML I 0l
MEE S ALBZ R 2 EZZHE FR0ZF SE0 R = UAsUT

o Export photos without lens distortion: At& 2 S 2] = GIOIEH 0l [t H=% X &40 6t CIEH 2l S
JPGUIY 2 HWEWHELICL OISt A2 RHE2 Y S MEE = ASLICL

(& Goagle Eann - e e . e e e o e

lfuchia Edition Affichage Outils Ajouter Aide

¥ Search B @' & @ | & @ | & | B < | o | BE Se connecter

0002_061000_2251.tif

Component: main component
Photogroup: 120724_Jaune_0002
Image dimensions: 8176x6132

Focal length: 150.093 mm

Position (WGS84): 48.8381"; 2.37781"
Ellipsold height 1283.34 m

Hinéraire - Vers ce lieu - A partir de ce liey

t “ } DMcuten\g\Pans2012Tutowin0002 061000 2251.uf

» Lieux

¢
-
1

» Cali  Galerie Google Earth »» Visite guidée

18/ 55: Google Earth 0f| Z A/ & £ KML LHZLHI/S 0
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D2 I AEXNIEAIZID B2 S 22460 ots 2R s B2 8 2 Blockxmllll A HX0ot= 2R A2
MNEE = ASLICLSE "R BH0IU2] I "2l 2R €42 0| ™ ContextCapture Cloud Console H 7E(UpdatelO
OIohH 0l A XI & &Kl & LIC

Camera orientation: X right, ¥ down v

Export automatic tie points:

Export photos without lens distortion: 'Yes - Embedded in main file

Yes - In an external XML file
Yes - In an external binary file

S22
0l % Block > Export > Export surveys

Hse o x<

HOE, AENEEE L Met S Oe FA22 L2 -LICH

- ContextCapture S II2A: XML EAI2 =28 = I2NE 2| S 2 Weol= 0l HEELILHESE
2 AX KNE ME 2240 A= HHE L AISXEEE L.

- KMLINY(EA EZX 22 ME): HE GIS &7 E = Google EarthOl A ARl I XIS A2t st 6He O
HMgst gAY LIC

- HIAE MY [0IEXYZ]

W EBxport surveys — O >
™ Export surveys
* Export control points, tie points and constraints.
Output file and format
Format: | ContextCapture surveys file (*.xml) -
File: |D:,-'TESTSIBIuck 50pc - Surveys.xml | IZ'

Options
Control points
Tie points
Spatial reference system: Local East-Morth-Up (ENU); origin: 46.654¢

Constraints

&) Export Cancel

Export Surveys CH 34 Xt

ContextCapture

113 AEXF 0/ =



FAE 3DMZ E LD
22 0|0|K L HME20A < 3DMO| CHEH OHE! AlsHsS M A EHL|C.

Orbit B(DMLZ HIOIHE W2 Ui 2 ME SE0| oY SHE MEGHD IIRA LEEZEHES
S0t AHAE H=E HAAL. O LEA M0l Al ExportE S8 = 0 X2 2 2 Export to

Orbit 3DM = <1 &Gt Al 2(0teH OI0I Kl & ).

~ | Roof
Aerotriangulation

Split...
Extract...
Import

o
(I
il

New 3D reconstruction Export to Orbit 3DM...

New orthophoto/DSM

Clone

B Ewportto Orbit 30M

. Create a Mapping Run for Orbit 3DM from block imagery and productions.
Select the items to include and click "Export’ to proceed.

File name: File location:

Orbit 30M Run (3) | [ perresTss -

Resource type: | Mapping Run v
B Imagery

1 Mesh Reconstruction_1 - cesium with app (Cesium 3D Tiles)
I Paint cloud Reconstruction_1 - opc (OPC)

O orthophoto
[J DEM

€€ £

Options

[4 Use links to input data

3 items selected Cdnr_el|

Export to Orbit 3DM CH 3t & Xt

SH0AMOE =40 MEC = HEL == ASLICHOH Ol 01X & X)

ContextCapture 114 AEX} IH0I &



DEM Not available

Annotations Reconstruction_1 - S3D_5 - Dales3D (InsightsS3D) ~

Options

Use links to input data

1 item selected | Cancel |

2ee =S HEIGHD 'Export'S 226t HISELICH

ProjectWise ContextShareOll Al 25

ProjectWise ContextShare= & & OI0I& S HAl, 22l ¥ 3= 6t= Bentley =3 & & LI Ct. Bentley CONNECT
HEO SE 0 AU OF ELICH

ContextCapture 232 F It R 2 U062 2HELICH

o OIDIXI Z=h4&: IaimlﬂHé.:,—.OIDIIIMPO'HIE‘P:!LIEL
o S OI0IA Z2EE2 0I0IX F20 THet 2K, 2l & K Zst 4= J2eLh

ProjectWise ContextShareOl 4 S = 0ll CHEH KtAISH LHE 2 & HIAl, ProjectWise ContextShare 0l Al S 7S
XS AIL.

S 2L/o=2E
B Z2HENK E2S 25/ 28/

SAS TEHE KA LAXOR AHS BIHse 2202 S LISH S/ 4 USLIC
2212 0250 (1208 86/ BEEHE 2E NS EL + ASLID

ContextCapture 115 AEX} IH0/ &



& 56: 5

B CC Project
I Block_1
| Block 1 - AT
o B8 Block 1 - AT - AT
Aerotriangulation
Split...
Extract...

Import

Export

New reconstruction
New insight

Clone

Delete

Rename

S ZELENFOAHES AZE

HEZZME EC| F0l= o 0t0IZ20] 2148 XclEg LIt

IZME EQ UM AZCES 22 AEELICH

E AL AE HS0M LoadS S ELIC

OlM SHS M Z2NEN M AIEE 4= ASLITH

Sa wy

SENS 2212 olLISI M 223102 Y SHELICH

Shift £= Ctrl 71 S AHEG6IH Z2HE E2| F0AM 0 B MG & 222 o LICH
HEAHEAE [ 5 (0tRA LEZ HHE 2 )0l A Merge blocksE S &tLILE

Hef S20A ANE LS AIEote ZR(0: Mt RLE S0 & & F2)02t

Ol =85S EEE = Us

= mmmg quarty

Delete

1&857: A&t =5 FE

BlocksExchange XML/XMLZ & Al

BlocksExchange XML & &1 2

BentleyJ} ContextCapture Master0fl Al 23 82| &

N&et SO we A YLICH

XML I 0= otlt £= 0

XMLZ €412 B2 E 2ol It

ContextCapture

S2io] 240 Z&E 4 ASLICH
o 4= (zip) 2 EII5H= XML 8 A9 3¢

116

HHLLAHLE HE D] 2ok
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o

Al A}

=/ S

212 0l 2 AF TIHY 2 ContextCapture & X| CI2H 2| WA 2 S == U & LICH(doc/BlocksExchangeFormat.xml).

ContextCapture J+0ll 2t 22 0l CHEF KA S LHE 2 ContextCapture Jt0ict S S FEGHY Al 2.

MS Excel & & 9
MS Excel Z MU M £ &2l = Bentleylll M XI &S A0 Tet HsE = ASL

C
Olgalg HoE 2l S-S JIE MSExcel ZEM0IA XLS E= XLSX @A 2 A IHHRLI| 2
MZELICH AU YEHEQOI AL B0 5 H S BlocksExchange XML/XMLZ SAIE AIEE XS HEELICH

MSExcel II2Z0A S H2A=RE2 L= ML = ALHUOHE NZ GE EALZ MEE = ASLICHL

CtS ContextCapture £ Xl CIZECINA KK X BEXS Z= = UASLICHL

¢ doc/BlockIlmportSample.xls
¢ doc/BlocklmportTemplate.xls

IOl AZANE
MS Excel I 0 A CIOIEI= 01dd RFITAIEZ MZELICHL

XIS 8Al2 16,3842 oz NS 22 2 UIOHMES N = B Al XLSX & A
AESHA Al 2.

0
o

Photogroups
St Z2 ol O H+-5 Z8ol= At 8 =5

e Name: Ol AFX JJE2 DRE OIS (2= ALE
e  Width, Height: = & &2 0| 0| X| 2J|(E 4= AIEH

e FocalLength:mm S22 =& Hl(E = ALE)

e SensorSize &£ = PixelSize: mm S| (2 4= ALED

e  PrincipalPointX, PrincipalPointY: &l & &2(2] =& | X (& & AtEH)

e  PrincipaPointlXmm, PrincipalPointYmm: mm &</ 2| =& 2| X (& & AIE)

e CameraOrientation: 9} 0l 2t & 8F & X (BlocksExchange XML/XMLZ & Al (& & At
o K1,K2,K3,P1,P2: &l = ol == Hl4=(&EH AFED

=

0

)

D
s

Photos
222 Y HH B8 ELESte ARl =25
e Name: Il 0| S(Z teh
e PhotogroupName: oz'jd = Jtietel OIS (B == Ate)

e Directory: J| & CI2E 2I(HE AIED

e Extension: It & 0| A& EY ALED

e Longitude, Latitude, Height &€ = Easting, Northing, Height: 3D I X| (& & A&

e  Omega, Phi, Kappa &£ = Yaw, Pitch, Roll, &£ = Heading, Roll, Pitch: S & 0ff {2t & &2l E£= etC] et
ChHelo] 3| M (K& AFEH

A& Name2 B 22, & B2 £= 1 0]

o

g &= UAsLIChL

ContextCapture 117 AEX} IH0/ &



Ol $3DRXE E&ot= MAHE S LICH

MOH&E =Z = M306ted® 4l BlocksExchange XML/XMLZ S A S AFEGHY Al 2.

Options
MS Excel It 2 S ci&lot= Ol AIS &= SE Y LICH

SRS
3D FA L B/ HE oH&otE G AIEL & 2 B L AIAE L/
EPSG 2 & ("EPSG:XXX"), PROJ.4 £ = WKT & 2| E XI& & LICt

InRadians

BaselmagePath
M H B2 E HH5HE Ol AR EE JI2 CIZE2I(M 2 ALY LICH
BlockType

S R (WS ALEN L LICH

ATExport XML & 4|

ATExport XML &A1 0fl = 2 AP0l CHEH LHE & Q12 & HI0IE{DF L &HE LICH
e ImagePath: O|0|X| It Y &=
e ImageDimensions: O| 0| Xl LH| & =0[(&4)
e CameraModelType: FA/2t5 = 0/oF /X
e TFocalLength: =& He|(E4A)
e FisheyeFocalMatrix: 102t S RS 0/ /X012 A= =8 g (EHA)
e AspectRatio: 0| 0| X| 2/ & HI2
e Skew: O|0|XI H=
e  PrincipalPoint: 0| 0| X[ 2] =& 2| X[ (& &)
e Distortion: Itii2t 22 K& SA/SZMHt AMNSE=AE Q= A
e FisheyeDistortion: It0ii2t 22 K& 0/of Ef/x()“m MEE =X f= A=
e Rotation: At&l 3| & (& &f H L= B ECEFUIA M3)

e Center: AHX 2 X (& & &
o Skew:x Xy T& = ALO

&l 2 ECEFOIA MI3)
| pS
e Aspectratio: ZA0| A A}

—
A
j*E% 19/ote A= H =

0] Ot 2% 101 Ot

510 g

{5 ATExport XML S A2 EtA AZEQHZ HEUWI RSt EE 2 HEEASL l:} Lt ol
ContextCapture il A 212 CHAl )b 224 ™ BlocksExchange XML/XMLZ & A S AHE6H OfF & LICH

ContextCapture 118 AEX} IH0I &



Jtailet GIOIE B0l A

Jttict QIO B0l A= AR 2 F=DtE! [ ContextCapturedt S22 HEZEHU AL QSN SAIES =2
HEY A Ittt 22 S == 22| LICH Tools Ul 7= > Options...2 0| =S8t = i3t &F Xt 2] 'Manage camera
database..'E S EGI0] WA A = ASLICH
| @ Comera database i o X
|
| o] Camera database
T Manage the database of camera models.
)
| E= |
| Fier:  [None -] 8 camera model(s) | vexc x ;
l Source Name Date = Add... '
| | & ComextCapture Vexcel Imaging GmbH UltraCamD 10/1/2015 5:19 PM ¥ Deter
£/ ContextCapture  Vexcel Imaging GmbH URraCamx 10/16/2017 3:57 PM -
£ ComextCapture  Vexcel Imaging GmbH UtraCamX prime 10/1/2015 5:19 PM 2
& ContextCapture Vexcel Ultracam Osprey Oblique 10300x7700 2/28/2019 3:45 PM
& ContextCapture Vexcel Ultracam Osprey Nadir 13470x8670 2/28/2019 3:45 PM
£ ContextCapture Vexcel Ultracam Eagle F80 6/19/2018 4:40 AM
& ContextCapture Vexcel Ultracam Eagle F100 6/19/2018 4:46 AM
Ei ContextCapture  Vexcel Ultracam Eagle F21010 6/19/2018 4:48 AM
Selection
o] o
_7&/ 58: Camera database [} 3} &' T}
JtOlet CIOIEHI Ol AN = & It SR &=0| J_SLICH
» ContextCapture & =2 ContextCaptureOil Al MlESot= Il Jtliict LE L LICL Olefs &S 2 2471
MEZ0/0] &= S=2 ContextCapture A& E 0 A O LCI0IEELICH
o MEBX =2 ZREUA FItoAL JHE 2 It0 et 22 I LICH
2 It SEH2 0| S(L2HA), EM(OHN L =F), CHASH(EE At 254 & H/OHXI D=2 =2
& LIC
2 S50 CHet RAHME HZE At 1SS oY AL,
ContextCapture 119 AEX} IH0/ &



@ Camera model

Check and edit camera model properties.

Name: DI FC350 3.61mm 4000x2250
Last modified: 2/28/2019 5:07 PM

Optical properties

Model type: Perspective v

Model band: Visible v

Sensor size (mm): |6.24

Image dimensions (px): [4000:x2250

Focal length: |3.65132 mm v

Distortion: :).0205896 P1:0 P2:0 Direct:true example: "K1:0 K2:0 K3:0 P1:0 P2:0 Direct:true”
Principal point (px): X:2004.8 Y:1093.88 example: "X:2566 Y:1551"

Aspect ratio: ;I

Skewe: [o
Advanced >>

Cancel

@ Camera medel x

_7&/59: Camera model [} 3F&! A}

.l X

CIOIE IOl A0l Al SHhiiet 2

=
S

= T
AME F=IHAI RS2 Jtet 2L & E
£ 2| Photos &0l M AR 2 FIHEH B2 ContextCapture= NS 22 IOt CIOIEIHIOIASE AFESHH FIHE
AFELON DHE M etst Jthict 2282 2 &LICH
ContextCapture= 22 A& =4 (B2 HI0IH L 0|0 Xl XI+=)2 A6t =4 L O Xl J1Z 0l et
CIOIEAHIOI A0 A =l &F2l Jthiiet 222 RSLICH
Hi: FN SN AEXES0| REH2Z AFZELICH
AR DS =22 JtHct RE HE
AMEIS FOLet = IOIEBI0IAMAM It 22 E XNEE ALY OS50l =22 €2 =& JUsLIC
LA OEE 0tRA LEZE HE L Z 20t Get camera model from the databaseS 1 &4 &t L| Cl.
photos... || |HH Import videos...| | | Remove photos| | | Set downsan
ogroup  Status
roup 1
Add camera model to the database...
Import optical properties...
Export optical properties...
Ungroup
Set pose from metadata
Clear pose
Set metadata from pose
Clear pose metadata
Set mask...
5.JPG
6.JPG Delete
& 60: AtX IS 0IA ZHH CF G O] E1 8] 0] £ 0 25 Al £
ContextCapture 120 AEX} IH0I &



2. Camera database St A UM HISE ZEHE AMZESHH st ItHct 22 =S ZMaHLIC

’ Camera database 3 ‘

® Get camera model from the database

Please selact an item from the camera database,

Fiter:  [Same mage dmensons v | camera macel(s) | 4t

Source MName Date == Add...
[g ContextCapture i Vexcel Imaging GmbH UltraCamX 01/10v2015 17:19:09 o
Selechon
Name: Vexcel Imagmng GmbH UltraCamX
Last modified: 01/10/2015 17:19:09
Model type: Perspective
Sersor sze: 103,896 mm
Images dmensions (px): 9420x 14420
Focal length: 100.5 mm

Ok Cancel

78/ 61: Camera database LH S} & ALOIA FHH2F P E 2/ 4, OKE S 2/6107 ALX
S0 AEE I PE=S ZEEL/LC

ArS X SHICt CIOIE |01 A& 2te|

CtS S IOt Y-E2 2 ALZ A JH0I e CIOIE HIOI A S WAIA & 228 == JASLICH

o AL IS IZ0IA S22l Photos & AHE: 0] WAIA ZEE ALE6HH ALK OS2 Ittt 22 S
GIOIEAHIOI A O ASBHA FOHE = S’AQLI Ch.

o SE ZZ ) H A0 M ContextCapture =& : 0l 7+ Options > Manage camera database. 0| 2 &= 0| & 0fl

=Oter Jthiict 22 HE =AM 22 20 S8 e A0l At2E = AsLIChL

[ em—— = T M-

ContextCapture 121 AEX} IH0/ &



photos... |v| |HH Import videos...| | & Remove photos| | |"# Set downsan

ogroup St

roup 1
Add camera model to the databas

Import optical properties...

Export optical properties...

Ungroup

Set pose from metadata
Clear pose

Set metadata from pose
Clear pose metadata

Set mask...

5JPG
6.JPG Delete

18/62: AIS AL LU LIOIE B 01 2 O A AP &0l FH0 et 2 & & & o/

Jtoilct CiOIE dlof A & &

Camera database [l 3t & X} = ContextCapture & &:

0l 7 Options > Manage camera database | A 2 Al A&
USLICEL Ol SIS ALESHHE M AIE L E=2E =

= T
g =AW IIE =SS HE T= AN E = USLICL

ContextCapture & =22 H& S == gl LIL

AE XIS QIOTEH|IOIA D 2 J1/LH 2 LD |
Arﬂxr HOlE B22 NEEIU HE H2S T2 2REIR 015518 Tool U5 0IA AHE I

AR S 2| It e 22 =0t
1. I OES 0IRA QEZE HESZ 2261 Add camera model to the databaseS S & &!L|CF.

Add photos... |~ HH Import videos... ‘& Remove photos ]

>hotogroup Get camera model from the database...
itogroup 1 \dd od by
Import optical properties...
Export optical properties...
Ungroup
Set pose from metadata
Clear pose
Set metadata from pose
Clear pose metadata
Set mask...
o
0385.JPG
Delete
0386.JPG

& 63: GIOIEHI0| A 0] AN 25 Ft02F 2 = f

ContextCapture 122 AEX} IH0I &



2. et 42 #0lot ) HES OIS (ZeloA)S e LIt
@ Camera model X

Camera model

Check and edit camera mode! properties.

Nome: [Unknown camera 43%mm 4000x2250 ,
Last modified: 2/28/2019 5:34 PM

Optical properties

Model type: Parspective v
Model band: Visible v
Sensor size (mm): 6.24

Image dimensions (px): 4000x2250

Focal length: 3.65132 mm v
Distortion: D.0205896 P1:0 P2:0 Direct:true example: "K1:0 K2:0 K3:0 P1:0 P2:0 Direct:true”
Principal point (px): X:2004.8 Y:1093.86 example: "X:2566 Y:1551"
Aspect ratio: 1
Skew: 0
Advanced >>

canc
3. OKZ 225101 ALZ X IH0I 2} CIOIE HI0I A Ofl Jt0iet D2 S S tEtLICH

MEXILZEIIE St 222 S2& JtHict2 2HS M AFXI2 =IHE [ ContextCaptureHl A XtS2 2
AMEELICE 0] &% ContextCaptureil A= t0ict 22 OH Xl J1&S HELICH

M S S0 M= 3D M E= ZAARR /DSM(S2F X AIAE], 2t J Bt MIsH 2 A, eIE X, el £F)2
Meots T PRAIAE 2l UICL A =01 [Het 8 O £= 0 i A S A& 5= ASLICL

SO RE2 WS MESE = USLICH

o 3D BA DH4IQ BAE
o HALAE/DSM: AFRIOIAl DEE X

Reconstruction - Reconstruction_1 Submit New Production

3D, Regular planar grid (grid size 300 meters), 187 tile(s), extra precision

FE D DSME &0 It 82O 2 Heste 2.5D 22 LICH

General Spatial Framework  Geometry Constraints  Reference Model  Processing Settings

R

In production

Spatial framework and processing settings are fixed.

Regular planar grid (grid size 300 meters)
187 tile(s)

8 tile(s) completed, 0 tile(s) retouched
Extra precision

Production Format Status Progress Last submitted Processing time
Production 1 Reference.. (@ Completed | EEEEININ 12/4/2021 23.. 20154

& 64: M2 O1EH B 0] £
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MA2 s sde2 Zo gL
o B UYURATAE S EHXZAAE, 2 A L EILS HOSLICH £ H A AR /DSMOI| CHEF ol &f &
43S ZeELIth
o A NSt EHE EZ0tHIIE3DUHOIEHE AHZ0HH MAS Mot A LFE SANE = ASLICH
o HADE2 M MHESAQIMN, MAEIMNHEN et BNEOZ 225 = 2RLE S |2 A2
MESLCLOIEX2E2 28X L HA Met ZH0l HEE D &= MASO0| It = 2L LICH
o Mol A2 EA HUST Y Y (high, extra S)I JIEFMH E&F S XIFELICH
. Nme==
&0: ME 2 AZESH| MOl Spatial framework & Processing settingsS ™ & 61 OF & LICH M &H0] Al &HE &
Spatial framework &2 20| 8822 MEELICL Ol R MAS SHOIH M HE JfssH A [ A
DY YAIAE LS = USLICL
o| O =
SEER=F
M2 Al AHEKX Ot A IAEZ HES HEGHNH ContextCapture Engine &£ = ContextCapture Cloud
MHBIA0A M HEES 4d=E ASE &= JASLICHL
Process with ContextCapture Engine
Process the job locally on your own computers.
C’_‘fb Process on the cloud
Process the job with ContextCapture cloud
processing service,
SLE HANM M M= S dde = UASLLL A MAE=S2 S2Le M2 £F(SRS, B, 28 &9, Hel
23 5)S EFELILL
MME=E M X SCtREUHAM XMl MES S0t AL,
MM =&
S AHHEAE H=OM HA0 CHE JIEL 8 SAHS RMAE = UASLICHE 300 B E).
Inter-Tile Standard Color Equalization...
Import
Export
Clone
Delete
Rename (Edit Name and D
ContextCapture 124

AFEAL IF01=



T=DHE EQI2 MAH =2 0IRA LEXE 26t HEAE N2 st 22 Jls
AESHA Al L.
v L Block 3
> Orthophoto/DSM_1
v Orthophoto/DSM_2
& Production_dsm2
2> Reconstructio - .
 Reconstruction Submit Production...
Reconstruction Pro on the Cloud...
Analysis
Import
Export
Clone
Delete
Rename (Edit Name and Description)
- Clone: & 212 EXZES MAELICH
- Delete: &M &5 A2 M AHELICH
- Rename: A2 0|8 L &Y 2 HEELICL
HE
Overview &2 Soll M HAI2EQ H& SE 2 22| &LICH
AIBE
HAIEEU M= A &FE 2 22 )2 32t 2 dA3 £80 et B2 E M3 LIC

—

@ Ready for production

You can modify the spatial framework and processing settings before starting production.

Warning: the expected maximum RAM usage exceeds 16 GB. It is advised to use smaller tiles.

Regular planar grid (grid size 200 meters)
22 tile(s)

0 tile(s) completed, 0 tile(s) retouched
Extra precision

&l 65: M HAI 2=
NS

M2 M= =SLICH

ContextCapture 125

o
I
1
o

hl

AFEAL IF01=



Production Format Status Progress
éProduction_fbx Completed 100%

Last submitted Processingti
31272021 2:5...

Open

Production_5 LAS J{‘J Cancelled 0% 11/27/2021 5.... Unknown Open output clirectory
Production_3s... 35M @ completed IR 3/16/2022 9:1... 0:01:00
Production_3s... 35M ® completed 3/16/2022 B:2... 0:12:06
Production_3s... 3SM ® completed 3/16/2022 7:5... 0:01:06
Production_3sm  35M @ completed [EIEINN 3/16/2022 7:4... 0:01:07

Production_16  LAS & completed 100% 11/30/2021 ...  0:00:22
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General Spatial Framework Geometry Constraints ~ Reference Model  Processing Settings

Spatial Reference System (SRS)

8 WGS 84 / UTM zone 29N (EPSG:32629) v

Region of Interest IE(_““ n N

Show details

Tiling
Regular planar grid v

Tile size (meters): 140.000000

Show details

Overview
Dimensions: 472 meters x 547 meters x 51 meters

The tiling contains 16 tile(s).
Expected maximum RAM usage for a job: 11 GB
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Bing Maps Et2l A|AE

ContextCapture 0l M = Bing Maps Et2 A|AE0 (et THAS =algh &= JUSLICH
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Geometry constraints 882 Soll J|= 3D HIOIEHE A0t THAS HHGtD MH LEE LXE %

20 et IS MAUMA =30l 228 A LFI LAY = UASLICLUHE S0, 201X &= S, BHAF
PR L= UM A LI LAE 2~ USLICH
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General Spatial framework Reconstruction constraints Reference 30 model Procossing setungs

Name Type Description Resolation (units
Model Surface constraint imported from file ‘Model.oby  0.0068758

Add constraint from 3D mesh...

Add a new surface constraint defined by
a mesh file

Delete constraint..

Remove selected constraint from the
hst

_1&/ 68: Reconstruction constraints &/

FAASZ SO HMEXN o Mgt x2S A = UAsUCLEXE 2E0] 010 A= B MHA Hg 2240]
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Reference model &S Sofl 2 LHFE L2 = 22ISLICL HII0A L& SES 22lotHU, elEXIE
HEZotHLEL HAE MEEE =

General  Spatial Framework  Geometry Constraints  Reference Model Processing Settings

Top

Status Retouching  Last modif
@ completed ... None 12/4/2019 2
Tile_+001_+000 (&) Completed ... Geometry  12/4/2019
Tile_+002_+000 (&) Completed ... Mone 12/3/2019
Tile_+000_+001 (&) Completed ... Geometry
Tile_+001_+001 |
Tile_+002_+001 |
Tile_+003_+001 |
Tile_+000_+002 |
Tile_+001_+002 |
Tile_+002_+002 |
Tile_+003_+002 |

) Completed ... Geometry
) Completed ... Mone
) Completed ... Geometry
) Completed ... Mone
) Completed ... Geometry

) Completed ... None

) Completed ... Geometry

0/11 tile(s) selected

_1&/ 69: Reference model &/
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o HIXE:8M&EXZES CIHXZ =EELICH
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Mel €4

Processing settings &S Soll & UL V= 8 S HIRSH M Xl 28 S d8E = JASLICH

D HES AEGH| &0l Mel &8s HEHOF & LICH MA Ol Al %S ™ Processing settings 12 &4 0|
@%QE MetE LIC

General  Spatial Framework  Geometry Constraints  Reference Model Processing Settings

Preset type: | Default | Load preset... |
Selection of matching pairs Generic ~ | Save preset... |
Photos used for geometry Exclude thermal imagery ~

Extra precision, larger file size (tolerance of 0.5
Geometric precision Extra =l - .p. 5 U

pixel in inout bhotos)
Hole-filling Fill small holes only ~
Geometric simplification Standard ~ | Tolerance: pixel ~

Apply the color correction computed durin,
Color correction mode = Automatic (machine learning) ~| PPy . X P £

Aerotriangulation.
Untextured regions representation |Inpainting completion ~ | Untextured regions color: | | |
Texture source priority Photos first ~

Clamp resolution of geometry if finer than the
Geometry resolution limit {units) | 0 | .p _ £ 4

specified limit

Clamp resolution of texture if finer than the
Texture resolution limit (units) | 0 | P

specified limit

Low-level settings

No item defined.

_1&/ 70: Processing settings &/
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General  Spatial Framework  Geometry Constraints  Reference Model

v Brush Size: | 25% [ Tolerance:

Brush Selection: Select faces, use Alt+Mouse to navigate. () Message(s). ® 8

&/ 72: Touchup user interface: &% P2 42 016l 7 +F&LILCL
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W Retouches Batch Import *

Import a selection of retouched tiles in the reference model.
Warning: retouches override the existing reference model and previous retouches (if any).

Geometry touchup

Tile Path Last modifed IAdd retouched tiles director‘,r...l

Remove selected tiles

Visible texture and geometry touchup

Tile Path Last modifed Add retouched tiles directory...

Remove selected tiles

Options

Spatial reference system: Local East-North-Up (ENU); origin: 60.167280N 24.948200E Edit Spatial reference system
Tag policy for the modified tile(s): | Keep tags w

0 retouch(es). &’ Import retouches Cancel
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3MX production
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General Propert

Running...
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3D view

The production is running.

174 milestone(s) completed.

Running processing time: 8s

Monitor job queue

Format: ContextCapture 3MX

~/  Details

Milestones

)

A% Xl S0l 2Z 0l &IotE Xel S oLt Ol

General

4

Tile_+000_+000 [Reference Model]

B Running Tasks 1

12/05/2022 15:57 -

Export3DProduction (Tile_+000_+000 (3MX))
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Ete = XMl SAHO et M AMEH2 DetailsS 2HHGHHA H Ml A
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s

o

Properties 3D view

@ Failed

The production failed
0/4 milestone(s) completed.

1 error(s). View error details | Export log file for technical support

=

'e Error Details

=3 B Export Logs

Error details for Production_7

€  Input data not found

5/12/2022 3:52 PM | | Task Internal25DModel (Model [Reference Model])
Input data not found. Please check location. ("C:/DATA/AcuteProjects/SurfaceConstraint_TestProject/

_1339.jpg" [InputData_NotFound]
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: o Sy |

_7Z/ 85: ContextCapture Viewer 0ff H A/ & H| & Z /9 0ff
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General  Propertes |

Production ID: Production_1

Format: OSGB

Output drectory: D:/TESTS/FOM/FOM/Productions /Production_1
Cotions

Keep untextured regions: true

Color of untextured regions: 128 128 128

Inchude texture maps: true

Texture compression qualty: 75% quality JPEG

Level of detal size: Medium

Type of level of detail: Adaptive tree

12/ 86: 4/ Properties £/
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N2 LM II2 a2 Z2OHUM IIE &2 = = ASLICH

Production - Production_1

Orthaphoto/DSM production

General  Properties 30 view

> Point Clouds

Survey Points

Generated Tie Points

Splats

Orthophoto

DSM

Grid/Axis
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B Exton_Campus

v Capture
. Block_1
. Block_1 - AT
Block_1 - AT - AT
v Block_1 - AT - AT

-AT
v Reconstruction_1

@ Exton_campus_OB|

@ Exton_sample_35M

& ORI 3

© Analysis

Capture

New Block
Import Block...

Import Block from PWCS...

Extract Ground...

_7&/ 88: Feature Extraction &' A/ &
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https://communities.bentley.com/products/3d_imaging_and_point_cloud_software/w/wiki/64523/contextcapture-2023---analysis---extract-features

q Extract Features

* Technical Preview. Learn more

Select feature type and settings, then click 'Create’ to proceed.

Type Settings

Orthophoto

2D Objects Detection 2D Segmentation
Segmentation

3D Objects Detection 3D Segmentation 3D Lines Detection

Selected item: 2D Objects Detection

Detect objects in photos.

Create {Cancel

_7&/ 89: Feature Extraction &' 2 &
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ﬂ' Extract Features

* Technical Preview. Learn more

Select feature type and settings, then click 'Create’ to proceed.
Type Settings

2D Objects Detection
Detect objects in photos.

Inputs

Photos: | Block - Block_1 A4

Feature Extraction

Photo object detector: | Manholes_1 (D¥/Detectors) V} Download

J&90: 20X & 2E LI0/E, 247/ 2 &5 o

b
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4. "Create"E F2H ZZHE EZ| R0l MZ=2 "Analysis & ="01 F=IJtELICH
B Exton_Campus -+
v Capture
Block_1
.| Block_1 - AT

_ Block_1-AT-AT
v | Block_1-AT-AT-AT
v Reconstruction_1

@ Exton_campus_OB]

@ Exton_sample_35M
@ o08)_3

@ oBJ_test1

& OBJ_test2

@ Production_7

@ Test_LAS

JE/91: ZZ2F E E2] 79 Analysis &=

5. ZQ8tA Analysis 8 52| Settings 12 JtM &S RS LICHO: 24& 292 =010
CIOIE S 2220 AE 2 XotES &).
Analysis - 2D Objects Detection_1 =

Overview Settings Result

6. Submit HES =2l 24 H=S AIHELILL 25 A4S HE6H1 SubmitS =8 LICH

7. Overview UM MHES HdESLIL

Analysis - 2D Objects Detection_1 Cancel | =
w 2D Objects Detection

Overview Settings Result

Processing...

. 2%

~ Job Details

Milestones 1 ) Running Tasks 1

Emea80593 &
2D object detection

J&8/92: Z& && T2/ =2/ Overview &

ContextCapture 173 AEX} IH0/ &
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Analysis - 2D Objects Detection_1 < =

 conpleczd

Overview Settings Result

Outputs

J&'93:2D 2 A 2 Al 22

ContextCapture 174 AEX} IH0I &



a
0o
ro
o
rn
Jm

ContextCapture

i
i
10

0x
N

02

M
30
o
1o
o
Ju
e
c
a

Extract Features

g Extract Features
* Technical Preview. Learn more

Select feature type and settings, then click 'Create’ to proceed.

Type Settings

2D Objects Detection 2D Segmentation Orthophoto
Segmentation

3D Objects Detection 3D Segmentation 3D Lines Detection

Selected item: 2D Objects Detection

Detect objects in photos.

Back \ Create Cancel]
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2D Objects Detection

Ol= 28s RHot= 001X 2HHME 2 XIS LICH OIDIKIOIAL 2HaL 24 =201l AFZLE AR SO 2
JAELICE Ol st AFLE ARl AR F2 2 = U2 H & ClEEH 2|0l ContextScene I Z J| S &
2= USLICH

Type Settings

2D Objects Detection
Detect objects in photos.

Inputs

Photos: Block - Block_1 ~

Feature Extraction

Photo object detector: Please select a detector v Download

J&'95:2D 2 A 2 A £ F

Yo 0l re= adotdH LS UIOIEE =6t E4010F gLICH 8l Us Sd= FEotd = AL 0|
el IZ2MES =5 S otLE d=ai0F LI
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2D Segmentation

Ol =2 RHot=0l0IX2 ZHHE ZXELICHLOUOIEAIES 2 0|01 Xl= AFZ0dl= 2 X210 Tet
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SO0 FE2 AHGHH LS HIOIHE MEIGHH S4010F &LICH 8 TS S4 2 FE0dtel= ALRIO|
IotE IZ2MEQ| S8 = otLIE &= ol OF & LICH

LSt ContextScene A2 AIE0IH AMX S=E2 MSE = USLICH

8z S FESHU U= ME 2 2XIE SESLCH (220 Z2X1010t l= 8 2 Download
HES AMESIH 2RI OG22 & HIOIXIZ It AIL)

A AN I=EC 2 =EELILCHL 0 H2R & 00X 2220l CHEH PNG OFA D M A ELICH Ol OFAZ 9 2
M2 550 ANEE S (2R7e 4 Ek)% HSLICLOI oA HEE 248 Y HE Z2HUH JISEH D
S+l ContextScene L 2 £ 00| X0l HZE LICH 2D 2& Z 1= Result 10 A AFR THE S AL 6L
BEE £ ASLICL
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2D Segmentation
Attribute a class to each pixel of photos.

Inputs

Photos: | Block - Block_1 v |

Feature Extraction

Photo segmentation detector: cracks_g (E/Downloads v ] Download
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3D Objects Detection

3D M A= 28 o =20 283D AH (& HE MSELILL 28 4= 22 & QAL
3D AME=XMLEAL=Z JISELICL

Oletis g2 W

e DGN

e Cesium 3D Tiles
e SHPESRI CH2+H Tif

e

3D Objects Detection
Generate 3D objects from objects detected in oriented photos.

Inputs

Oriented photos: | Block - Block_1 - AT v |

Feature Extraction

@® Photo object detector O Import 20 ohjects

Photo object detector: \ Manholes_1 (Di/Detectors) v | Download

Hide options

Use 3D data: C) disabled

Min Mo. of photos to validate object: |3 |

Maximum viewing distance: |1DD.DD | u

Ol =24 M2 22 24Hot= 001X 2XME ZXNELICHHOIEHMESR 2 0|0 Xl= AtEZ6t= 2 X121 0l
(et =F & LICH
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ContextScene & = = =0l OF & LI Ct.
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3D Segmentation

3DEY AY2 ERE LQE SctRES MH6t= O AFESELICH

3D Segmentation
Attribute a class to each point of a point cloud, starting from a mesh or
point cloud.

Inputs

® Mesh O Point Cloud O Segmented Point Cloud

Mesh: Reconstruction_1 - Exton_sample_35M [35M) v

Feature Extraction

Point cloud segmentation detector: outputs (D/Detect'v Download

Detect 30 objects: C) disabled
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ContextCapture Editorfil A= 2342 2F &

LAS &

= POD I+

3D =S 0A JHE 3D M E LHEE =5 ASLICL OIS 3D M =3D ERE ScetRE 2FE JIEICZ
HECM, s2e ScHA2 I8 ZENAM 112 HE KM E THESLICL3D HE 24Xl XMLE IS5 11(3D
2H HXZ)DGN L= 0B I 2 WEE 4= ASLICH Oleiet 3D M2l S E (XS DGN E=SHP EA4LZ2 T
LHE2E = JUSLICH 3D 20 A I E 3D 24Xl = ContextCapture Master 3D-View il ZAIE &= U
Annotations - 3D Segmentation production, 1 job(s)
General

Properties 3D view
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3D Lines Detection

Olcdet AAES E2 Ul 23clE X2 I EXNYLICHL =0l 2&0l NI EE OI0IX0A A ZE = 01+
F=HQE ZeAREN TSN Y L= X+ 242 Aol HEstELICH
3D & = {0 DGN ZAlC2 LHEH

2 ContextCapture Master 3D-ViewOll Al Z2ES = U2 H FIt 1
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Type Settings

3D Lines Detection
Detect 3D linear geometry on a mesh or point cloud leveraging 2D
segmentation on oriented photos, or by 3D segmentation.

Inputs

® Mesh O Point Cloud O Segmented Point Cloud

Mesh: | Reconstruction_1 - Exton_sample_35M (35M) v |

Feature Extraction

| 2D Segmentation (on Photos) W |

Oriented photos: | Block - Block_1- AT - AT - AT W |

® Photo segmentation detector O Import segmented photos

Photo segmentation detector: | cracks_6 (E/Downloads W | Download
Hide options

Compute line width: () enabled
Remove small components:  |0.00 | m

| Back ‘ Next ‘ Cancel |
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Annotations - 3D Lines production

General  Properties 3D view

Orthophoto Segmentation

Ol SE == M2 A 2 X100 J18tot0 ZAFALE S| 2 AN 2cHASE XN EELICH
Ol el Z20t= LA PNG UIADA AS 0|E L2 FAAHY(R A E B DSM)RLICH
Orthophoto Segmentation
Attribute a class to each pixel of an orthophoto.
Inputs
Orthophoto: | Reconstruction_1 - Qrtho (GeoTIFF) v |
Feature Extraction
Orthophoto segmentation detector: | Cracks_Ortho_1 (I'v* l Download
Detect 2D lines: () enabled
Detect 2D polygons: () enabled
Ol ol &= OOl = & M ContextCapture T2 X E A MelE A AN /€= DSMO| H L ContextScene

SIAIS MESHH JtNE == ASLICH
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&2 0/ I BIHEO ZR ZAANE SEE3D M A HE & ZAF AN L DSMOIA B F2 2 =+ S =LILCE
2.5D M OWA HEE SAAIY ZDSME & AMEE + &&L/CL 12/ LF ContextScene &4/ = AtEoFH

gyeozs MeE AL/

PNG OtAT= AFE R Z2l 8t Z2XDII0A =&et 272 ZUHYLICLPNGOtAT=E XN SE5H O
SAAIR S QB0 LICHLPNG OtAZ S| 2 AN = 2 XDI0A H2le S A0 HEots D7

UASLICH

&= ASLICLOI=EGIS AZEAN O A
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https://communities.bentley.com/products/3d_imaging_and_point_cloud_software/w/wiki/54656/context-insights-detectors-download-page

Ol HIOIXl= ZXIJ] &€40] 2 Q& [l ContextCapture Masterl Al 2 & 4= U SLICHL

Type Settings

2D Segmentation
Attribute a class to each pixel of photos.

Inputs

Photos: | Block - Block_1 il

Feature Extraction

Photo segmentation detector: | cracks_g (ExDownloads v ]

_7&/ 96: ContextCapture Master O A 2/ X1 7] CF2.Z = B O] X 24 A2

ol ECA LRI UA=ER M ZES SH 2L QLES NEGH QP AIES 848 +UES
SHELCH
ANH ==
2N
Kl == 2 ContextCapture 20232] J|= EIHEHNA T &= &l IS LICHL
Ol =2 Chyst L (O OIDIXI X - 2AZ BIAY HelS I E3MX U4 - LEX: BetMo2 =5&
NHZOIE L A2 HIXIH ZOIE)IA XIH £E=HIXEH ZQE 22t %Q% FEELICL
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N2&= g8 UolH= St 25U
- 3MX £=3SM & Ao M= 0=
- LAS,LAZ,POD £= OPC A9 ME= ZQIE 22RE
- 2 & st=g & H6t= ContextScene( =
ME S22 22 ZE SetREZ XS L HIXHS & IHX SN AE JHAIH, Ol= Z 1 3D 7 (Result
B0 EAEHCO&E ZOE SHREHACZ HEE &= UASLICHL
0l2{8t £ & Microstation £= ContextCapture EditorOil A 2= 24E UWEW DTM £= TIN i+ 2
ol gete = ACH, XN ZEZ MLots Y I+ E d8e == UASLICH
bt YIE2
NH == &2 MH35He M ContextCapturedil M 2 HHe= O 2sUt
1) N FZ2UHANE Z0H FES LA YUS L EFS Z2ASLICH
2) 2ot 3R SE UAES 40 A2 G922 FES MEELICL0l=3D RUIA S
HlOIEﬂSettm )0l & E 238 & ASLICH
3) E XML ENESHL 2E & A2 dHSLICHA &SHHAH ContextCapture Engine0l Z ).
4) 3D = (Result &) 0lA 20 SCISLICL SH ) & UOIHE 28101 = JASLICH
sXE s 2AA2 08 4@ &S LT
AHF== Xl
HIINME ZOE ScetREE NEe XNHS ddol= ©HHE KHAloH £E gLt
N =5 A%
ContextCapture QI E{H O ANA XIH === Mdot= E O 20l ASUICL NE Ml 238 L 28
NEe == Ae Heta U E SLICHL
1) O LEtNoIYHOZ = 3= %S € 1) "New Analysis"S 1 €45t C} S "Extract Ground..."S & EH&HLICH
ContextCapture Center
New Project... Ctrl+N )
Project - GrazPro
Open... Ctrl+O
5 blocks, 22 analyses
Open Recent
Save ProjectWise project
MNew Capture Associate a ProjectWise
Reference Manager...
Basemap Manager...
Free Up Disk Space...
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) DIRMEER| | I2MES MEHF
a5 dEe gL Ch
P GrazProject —+
v Capture .
[ Block_1
| Block_2 (Block_3 (Blo...
> | Block_2 (Block_3 (Blo...
3) Z2HE ECHAM"+"HES 21

B GrazProject

v Capture
_ Block_1

Project - GrazProject

ProjectWise project

| Block_2 (Block_3 (B

22 analyses

=S M "New Analysis" H 1) "Extract Ground..."

New Capture‘

New Analysis‘

Extract Features...

E ct Ground...

Capture

New Block

Import Block...

PR - e &): |mport Block from PWCS...
L& Block 2AT © Analysis
. Block_&
. Extract Features...
> Analysis
4) Ol ME s L UE He St YEHE AABH == 48 dect= ALICL O E2HEN M
OIDICHE I MIMSZ2 WE SXNH ZZHE E2|NAN OIS HdeotHYIAE2 ':?H}OHA-I =EM
"Extract Ground--"HES 2 = USLILL HH S S ISA LLEEZH
Ol5=0ll s 28t &=0l ZAIELICH
B GrazProject + Production - Production...
v Ca"i“:w
. Block_2 (Block_3 (Black_3 (Import_Block_Graz) - extract - ... Overview Settings Result
~v [ Block_2 (Block_3 (Block_3 (Import_Block_Graz) - extract - ...
> Orthophoto/DSM_1 —
&“a C leted
> Orthophoto/DSM_2 @ Omnpretec
The production is completed.
v Reconstruction_8 S .
Processing time: 2min 2s
@) Production_35M
T Open with ContextCapture Viewer | Generate Web-Ready Scalable Mesh
ORI SEHES X =& USARS AA 302 0] HIESZ0] 010 888= 0180 AsLICHEHE L
2 EX)
TER=IRE
N == Ut 0A LSO MESE 24 222 M-d0| ItseLICLAIZEA=E A4 LS (RE &
CIOIEN) ¥ XIS =0l AASE ZXIIIE &0l OF & LICH
& 1: ContextCapture= J|& AIH 2 X J|E Z& oK IEIH, TE XD Ie S U222 =
USLICH
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Extract Ground

g~ Extract Ground
* Technical Preview. Learn more

Select input data and detector (the default is selectad), then click 'Create’ to

proceed.
Inputs @
® Mesh (O Paint Cloud
Mesh: Reconstruction_8 - Production_standard (3MX) W

Feature Extraction

Ground detector: Ground detector 1 (default) W whnload

®
©

| Cancel l

24
XM 28 RE 2 Mesh &£ = Point Cloud2 & &4 EHLICHO| 28t 2 Mesh).

OB US EEU2 SEUM MEZ26ILES SEELICLMEZ220/01 JIE M2 SHA ZHE DO
SetE=E HES0LIZELICH: s8tte 28 Y g4)
SE0/HHJUA=ZR EIZNEW S&t= NES(0H4 C= 2 E 2& )OI OLS A X ZE
AYLICLOol 2R Uss 8 = ASLTH

o IEHI=NZ2 UM MY L= H0E Zet2C HAES M4 9E &xX)

o CIA32 UI0IEE &#ZE30t0 ContextScene & & IH M A (1) =: ContextScene AHE & X)

ZXID| HE(2)
ContextCapture= J|& X H =& 2 XJ|E E&ot0] &XIELICHLCIE ZXIIE ArEatI| E DA

tset 2 M 22X J= & MOIENAM &2 L 22 EE = ASLICHU A XS] Download & 3
EX).2Z0 EXEHHUS2EE IE2 BZE HE6tH ZRIIE S = UAsULICHL XEH 2 X112
HOOIEE HEO U= B2 HII0A &1 &= AsLICH
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Ne == HH(3)
"Create" HHES 220l T2 HEC 24 517 =2z ME2E &= dd &L
50| =222 HE T Al Dt Xl & (Overview, Settings & Result) A &8 L 2 2E MES
ADSE MY, =S &g = UASLICHSubmit HE S
B GrazProject + Analysis - Ground Extraction_1 =
i Acti Ground Extraction
~ Analysis ‘ o
@ 3D Segmentation_clipped Overview Settings Result
" Ground Extraction_1
@ Ground Extraction_2
@) Ground Extraction_3 / # Ready for production
@.‘ Ground Extraction_7 You can review and modify processing settings in the Settings tab.
@ Ground Extraction_111 Click Submit to start production.
@ Ground Extraction_clipped
Ol A= NI F=Z0| OFE AIEEIA 2SLICH
ol By
Settings i S & &iot D 2 HIOIHEBD R0l EAIE)X £&ZBD 7 LEXS £F3 WE)sS ZEot= 20|
Z&LUICHL
O 0 2t HAEE HO(Z22E EF2 AEB)otD FE JAE NEHE =% ASLICH
NES
AHS ALY EHIIE QD =5 =5 A S AEHJACHH Submit HES =21 0F & LICH
22T 9o My
Ol= HE AR HAHIKICH Kl SSEE MHistot= Ol Il S S&HLICH
ANHZ=E2otde= H2 MO 6t A Settings & 2 2 JtAl Region of Interest & & AFS&HLIC
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Analysis - Ground Extraction_1

Overview Settings Result
{3) -
() QD (e]o|w|=)

O

D~ iy e g S

J&/97 Z2/& | FZ Z(Vexcel Imaging H| & L]0/ E)

(1) Ol E2&=3 Ii £ 2| "Edit" B = (Region of Interest
2 A& LICL

(2) ZHRNM ZEE 22510 2D CH2E 2 M0 S4 6t
AZ2HS EotD 2Rst HAOZ XelE MetE 4= USLICH

(3) CHAUSE S MHMOM "Accept" HES FENU UAES CHAI HED A2

(4) OIXIZL o2 "Submit" HES =2 RUS MSot CHYs =232 MHEHL
& x).

JIEC2UE 2SI & = JASLICLEH WEQ"."HES FSLILCL

Region of Interest

Import...

Export...

ContextCapture 190

Type

Ground Extraction

Extract ground points from input
mesh or point cloud.

Inputs
} Cloud
Mesh: | Reconstr abv
Feature Extraction
Ground detector: v

Region of Interest|Edit| *+*

HF F)ez &4

P

!
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CHAtAIE 2= A

AFEAL IF01=
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Submit jm 4
¢~ Submit

Al

Submit job for processing with ContextCapture Engine.
Check output formats, then click 'Submit’ to proceed.

Outputs

Segmented Point Clouds
OPC/Contexts

O Las
M LAz

m

cene

m

O roD

Spatial reference system: | WGS 84/ UTM zone 32N (EPSG32632) V|

&m

10| XS 22 OverviewZ HAC 1) &Ho NHES D SLICH
x

1
e
]
-
0o
=
=]
¢°]
]
B

A BT MNBEEO| SetIHAl Z=CHH ContextCapture Engine0] &1 8 SQ1X

HAMEXl "Cancel" HES =2l M2l E FAE = ASLICH
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Analysis - Ground Extraction_8
m Ground Ex

Overview Settings

traction

Result

Processing...

~ |ob Details

S0l 2ZHH UHEH LS CIATSUE
=

H IO
c ME=S2 ?XIE E &= UASLICHL

Project * Productions * Ground Extraction_(1
~
Marme

GroundExtraction_las
GroundExtraction_laz
GroundExtraction_opc
GroundExtraction_pod
Segrmentation3d

Result 80IA O] &2

ZH0AM AIEE

Date modified

A O
T A

2/23/2023 2:14 PM
2/23/2023 214 PM
2/23/2023 215 PM
2/23/2023 2:14 PM
2/23/2023 2:14 PM

HAEEMS BZot0 238 /L= 48 Z2U2)2 HAIENMEE = U
& XM= Type £= ClassesZ 2HE(3)2 = UACH, 2= S A HA,

H ML

CIEQHHAIDLR ﬁ LICH

XH =& RE 2 "3D segmentation"0| 3, CtE 3D &
S0l USLICH
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Cancel ‘ =
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Type

File folder
File folder
File folder
File folder

File folder

AFEAL IF01=



Layers
V Analysis @ T3
Types: | 3D segmentation v |
Classes: [ Non Ground, Ground v |
Al
Point Size: None
|B B Ground @
|E4 B8 Non Ground
> 30Meshes
11 =: ContextScene 2 & Al S
Ol AAEZ2= LS AI0IH Ol E AH=Z0tH LS HIOIEHE MEHS &N 04l L= EZ01E Z2tRE9
SE2Z & X 06t= ContextScene2 & 4= USLICH
CEAZYE SH= 0128 Itz S HOIH(EZ, L8 L SRS)E FAE = A0, Hel 832
SHH2 USLICL Ote= 2= Ol Al LICH
0H 4 &8 2 & Y St= ContextScene
Otell= "C:/DATA/Terrain/Scene" 0l £l X| &t ContextScene.json I 2 2| 0l Al 2 LI C}.
MeshCollection Z1EHI O L 0l 044 (3MX L} )t StLE U2, X Z22= 04 HIOIEHS |AXIE &F&LICh
{
"version" : "5.0",
"MeshCollection" : {
"Meshes" : {
"o" : {
"Name" : "Production_standard",
"Path" : "@:Production_standard.3mx",
b
b
T
"References" : {
"o" : {
"Path" : "C:/DATA/Terrain/Scene"
¥
b
¥
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SL:EHIN ST LS AMGEE AADAI 20 2= 02 2| 0] 2 ContextScene.json 0| 0 OF

H
e
Im
Y
)
40
In
e
Ju
Mo
x
R
ol
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s
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%
72
()
[«]
5
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- POD EAIS HOIE 22tRC
- HOIE SCtREZY FXZZ2(0: HYH A2id=02 X ZZ22 HAHIE)
H0: U= ZE ScREE FIIot= B &N 88 £ = MEtEI == ol OF ot H, ContextScene2 = & &t
A0 U= =2 EHS F-dot= ol 2FLICH
{
"version" : "5.0",
"PointCloudCollection” : {
"PointClouds" : {
"o" : {
"Name" : "Production",
"Path" : "@:prod.opc"”,
}
}
¥
"References" : {
"o" : {
"Path" : "C:/DATA/Productions/PointCloud"
}
}
}

ContextScenesOfl CHSt AHAISHLHE2 0] A& S XS AL,

&Y € 2LIH

Job queue monitor= & H2| S AEHE ZAlotE =& IHE L LICH
Y I ILHE EH S I JH| HwUA CHE 10 22 Tools > Job Queue MonitorE & 4G Al 2.

Job queue monitor
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Open job gueue directory...

Close
72/ 98: Job queue monitor I} £

V:flabs
(S| engine(s)
1Z p pending joh(s)
"% 0 running job(s)
= 0 failed job(s)

o
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3
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tc4 ™ Open job queue directoryS
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ContextCapture 22t & X2l &

ContextCapture= ContextCapture Engine=S At& ot F3IDMH HHE XHelg = UAKIEt
A E Xl ContextCapture 2t E X2l MUIASE AIE6I0 2etREUM HelE Ade =5 USLICH

=
Qﬁ
0B
b
_'\J_ J—
I
v
=
w

=8 £= AWM Submit HES 2! 610 Process on the cloud
el MEIA0A Kl E HSE LT

[ .
| @ Process on the cloud X

|
| [N

& 4310 ContextCapture SctR =

Process on the doud

. Create a ContextCapture Cloud Processing Console project to process on the doud.

File name: CC Project - cloud
| = File location: D:/CC_Console_Projects
1
ProjectWise project: Reality Modeling Prod Edit

\
|

Cancel

_7&/99: Process on the cloud [} S} & A}

ContextCapture Cloud Processing Console T2 M E = SelRE M2l NE= 510t fIo Z2HE
_@EOHA-I @@E LI Ct.

_71&/'100: ContextCapture Cloud Processing Console &/ £ I 0]

222 Meloll Cist XtAISH LI 2 2 ContextCapture Cloud Processing Console AtE &Y AN E
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2 HIAl

ContextCapture AFZ X0 H= &2 3D ZHIZE CIHU0 HAIE = U= LSt SE0 AsLICH

o

ContextCaptureOfl A O|0IXI2t L& L= HA=2 HE SR &= JUSLICH
o
TT

ProjectWise ContextShare= & 4!

& &l 00l B & ProjectWise ContextSharetil 22 =8 01 £ 0l S

1. = £ = X 22| General & 0l Al ShareE 22! &HLICH

o ProjectWise ContextShare

The Bentley platform to manage and share reality data.

To access data associated with the current ProjectWise project,
you can use this bnk: Va
Reality Modeling Prod

Cose

Share on ProjectWise ContextShare

o Upload to ProjectWise ContextShare

Mame * |Contex‘cCapture Block |

Acquisition Period | 30/10/201017:08 ~| to [15/11/2010 17:09 ~ | CIearDates]

Uploaded data will be associated with: Reality Modeling Test1

Fields marked with asterisk (*) are mandatory. oy [W[s]LEIE | Close
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JooliOr e == UAsUICL EX], cH0[8 A R A EHE FRGHYAIL. &4 HI0IED
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ContextCapture Web ViewerZ Hl Al

ContextCapture Web Viewer= ContextCaptureOfl Al SMX &40 2 MAHE 3D 2L S & ALOIEO HAISHHLE
Lot ol M& S A= LICH

2 2 ContextCapture Web ViewerS AIE06I0H 2 & AIOIEUHAN 222192 3MX HI& =3 A2 5HE £
USLICL O E HH=dgAs %%%WebGL3Dv—r01§, HAIS EBHEx L ADIEZN HEELICH £
Z 002 AI26HA L 10 WebGLE XIRote 2PEECI2 MM Z=6tH & HIOIXIO & H Z&g £

USLICL A X2 & AIOIE N 3D 2 S HAIGHHLE Z&olHH IMX MAS2 & AH = 2201 It Y
HEA A MY A/2E = HS U ERA(0: Azure Blob & = Amazon S3/CloudFront) 0l & £ =6l OF LI Ct

3D 2EES3MXEACZ A0 HAlIGt= JtE 2test g2 sl Z5LICH

o 1EtH: WebGLready S &2 MEIGI0 SMX EACZE 2 .
o2&t Xl Production Z (Scene & App o2l 20 ZE)E & AHO 2SS LICH
o3& http://your_server/your_production/App/index. )

ol

2]
1
P>
i
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https://connect-realitydataviewer.bentley.com/

ﬁ Production definition

- [m]
Production definition
Define parameters of the new production.
Name Format/Options
Choose output format and options for the production.
Purpose
Format/Options l i i i 5
Format: | ContextCapture 3MX o] 3D mult!resulutlun mesh format, optimized for exchange with Bentley
] applications.
Spatial reference syst...
~
]
Extent Web ready
Include proxy 3D model
Destination
Generate ContextCapture Web Viewer application

Level of detail (LOD)

Generate LOD across tiles: C)

Type: Adaptive tree

Node size: | medium (~35 kB/node)

Include texture maps

Color source: | Visible colors

Texture compression: | 75% quality JPEG  ~

Maximum texture size: 2048 | pixel

Texture sharpening: Enabled -~

v
< Back @ HNext Submit Cancel

1&'101: A E3MX 4 A F

A /2= H3B U ESKA(0: Azure Blob/CDN & = Amazon S3/CloudFront) &
LHO e THMEtUHE2 "MA=ES

== =l ANES HiEots HE"MES HXOHYAIL.
OE =0, 2UE MYUSHHLI ROHUAN &olg = JAEE 2L H4HE FI6HH S AL E ANEXN FE
=T ASLICH
BIAE HED|IWA OFAE 3MX T2 S HASHH & AIUSIE 2HHH3| 2EE = JASLITH
AAIS 22 3MX 2 B L E H# AT AL
ContextCapture

199 AEXF 0/ =



Construction aggregate quarry

Comttruction aptregst
Input: 1 170 photog

Ground resctution

Ty
n with 3 Sany DS

C-RXLOGM3 camera and using & Rovadem U 130 diore
1/ pinel tmages snd model courtesy of Bris

et Veyrier M

_7&/102: ContextCapture Web Viewer

ESof & H0/X 0] ZEE3MX HFE2C 0 AFEA Z 2
L=

&= &0 &8E
&2 LT oIE G AIEELICK
Z10: ContextCaptureOfl | MAE = 3D RES el 2 2EELICLUHH2 2H SS8HOlEHHE L AELY
2|5l 'Generate LOD across tiles' 14 & & S 24360 2= EIL 0 LSt 229 &N Y 2T E MH5t=
A0l ESLUICH

CesiumOi| Hl Al

ContextCaptureffl M= A E

2l S ol MM HE2 3D 2L S Cesium 3D Tiles @402 A6 Cesium &
S T2 00 ZAIE 2 ASLICH E8t ContextCapture I A 0 & HAIE = JqE= JI2 Cesium ES
D2)dHs MHE £ USLICH Cesium2 X O 2 Z2I0IHEN JI B2 £, Cesium 3D Tiles Gl Ol & 2F
Cesiim S ZZ2)HS & & AH S AEE 4= JASLICH
220l Ty MEA & MilA/28I= JS Ul

(Oll: Azure Blobs/CDN, Amazon S3/CloudFront) =
K& ELICH
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Ct=S EHAHIO et 3D 22 =S Cesium S Z2 10 HAIE == AsLICH

1. Generate base Cesium application S & S & &G0 Cesium 3D Tiles @A 22 LS MY S LIC Cesium
S8 T2 32| AL https://www.bingmapsportal.com ¥l Al Bing Maps API 9| £ Jt X 2t Al Bing MapsE
Cesium globe& 0|0 X2 A 22 2 AIE6t1) app_cesium/main.js Al & T2 2| 0 2| | Bing Maps API 9| £
ey = AsUCH

2. &Ml Production = (Scene ¥ App ot?l E2H ZeHE & MHU B2 EFLICH

3. http://vour server/your production/App/index.html =242 Cesium 2 0l YA ASFLICH

RSt 3HAA4EAH OIH0 JI2 S8 T2 NS S AASH EAE = ASLICHL

Cesium S T2 )&l B B E2| Javascript2 il X /2 D E FI16t1, ContextCapture | Al A A &l 3D
QS UED LY, HAH T=HHGISHOIHA Z2EE = UASLICH A EGH H Cesium NI BN E

1]
B
ol
1P
=
to

78/103: Cesium & £& Z.Z 720§ Cesium 3D Tiles &4/ 2 £ J| A/ & Orlando 3D 2 &9/ 0ff
ContextCapture O A1 2 & &l Cesium J/2 £& ZZ T&0) #E 2 POl L]0/ E FI}6lE [ 2F100 =2/
JavaScript ZE=0F 22 5L/C
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https://www.bingmapsportal.com/
http://your_server/your_production/App/index.html

Sketchfab0fl Hl Al

Sketchfab2 3D 22 2 HAl, B3R, £&ot)| 8t EsHZ 0|, sketchfab.comWH FEZ S

SketchfabOil HIAlGted & &M OB HAILZ M2 S e ol
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O B2 2 285 HLELODE Z&6t= OB M =2 XNJ & Xl &SLICH

1. OBJ Ml &2l General & 0l M Publish to Sketchfab= =2 & LI Ct.

ContextCapture

FIULULLIUI — FIUUULLIUL_ D)
enter your description here &

0BJ preduction

General  Properties 3D view

@ Completed

The production is completed.
Processing time: 4min 3s
Open with ContextCapture Viewer | Open output directory | Publish to Sketchfab

_1&/104: OB] A/ %S/ General &

S5 =01 0|0lE £ = Sketchfab & H 0l A &01E &= ASLICH

e Publish to Sketchfab

Sketchfab is a platform to publish, share and embed 3D medels, you can sign up for free on
sketchfab.com.

-

S
=

H

files
Tile.obj | 3 fle(s) | 12M8

i
H

Model name * Mascaron Freel
Descripbon

Tegs (space-separated)

|| Private model (PRO account only)

Password (optonal)

H
|

APTtoken * s - ——
You can find your API token in your Sketchfab regstraton confirmation emal, or in your Sketchfab settings,

Al felds marked with a * are mandatory, (@ publish | [ Cancel
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o Options: NAHE ZS X HFLLICHEAM = SIEHXI S0l cidote 0 =S50l 22 2SS A=
).
Optional: ®! AKX Xc|EIX g2 H Mas HISLICH

e Directory: 0| B &= CIE IS AEASLICHOMH & X)

NS EEGHY AL,

_F E
grLICh
3. [&HA Cc’!] clEIXIGH| &0l & X 22 SAH=S MEELICHL

s

X & Ete 2 LIS 0l ContextCapture Master2 It N2 = ASE HA 2 WY 2EE K XISHOF
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e Ol =A== ContextCapturefilAl IS 2 M= = B2 2 RAELICH
o JIZ2HES AMESIH 2IH XIGt= S0t EPO' |CHet HE A S MESLICH B0l 0 H U= E=
2= B0l 2t o CI=Eelol 0l 2XE HEE = UAsUIT
4. 3DSE ZZ1H= AISot Et2 = BHEELICH

Bentley Descartes todesk 3ds Max, Rhinoceros 3D, Autodesk Maya, Autodesk Mudbox, Autodesk MeshMixer,
MeshLab S 1 & F 2L HE AFE0HH Bt S HEELICH

5 clEXI= Bt =S ContextCapture MasterZ Jt M & LIC

o ContextCapture Master: X 21 & 2 2| Reference model & 0l Al Retouches Batch ImportS 22 & L|C}.
o MEH IHO [Het Geometry touchup & = Texture and geometry touchup H| 0| = 0l Al Add
retouched tiles directory HE S AIE0t =& & Bt 0| Z& & CIHClE FIte LI Ch

Import retouched tiles HE S é‘a%' otd CHat &t KHE & LICH
=+ X CIEIIO ébx +A|/\|9

[ R

6. KIZH THAIZ

LEtY S elHXICHH Y Bt 0l ZEE M MAS0l 2HO0IEJERE S4H 2 MSELIC

CS St Y822 A== GUOIEE = UsLICH

o =HEEHL0 X NAH=SS HUOIESLICHL A 20 A Submit update HES =i M= 0lA
Dedoiore =& At = 5I E&LICH

o =ZE EHYS DOl St= M HEHS S MESE UL

oS 2 2| O Reference
model & 0l Al Reset HE S E“_"*%'O*LI Ch. deq4d™ =l O'E CH 3t & XEDH

SELICLEL DS ZXGHYAIL.
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1. Create tile(s) for touch up

!

4, Update tile(s)

3, Import in master

2, Edit tile(s) in 3D application

H& 2te| Z2&

o

O ZuotXet 2= HaA

njo

I
B
]
2's

1. Create tile(s) for touch up &

5. Update tile(s)

t /N

4. Import in master
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SN ELOZMES F2 HA(S2 ZdIYAT) & M Al 20 M Spatial Reference System (SRS)S 1 €46t (H
HZ AIABS B 2|6 OF & LICH
SHEZ AL JE0 AFEE = QI HHOI A= HEAE & X2 M8 SE0| X ZEE J|2 S
NCtotH, =Ot HEiS ol B2t & AIAE GIOIHBIOIAN 2E BAHAS =~ JASLICH
Spatial reference system: |WGS 84 / UTM zone 31N (EPSG:32631) .t
Default

Local East-North-Up (ENU); or||n 41,572310N 2.261570E

Recent
NTF (Paris) / France II (deprecated)
WGS 84, orthometric height (EGM36)
RGF93 / Lambert-93 (EPSG:2154)
WGS84

More
Spatial reference system database...

18107: F2 EFL NLE LE

[ |

S &L AAE GOIEHI0NA

22t X ANAE U S =0l A More: Spatial reference system databaseS 2 & 6t 04 Gl Ol & il 01 A Ofl
0 .

OIEIHIOI A= 4,0000H Ol &2l B2 HX AIABS HQtotH XSS AFEAH 20l et &S -
F

o« OI9IZE AlAE: ECEF(X+ N & 22 ENU(East-North-Up) ZHEHE HIZS 3D HIJIEE
SMEALLICH

e XN2IEE AAE: 2N EIRAME IS 2 ot= ZHEH(0: WGS 84 R/ & R E AN LICH
e S ANAY:FE RY(UTM, BHIZE (Lambert) SHHFFTEH SEZ D= N SSYLICHL E£8F

S8 8 X% &Y BingMaps A|ABS ZEELICE
o AIEXFOI AAE:UEE AMEA FHALICH
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Select a spatial reference system from the database.,
You can also create your own definition by creating new user defined system,
Filter
paris Type [‘l '] [Gu' al ﬂten]
Spatial Reference Systems: 31 items
Spatial Reference System Definition .
NDG (Panis) - Nord de Guerre (Paris) EPSG:4902 .
NTF (Paris) - Nouvelle Triangulation Francaise (Paris) EPSG:4807
Nord Sahara 1959 (Paris) EPSG:4819
Tananarive (Paris) - Tananarive 1925 (Paris) EPSG:4810
Voirol 1875 (Paris) EPSG:4811 =
Voirol 1879 (Paris) EPSG:4821
4 [ Projected systems
4 Lambert Conformal Conic
ATF (Paris) / Nord de Guerre EPSG:27500 —
NTF (Paris) / Centre France EPSG:27592
NTF (Paris) / Corse EPSG:275594
NTF (Paris) / Francel EPSG:27581
NTF (Paris) / France Il EPSG:27582
NTF (Paris) / France I EPSG:27583
NTF (Paris) / France IV EPSG:27584
NTF (Parnis) / Lambert Centre France EPSG:27562
NTF (Paris) / Lambert Corse EPSG:27564
NTE (Paric) /| amhert Moed France ERSG-27561 X
Selection
NTF (Paris) / Lambert zone II (EPSG:27572)
Type Projected systems / Lambert Conformal Conic
Datum Nouvele Triangulation Francase (Paris)
Learn more about this spatial reference system on hitp: /v spatisreference.orgirefiensa/27572/.
(o< ][ conca |

1E/108: LIO/EI B O] A O A1 B2t &L A| L8 L&

TEIS AR50 HIOIEIHIOIAGIA JIE B2 & AIABS W2X 2D ZEHTE HO0IZHA &
SedstLch

=IHOHOH B2 & Eotets HAIXIDOF EAIE = ASLICHL

SH S8 AAHNAES
AT ATAAS

o & ENU(East-North-Up): & & 2 3=
e Bing Maps AIAE: 12 H 23 ALOI2] &8 Al HI”0
o ANEXEAAEN=0IS

IHEQELL 7E8 HES HXotYAIL.

0| &€ & LICH http://msdn.microsoft.com= &%
LICHO2H & X).

H
=
St

W HIERE
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https://msdn.microsoft.com/en-us/library/bb259689.aspx

WKT B2/ E Laot £, NelBE L= MEA T SUAEF X ANAMS HEPRIIIZZ LHEE
= UASLICH
A=Z2 0RA LEZHELZ 21011 Export= S80I PR] W2 2 M A& LICH

VIO2 0% J U IV ZUune D3> CFAJ3:0L710Y

WGS 84 / UTM zone 3N EPSG:32603

WGS 84 / UTM zone 35 w» Export this SRS I EPSG:32703

WGS 84 / UTM zone 40N EPSG:32640

WGS 84 / UTM zone 40S EPSG:32740

7&/'109: SRS Z S/ LIZ LT/

SRSE LHELHH SRS E2AE 2IR0MN ZEE = UASLICLUHEWI = THE BFEHOUM ALZ X B 2| SRSE
MHAISE ot OOl REELICH

MaotE Lt
=0|0l (HEt M2 2 B X E & =5tH ™ Override vertical coordinate system2 22 & L| L.
@ Selection of & vertical dstum (3]

fite ' Clear fiter |

Verticsl dstum Defrition -
Chatham Island 1959 height EPSG:5T71
Constanta height EPSG:5781
DHHNSS height EPSG:5784
DHHNSI2 height EPSG:5783
DNN height EPSG:5733 =
DVR90 height EPSG:5799 ‘
Danger 1950 height EPSG:5792
Douglas hesght EPSG:5750
Dunedin 1958 height EPSG:5761
Dunedin-Bluff 1960 height EPSG:4458
Durres height EPSG:5777
EGMBE4 geocid height EPSG:5798
EGMS6 geoid height EPSG:5773
EOMA 1980 height EPSG:5787
EVRF2000 height EPSG:5730
EVRF2007 height EPSG:5621
FCSVRIO height EPSG:5597
FVROS height EPSG:5317
Fahud HD height EPSG:5725
Fair Isle hesght EPSG:5741
Fao 1979 height EPSG:3836
Fao hught EPSG:5751 >

ok ][ concet |

1&8'110: =& HEH I HE </
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MEIS SHOI5HR! X SN HECIE M ALB X F ol AIAE0l M LI

&1): B H J(orthometric) £ = B o +=H(MSL)S EX 2 ALE0ot= J1E OHZ CIOIE Ol HIoH Bt M =0l=
= o

EGM96 X20|=5 =& HMEHZ AHEotH AEXIH E 2 =3 (MSL) =012 2AIXIE &S == UASLICH

PROJ.4
PROJ.4 8 HES AESIH MELN F2 EF AAEHS MYS
+datum=WGS84").

$0
>
-
O
—_
=
+:
=}
=
k=)
=}
(=g
3
+
N
o
=
(¢}
Juny
[y

http://trac.osgeo.org/proj/wiki/GenParmsE & X5l Al 2.

WKT(Well Known Text)
It HE HE OpenGIS WKT(Well Known Text) S A2 E2& PRI T2 UM NS = JUSLICL O 2R EZ IHY
B ZE SRS B2 A ELICHOI: "C:\projections\myProjection.prj").

PR](.prj) WL 0l Z &= WKT &2 2| 0ll:
GEOGCS["WGS 84",
DATUM[ "WGS_1984",
SPHEROID[ "WGS 84",6378137,298.257223563,
AUTHORITY[ "EPSG",7030]],
TOWGS84[0,0,0,0,0,0,0],
AUTHORITY["EPSG",6326]],
PRIMEM[ "Greenwich",0,AUTHORITY[ "EPSG",8901]],
UNIT["DMSH",0.0174532925199433, AUTHORITY[ "EPSG",9108]],
AXIS["Lat",NORTH],
AXIS["Long",EAST],
AUTHORITY["EPSG",4326]]

Z=JtOlOlE

2F SU B ANLEUNAME 2AF SS == AASELILL Ol e =2 ArE0ot)| &0l ContextCapture & X
Cl&hE 2| 2| "data\gdal" of? CIZE 2|0l £ XI = 0f A0 OF ELICH

HESHASA E =X HMEHE Zgots S X AAHUHAME GTX Jel=8 AFE0t0H XI20IEE
ZAtete = JASLICHL
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AL H2 Z2H X AAY M
CHS A EPHONl M2t AFS X B O B2 BE AIABS MAS 4 ASLIC

P — |
1. Define new user system & SS S EHGI0| M| S2F H X AIAE MES AI A LICHL

WAL | WIIE T T IR ST I TN W

« 2 User defined systems
" Define new user defined system...
NTF (Pans) / France Il (EPSG:27582)
NTF (Pans) / France II (deprecated)

Selection

New user defined system

Type User defined systems

Defiv®on  Cick on Edit... to enter a definition, Edit..

TE111: M A S B AAE M AF
2. EditE 2200 M| S22t & X AI&E.:;% ’églé, LICt.
p -

2 Edit user defined spatial reference system (.30
Enter your own definition in WKT or PROJ. 4 format or load & projection filke,
To find known definitions you can also visit www. spatiskeference org,

Display name | 3 LM&LJ

Definition

Cancel
3. MALSAHES AIARISI HAI OIS0 HoJE Lt
PROJ.4 & &, WKT(Well Known Text), 82| & L&lot=PR] It 2| O|ES HIXRst & LHL SRS HE

Tool assistant

S0 CHE KNS 32 = 43 8 ER0: 58 &7, M &2, 8
AMNEGIESE = 21F= Tool AssistantE Soll SS Z2 A 2 & AIS

SS = JHsEHLICH
o HEHHE BT SO UL SHS FALIC
. CTANBS TUAFDABIISE AU HIE NI ARG O KAS RS 220 0 0l A
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http://www.spatialreference.org/

MEASURE A DISTANCE

Measure distance

Measure distances between points. Click on the scene to create the points of the path to
measure. Press enter or double click to close the path. User can create additionnal measures
or modify existing ones.

Editing existing measure:

® First click on any drawn measure to selectit.
® Click and drag any of the points to move their positions.

® Click and drag any of the segments to split it. and move the new point created.

Shortcuts

Mouse: Left button | Creates a new measure point

Enter or double click | Validates the measure, and allows for new measure creation

Backspace Remove lastest point cgeated

Esc Reset all measures, g in to leave the tool

Measure a distance: Measure a distance between two point| @
N/

J&112: 712 & == £/ Tool Assistant
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Capture Engine
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ContextCapture Engine2 ContextCaptureol HAX S=AULICLOI EE2 AU &S A2 10| WOtR2ERZ
ZEEHNA AHELICHL AI20IA 2= S0 Engine 24 =22 ME EM0l Tt SoM I Sl &GS
IFM A A EHEHLICE —.%*8 UBINOZ s Ha UM ANSOIZNE F&, s HEE X, HE
&, ZLUSHOI0IX OHXI, 228 3D A, O N2 ESA K OHE, B1AK OlS2tA TN, MM dig M4 )2
MEGIH S8 AU =2 T=3D A Z2NAZ 2HELICL

-

ContextCapture Engine2 “1cHZ X 2| 2 XI(GPGPU)UHIA HE H&tsS ZHLACHH AIESELICH 2 A& 2 HY
GPUE 0|2 = JUSLICH

AA S Al = 5ted M ContextCapture Engine BHE St H Ui 2 D1 E 2=/ & LICH

W ContextCapture Center Engine - [m] X

ion

/Documer

0

_7&/ 113: ContextCapture Engine
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ContextCapture Engine2 ContextCapture SettingsE Soff #&E & S CleAH2IE =4 & LICHEX
)

ContextCapture 213 AEX} IH0/ &



2 2 24 =20

ContextCapture Engine= £ ™ A& &2 &0 6HH & LICH eSSl
Ol &0F A2 ContextCapture

Al
et S &2 28 22 UOAl 0ISELICL D Sl 2 &Y
Engine®l CtS &0 M XclE IHIXI CHOI&LICH

ContextCapture Engine = == 3}

JIZ2 & 2 2 ContextCapture Engine2 &% &/2/ &R A7 AT S 25 XeleLlth
ZFH SN ST RE HYLHloIEE HAS E+350t= 240l R8 = UASLITH

ContextCapture Engine2 S35l (1S HE 22 A S#EHLICH
o SR A= X N,

CCEngine --type AT
e TileProduction & RasterProduction & & & &:

CCEngine --type "TileProduction
RasterProduction”

A S
AHE = Mt
CC_MAX_THREADS &8 H5 & &G0 ContextCapture Engine= & & 5t= = Y
H ol &tLICh.
Ol DS E32 SdstZREHUAM A S UESE Iz SHHES RAldte dl =8
o

= UASLICHO: sLe BREUH AXIE &< ContextCapture Master0il CHolf StLES] 2O & R1).

ne

Adl=

4>
U]

X2l GPU B 22| Ml et
2oz XS 42l AF2 Jtsst 2 GPUE AIEEHLILCE
I

0l A A= 6t= GPU BI22I S A

ron

tefLICH

0
Qj
52 H
r_

CC_XXX_ GPUMEM =& HE &

e UESKBEZHIOIE)Z 4&ETI{O0F
e XXX= ContextCapture Ofl C| 4 0f (2t CENTER %= DESKTOP&! LIC.

Ol SESATUA Helote SAHUESB I USRI LR GPUNIZEIE EEdt=e U =8

= AsLICh

Al et
OJD:! E—”J\a‘:’ o d

o GOIESN IS0l B2 ESE O AI| IHZ 0l ContextCapture EngineO| Microsoft &2 HIA IS
Sol =g = SLICHL DML VNC £= TeamViewer2t 22 A 22| ATEYHE MEE 5
[e]]

()
HE=

o= BA =5

Windows Al &

e ContextCapture Engine0O| & & &l = SOt Windows AtE XIS M EGIH MAEXIFHZBEH UK LS W
SIERIO JI50| HIE2# M3 22 Als S0l H A A THEHLICH
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ContextCapture Viewer

ContextCapture Viewer= ContextCapture2| £ & Z&F Al2t3t LS LICEL 0l RO EContextCaptureS’J 3MX
AN EESE O AA Y HOIE L AELAUS HEOIPZ HNHA2 ZHY T2 2 L= 22210lA
HI2tHIOIE ==& 2| 3D UIOIH E Al 3L E =~ U SLILCH ContextCapture Master 2 &l ContextCapture ViewerS
ANEoIH AAEZ HMOUAM N SES 22 = USLICL ZUE EMG= O AI2E =& JASLICH

ContextCapture Vieweri= ContextCapture®t STl X2t =& A HADS SE Z2 B EER
AXE 5 UASLICLZA HES X Z2 )82 Bentley A ZEH U2 WMN RPEZ URIEE

= ASLICHL

2|
=

ContextCapture Viewer= Windows 64H| ENl A AFE & &= USLICH

@ ContextCapture Viewer - O X

File Camera Display Tools Help

_7&/ 114: ContextCapture Viewer
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https://softwaredownloads.bentley.com/

ContextCapture Viewer= 3MX, 3SM, S3C, A3D(ContextCapture Master Li & & 4!), OB]J, FBX, PLY, OSGB S 2
3pEAS AS A O'¢L|E|-.

o= 212 T AMA-g

ContextCapture Viewer= 0| 0| XI & &1 2 = USLICH X & &= 0|0 Xl & A0l = JPG, TIF, ECW, JP2, PNGIt
USLICH

X0
SR e
ContextCapture S3C ComposerE AtE0tH J|ES3ICE2E S HEGHH 3

D&
FIHe &= U SLICH XIHMIE L2 2 ContextCapture S3C ComposerS & X614

Ay B30l EF= ALEEX 25LULILH

=5

= MAGHAL A S
A
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ContextCapture Web Viewer

ContextCapture Web Viewer= AtE XtJt & Ect2 M0l A & & ContextCapture 3MX &2
= A A2 AZTEQ N LICH

ne
njo
HT
J
n
z
gﬂ

ContextCapture Web Viewer= A Z2A Z3Z WebGL3D RHZE, UA IS, EHEX L ANEZEN HELICH
Ol B0 2= & HOIXIO & H L& 4= ASLICH E£5 E22{ 0012 AFE6HAI & 10 WebGLS X &ote

2= EBcetRMUA S LICH

=
=
(=)

3D 222 &fAl Al 2(LOD), HIOIE H AECIUS AIE0tH 2= & HAITIH AHEXt= HHelE 36t GPS
SNHE HEE = JASLICH
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A Construction aggregate 5 X

€ 2 C f [)vwwacuted.com/quarry-c6d82a0a1697f925ec7b ar @B =

Construction aggregate quarry \

Conmttrustion sgeregste qusrry
Input: 1 170 phatograghs taken with 2 Sony DSC-RX100MI Camera and using 2 Novadem U £30 dron

Ground ressiution 1o 7 pisel. images snd model courtevy of Brissel Veyrier Megur

See the quarry in 3 full windo

Construction quarry v
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= AN E Jisct a2 BHE
= 5 — o
0l 5 Tools | Convert 3MX to Scalable Mesh
Ol EFE AMESIH IIEIMXEL S ALY Jtset HABSM) 22 HEELICH
KIS ALE: O] HEI2 O ElA K 0| U= =S5 ELE6t=3MX 222 XI2I6HK| &£&LICHLLOD 8101 444 & 3MX
QA FUst NS EAY I MHEEMXPE F=RE2EL EZ3MX 2L A LAE 4= USLICH

HolZ 9ioH 0| SR

ContextCapture

#

™ Convert 3MX to Scalable Mesh

Convert ContextCapture 3MX format to Bentley Scalable Mesh format (35M) for optimal display, analysis and editing in Bentley

design applications.

Input and output files

Input file: |

Output file: |

Options

Spatial reference system:

Please enter input filename

22 E IMX HMEMAE AASE

219

AL
e

o
PN

LICY.

a Y Convert

Cancel

AFEAL H0I =



ContextCapture S3C Composer

ContextCapture S3C Composer= ContextCapture Viewer(l Al Al2tStE 2|8 S3C & 4] 2
Ei=g=10|V3

IH

ZHE EH|

A4
i

Z20: 0l EF= MSE X LSLICH E2™ ContextCapture2| & X| CI 21 E 2] 0l A bin/CC_S3CComposer.exeS
A AIL.

B

ontextCaptureil Al &5t J|&ESICEHH ML S HESHAH 3D

ContextCapture S3C ComposerE AFE5tH C
U LICH

oS MAstAU A E FIHE =

acute

Paris 2042 Extract

-1
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o HIANERESSICEHEH
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ContextCapture S3C Composer J|= I EH H 0| A

File

ContextCapture S3C Composer [Paris_sample.s3¢*]
Tools Help

" @

_—

]‘ 1 Models

‘ Edit the list of models included in the scene.

Information

Coordinate system Data\Tile_+000_+ 000\ Tile_+000_+000.53c "

Data\Tile_~001_+000\Tile_+001_+000.53¢
Data\Tile_«002_+000\Tile_+002_+000.53c
Data\Tile_+003_+000\Tile_+003_+000.53¢
Data\Tile_+~004_+000\Tile_+004_+000.53¢c
Data\Tile_+005_+000\Tile_+005_+000.53¢c
Data\Tile_~006_+00\Tile_+005_+000.53¢
Data\Tile_+000_+001\Tile_+000_+001,53¢c
Data\Tile_+001_+001\Tile_+001_+001.53¢
Data\Tile_+002_+001\Tile_+002_+001.53¢c
Data\Tile_+003_+001\Tile_+003_+001,53¢c
Data\Tile_~004_+001\Tile_+004_+001.53¢
Data\Tile_«005_+001\Tile_+005_+001.53¢c
Data\Tile_+006_+001\Tile_+005_+001,53¢

Nara\ Tile OO0 LONNTile LON LOND 3

Navigation
Web publishing

Advanced

= Add model...

H Remove selection

Select al
Unselect al

Invert selecton

Load selection. .,

Save selection. .,

_7&/ 116: ContextCapture S3C Composer 7/ £ 2/ H 0/ A

s3cH¥H2 eEZ AdELILL 20N Et2 S FOtot HL MIAE == ASLICH
NEAOISEEHE B3R UE MASUHAM L2 B2 S FIHE = JAsLIt
2/F OBJE=FBX 22 = ZH0 L& == USLIC

(M2 0B TEFBX Y2 MK MBS HB6HK 2222 3D HHIHOIL0] B E £
HEAEH=O0IRA EZHE 20U MSE= 012l 21 JIsS
HEE 2ES HEN 0122 = AsLIT
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Title

2= LIS/

HMESE =I1E 4= 20 ContextCapture Viewer Q1B H 0| A 2] 222 2|0l EAIE LICH

ContextCapture S3C Composer J|& Ol E{H 0] A

DS 842 )

00x300H &= HistE

Model position
ZHSMEHE HA

L8l Hl Ol &
UWEIHOI&A 2 & DA Hat £HAE LE
Minimum/Maximum height constraint
Jtoiletel =O0l0il CHEr Mt 24 E &4
ANE0 &E2=2 =0 Met =
Maximum oblique viewing angle constraint
JtOil et eret
Navigation mode

JIE HEIH0IE ZEE

SN et

LTEISILI L,

LI 0l ContextCapture Viewer 0fl A

2 HIAl
2 A et EZ HMAE RofS3C ZFHE &
Web server

Base URL: & A/ S J/Z URLE L EEHL]LL

ContextCapture

ALOIS] 21 =0l CHEt Ml

ZEHe UlgIAHoE 2=

R 2 04 ContextCapture Viewer I E{H 0| A 2| @2
P2 £ S3CEH I
ILICL O 2 0I0IXl= Ats22 SAEL

0
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< 2t et LIC

1S & FotA ™ Relative to ground =0| 2

st x2S 2dstELth
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™ ContextCapture S3C Composer [Paris_sample.s3c*] - o

 File Tools Help

E d @

Models Web publishing

P Setup the scene for a remote access to a Web server.

Coordinate system [ Enable Web publshing

—

Base URL: | http: /fnww.acute3d.com/demos Paris/ !

Advanced

Maxmum number of connections: 8§

Limit the number of simultaneous connections for one user sesgion.

ContextCapture Viewerfl M= Ol & 2 AFZ5H0 S3BC BN XNIZE e Bt A4S Z2E M A URLE
2018k C.

Transfer settings
o2 +=&/L/C}

=
lo

i
=
Q
1y
o
>
00
el
L)
w
)
0
2
lo
L)
e
H
N
i

ContextCapture Viewer= (0| Al2t2 Z0]J| {1oH &
OG22t sAHZ =01 83 T & lsSLICH

2 HAISE HXGHYAIL.

Edit command line
Ol & Tools > Edit command line

ATJHEE 5126tHAH command lineS Soff &8 sS 2HE &% USLICH

ContextCapture ViewerZ 02| 27|

I+ Tools > Preview with ContextCapture Viewer

ContextCapture Viewer Ol A Z 2| & &S 0l2IsLICH
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instant loading scene file L & L} J|

Uil 5= File > Export instant loading scene file

i
1
50
i
-
__(T‘_
>
I
im
j_g
=4

Export instant loading scene file2 ContextCapture Center Edition il A 2t A2
OICI& S B AIL.

FHOHS Bt 0l 2 E 1 2 UOIEHMES B2 J|2 &8 2= 8550 3D A2 30l HEotAl
ASLICL SOl E0M 29 L HAl 850] Zats 22 = UASLICL

B

Exporting instant loading scene file2 AIE0tH 0| S 2 HAIE AlZE0l ZHeet IO EE 2
Mgt XS LEot=e SAI 22 ZH A8 M8e = AsUICH
A

=
WEH ZH M2 4N 2 Jd0il AISEH= Beo 43X 5, SEL0D 7L, 21 2= & =010 tHet
x 5

=1
=21
A= SEELICHL

18/117: SA| 25 & 129/ 3D A/ 2BHZE A& Al)

0l ST 22 9 EH0I Y= 2D EFUE TAIE Z P02 MBBHLICHYBHE © 2 >50),
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. ContextCapture S3C Composer - olEE
1
Export instant loading scene file

Create an rstant lbadng scene format nduding addtional data and specfic motn constraints which are susted for very large dataset
veualzaton,

Output file
Choose the name of the new 53C scere fle to geate, The output fle must be saved n the same drectony a3 the nput scere,

Output file: |C:/TESTS Web Pavs_sawple_opt s [..]

T

Slapoing lowest LODs allows to optmze loadng time of refevant levels and to avoid daplay of rrdevant simpificaton levels that may affect
perception of madel quality. Warming: ignonng 100 many LODs may affect deplay performance.

|| Skip lowest LODs.

Lowest LOD to use: 'LIG

Yamning: previous moton conatramts wil be gnored if any.
A minimum heght constraint slows to forbid dose wp viens thet may highlght insignificant detals.
(] Mininum hesght constraint

Height (meters): ©

Spedfic nragation comirants can be enabled to it the alowed range of wewing datance and vewng angle, n order to avord deplayng too
much data at a trme, and hence to ensure cotmal per formance.

[v] Distance/angle constraints
Mrsmum scene hesght to conmder (meters): 0
Maximum viewng datarce (meters): 5000

©) Export imnstant loading scene file | Cancel

_7/&/ 118: Exporting instant loading scene file

Output file

& & Skip lowest LOD
S0l AMEE N REEF A

Of £
LODE AU FH 2 &2 2
ot ES HAIE EX

U2 M2 LODE R AICHH HEAl 450 S€= 012 = AsLICHL

o b
Ay >

oy
o]
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F(Oll: L16& "Tile_+000_+000_L16 _00.a3d"

A (el LICH
Moo Ee). =5 S S BRGHEAILAME IISE 2 M &l e B2E AISotHBE 0l 58S

Minimum height constraint
Jtoletel =4 =010l Ciet 248 Mgt 24 Y LICH

ZA =012 XNYotH S0t 2 NEAMES ZXSE A= S22Y FE SAE = UASLICH

Distance/angle constraints

SHE0l LR R2 HI0IES EAIGHN 2D Ao M52 PRI o SE UIHIHO0IL ME XAS
M550 5B TS JHAl Hel L 8 24E 89S Riste & ASLIC

2t @E N DR 2L W E0I9 R4 KB ZAS FHEI| 98 A0 A N2l YHBUCHL £
Etol 7| a2 EUC

r
g
JH
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ContextCapture Target Creator

ContextCapture Target Creator= QR 2Z& = 2= (4} Chili Ef 2 2F April Ei 1 =)
CHatsS M 36?" &P LICH ContextCaptureS Sl AIXOIA A S S22 —%—%8}04 ZZH0HME=

e MEXNZEE:QREE ZRAMEX=0IEN EY(EEY AENE XIEHOF & LICH
o MOEQRIZZ=2H: 01218 LHA S 301 0| A0 ZXEHBHO XS D SEU AIZELICL AIZX=
MOELI 0SS XM ELICE B2t X AAE0 Jqes= AFE HO|E 3D HHE FE6I0 522
NS SESE > USLICLESHHE=E SUHOZ SAE = UASH LIS HE6| 26029
HOHES AI=20I0 22 S 0M AIS IO E 28 2 USLICH
e MBtEHQRIED): US HMEtZHZ ASELICHL MSt Z240= Ul JtXI RE 0] ASLICH
o 2T QRE L0l 2H(0,0,0)2 &FELICH
o AN FQRE AOIC HElE A HEHLICK
e =:SFICQREEE MEHX YEEZES &FELICL
e HH: SO HEBHMQRIEE X, YE=ZSS E&GIL M HM QR 2EE Wet 2L & =9
grarsS XIE LI
ZULHHNS XA SUS HHUM AIZE Q00 F IS SASHHE ZAHAE SUSHHHNA AI2E
= USLICL At UHE=2 S /X XNE Mot A AES FEoHY AL
S TH Chili E§ 20 & April E 21 = Target Creator UIS AFE0H0] BIX| M E 4 JASLICL AS2Z2 0IH QRIEESE
MAHOOtot= 22 E=QREN0 CHEH E—I E2 MOII 228t HL, 012 ContextCapture 2/ SO0l A =8 &
%= & LICH ContextCapturedt QR Ef 1€ 21 Al6He X OIS 7= 2 [ 2+0F ELICH

e HIO=QREEZIE2%H OI(HOF SLICH
o B0 Q2EE HAEE= ContextCapturelll A 7 L= (S 2 42 [H2HOF & LICH(&2H A

Bl A E = ContextCapture )t QR ZEUA 2= 22D XN E, ZEM HAE= AIE I 2 8L).
o A& &o8t3D A It 3= MO &: CCQR:CPNC: TagNam
o 3DXEI U= MOAHE: CCQR:CP:TagName:X Value:Y Value:Z Value:SRS Definition
o AEX &&&:CCQR:UTP:TagName:Data
o N S& &&:CCQR:CONS:Origin
o HMLSE AU HAEIZEEQRIE 2M

=  CCQR:CONS:Scale:A:Distance Value:Unit Type
=  CCQR:CONS:Scale:A:Distance Value:Unit Type

ContextCapture 227 AEX} IO/ =



o NMUASREZHAEILSEEQRIE 24
=  (CCQR:CONS:Axis:A:Axis Type
=  (CCQR:CONS:Axis:B:Axis Type

@ ContextCapture Target Crestor = a X

EzE ContextCapture Target Creator

[=1:4 Create QR codes or Compact Targets for automatic Control Foints, User Tie Points and
“s===" Constraints.

Targsts

Target type: QR Code v

* QR Codes are machine-readable labels that contain information about the attached items.
o * The codes have to be photographed at a fairly high resolution to be detectable (tag size of about 150

pixels).
* Thay are useful for close-range projects vath user-defined labels and data.
Point Type: User Tie Foint v
Output directory: |D:/ &
Options
Mame: [Pump |
Data: Model #4563

&) Create QR Code(s) | Close

ContextCapture 228 AEXL IH0I =



ContextCapture MasterKernel SDK

ContextCapture MasterKernel SDK= ContextCapture Master2| 2= JIS0l T2 i LA O Z H AT &
U= Python LSS Z&0= AZEANH WL IELLILLO LES MM ZZNE M4, HEY L 2LIHE S

Aol ALZ At QI HIOl A CHAI 2 S EFLICH

ContextCapture MasterKernel SDK= ContextCapture Center Edition | Al 2+ AF=Z & 4= U SLICH OICI & o CHSE
AAlet g2 A ZERAN 0CIES &0 AL,

ContextCapture MasterKernel Python 2 & Q! ccmasterkernel2 AFE0HH A A 2l L /= X= 3D MA
T2 NAR Z2Python ADEEE Soll 2ttt Aoz AFE X 2| ContextCapture 88 ZZ2 1S

Hee = AsLICH

SEAPI(SE Z= Y IHH 0| A)E AFE3HH ContextCapture Master ZZ M E (CCM TN UM AHE &l =

eSS 22 = ASLT

o HLIZME. MM MY BHAY SEALEEH ZZNE E2| 2|

o« =% JIM2D|(Excel/XML), HE I (KML, XML, HE T X 22 A&, 2E, =, AL /AR 5 M8 2
IO sS4 3D R/ E L), MHE Md L HEBD X R OI0IX SE), AAEXNEEE 44
ERL RS

o AT(EZE &L ZE): 2L AXXNE 2E 43, AL ME Y 2LIHE /MO, &3 42 S 20N
LI 2 LH DI

o M2 B2 ZHURAI(SRS, 2& I EHY), MAH Mt M, X DL RIEX AL /LHE D], A4
#s3h), Mel &4, El2 S KMLZ LH:'LHjl

e HMZ:IZEMHHF(EL, A, SE HEA LU HA, XS HE L 2ULHE /HA

o A IILIHY

e S IEZZOHB LFE:2H0ldA &0 HE MO, AHUHAM AZEAN LOIO0IE &0l

APIOl= CIOIH wat(H4d EC, gd) & A AL S ?et Ut =75 2850 ASLICH

SDK % Python 2 & APIO| CH St XHAl & LH 22 ContextCapture & X| C|21E{ 2] 2| ContextCapture SDK & H A E
RO AI L.
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A H&E2II2H 22 "Normal"E &

= :Production 1

ek

LICH

Cpen output directory

Urgent
High

¥ MNormal
Low

Paused

LICH

A S LICH. ContextCapture 0l & 0l A

&2 CIOIE IO A0 A XIS & LICH

oA EA 2 "Urgent" == "High"E & & &
Heist xrolg of BT B0 UK 22 ).
KEAH A X al
T =2 o
CIAZ OR B2t L o420 85 FAS RA0H QoS RS Fe2 4
Tools > Clean job queue database -2 0| S & LI Ct.
ContextCapture Center
B New project... Crl+N +
Block - Block_1
B Open. Ctrl+O
10 photo(s), 0 control point(s), 0 user tie poin
Open recent
Overview Photos Point Clouds  Surw
New capture A\ Incomplete photos
FALaN
New anal You can estimate missing photo information
_ Photos positioning level: georeferenced
Reference manager...
Basemap manager... 10 photo(s) in 1 photogroup(s). 90.0 megapixels
) 0 photo(s) in the main component
Free up disk space... 10 known position(s) and 0 known rotation(s)
0 control point(s) (0 full point(s). 0 horizontal point(s,
0 user tie point(s)
Ctrl+m
Convert 3MX to Scalable M
Project Version Checker...
Create ContextCapture Targets and QR Cod
2 oA 22 Eme Hets dESLICL Ol MEt old0 S &
| SHe SITOI0 CHAl E1S2 4 giasLICh
Clean job queue X
Job queue: |C:r‘Jonueue | ‘ ‘
Number of days to keep: |2D| = |
| Clean jobgueue ‘
Ol JI=E2SDKE SHHME AHEE &= JUSLICHL HY 2LIHY ME2 SDKAE B M E &015
ContextCapture 231
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ContextCapture It 2t 2 &

=
=248
EZANAEFE=0L A0 HIE = A2H HHE 23X 210| «U= AU Z» MBS E LILCH Bentley Systems=
= NS 2EGHH HHe SF2 2SS otk E2H, M0 4540 EE S Hgdll et SAIA
23S ZEolsl 00l =8t% Xl &2 SLICH Bentley Systems= 2 @MU L& E QF £ =2 X2 AAE Dt
2EE AE 2, S, 208 L= Z20A &o0l CHol 22 XXl ESLICH

22 It 22
IS 0IDIX 2+ ES2 CHS 0l ol8h HMZE LIC

x=F.D(I(0.RXX—0C)))+x

btz (S 2SLIC
X Mo 222X ANASNA 20 Mol 9XIS LIEH S 3D & BE LI CH

X= 0101 BO SIXE M2 LEHNE 2D E HEHQLICHL AFSAZ 2 0/01 X LA JIR2H(0| D, XEL
010 XIS @22 85F0| D, YE2 0|0 XI Q) OF2HZ 8HaFel LTt

C= 3102 )20 X2 LEHH = 3D & #E QL C

R2 302 31 RS LIEHLH= 3 x 35/ & B2, AIH 22 &2 X A| A0

JiMict $sto2 MO Jtnc =0 HESLICH R2 S 5HLIMA XIZE £ UASLICH
Moo Moy Mp2
R=|Myp My; My,
Mzp Mz; M2
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H ==

Omega/Phi/Kappa 2t &:

[ COS@ COSK COSwSinkK +sinwsing cosk sinw Sin Kk — cos w sin ¢ cos
R=|—cos@sink coswcCosSK —sinwsingsink sinw cosk + coswsing sink
sing —Ssinw cos @ COS W COS @
Heading/Roll/Pitch 2f &:

[cOSH cosR +sinHsinPsinR —sinHcosR +cosHsinPsinR —cosPsinR

R = sinH cos P cos H cos P sin P
[cosHsinR —sinHsinPcosR —sinHsinR—cosHsinPcosR cosPcosR

Yaw/Pitch/Roll 2t &:
cosRcosY —sinRsinPsinY —cosRsinY —cosYsinRsinP cosPsinR
R = |cosYsinR + cosRsinPsinY cosRcosYsinP—sinRsinY —cosRcosP
cosPsinY cosPcosY sin P

>
W
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o
=
oM M
E:
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oo
10
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e
Qﬂ
rr
-
a8
=
IS
N
°
-
o

& Gh= Roll 2t =& LICH

"XRightYDown": 1 0 0
O0=[0D 1. 0O
0 0 1
"XLeftYDown": —1 O 07
0=10 . 0
0 0 -—1J
"XLeftYUp": [—1 0 O]
O=|0 -1 0
120 0 1.
"XRightYUp": 1 0 0
O=|0 -1 0
0 0 -1
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"XDownYRight": [0 1 0]
O=|1 0 0
0 0 —1.
"XDownYLeft": 0 -1 O]
O=(1 0 O
0 0 1.
"XUpYLeft": 0 =1 0
O=|-1 0 0
0 0 -1
"XUpYRight": 0 1 0
O=|-1 0 O
0 0 1

II:R® - R’sjsca mos o e a49/LC).
n(u,v,w) = (u/w,v/w)

D:R? - R?’2riscz mojg = st29lLCh
1 4+ K724 Kor*+K.r®)u + 2Pouv + P, (r? + 2u?)
D(u,v) = (( v’ " a7 < R

2 P 3 X ), where r? = u? + v?
(1 + Ky +K,r*+K3r®)v + 2Pyuv + P,(r? + 2v2)

(L ﬁ&mwfplglg P29|2='%E*O|A+§u+ﬂuu.)

F = ZEHEYLICHL HIIA fEQ A SR Jthllet 28 12012, S= A=

rr

o o

OHoH 201D, P=maysLc

Xo 2 ol £r9lo] StHigt =& XIS LIEHHE 2D & HEQLICHL RIFS2I% 2| 0/0/X B0l
JH2 012, X5 2 0101 X/S] Q2% 20|, YEES 010X/ OF2H % gakelLICh
Hetdl X Jthict 2E
MIZIH 010Xl 2t £ CHSOll 2/ aH KBS LICH
x=F.II(0.R(X—C))) + xp
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3MX & B &

2l 5= O
[ i i gt
SEER TP

MiningSite » Block_1 - AT

Block_1
4 __ Block 1-AT
4 Reconstruction_1
& Production_1

ContextCapture

2 MHats gy

oo o
otcd® 3MXE
gds +=dE 4 ASLICHOLH OI0IX F X).

ContextCapture Master - [MiningSite.ccm]

Production definition

Production definition

Define parameters of the new production.

LIEWI EAa o=z HEi5HOF & LICH ContextCapture Master2| Production

Name | Format/Options
Purpose | Choose output format and options for the production.

Spatial reference... 2 | PPlications.
| Smart30Capture S3C
| OpenSceneGraph binary (0SGB)
[ web | OB) wavefront format
[ | Autodesk FBx
| Collada (DAE)
[_] | stereoLithography (STL)
{LOD tree export
[¥] Inclu¢ Google Earth KML
SpacEyes3D Builder layer

Extent

Destination

Maximum texture size: 8192 pixel

[¥] Level of detad (LOD)

Type: Adaptive tree

Node size: | medium (~35 kB/node) ~

| skirt: 4 powe

J&8'119: MF A & F4 L

236

- | 30 multiresolution mesh format, optimized for exchange with Bentiey

|
Submit new production...

»e and submit new
uction.

Delete production

AFEAL F0I =



2 A

3MX A2 & AHA AE FHAOIXISH Ol0 28T Xl ZELICHL3MXS &= CS M JHAI LICH

 MZ& ContextCapture ViewerE AIE0t0{ 22+Ql B

e MicroStationl 28 2 C} 2 Bentley Systems HIS 12 &5 284

o EIANESE2IZZIOHEBDGCIS)US AS 224

AAL BE=3MX MEHSHSHEEX F222 2o HEothl A2 EH SES ME LM AHEE

2= ASLICHL [etA EC0 JHE HEst RES HEUsoF S LICH XHMSt HES TS Al S E X5 AIL.
3

3MXO0l CH&F XEAI S LHE 2 document Cl 2 E 2] Of
XS AL,

s0
i

MX At & H M (3MX Specifications.pdf)

i

NS =N

= = = = 17 = = A
SMX EAICZ MAS AR Ot otH X0 EAE i sES 28 = UASLICH
4
Production definition
Define parameters of the new production.
Name Format/Options
Choose output format and options for the production.
Purpose
Format/Options l Format: | ContextCapture 3V 3D mult?resolutmn mesh format, optimized for exchange with Bentley
applications.
Spatial reference syst...
"
Extent Web ready
Include proxy 3D model
Destination
Generate ContextCapture Web Viewer application
Level of detail (LOD)
Generate LOD across tiles: ()
Type: Adaptive tree
Node size: | medium (~35 kB/node) ~
Include texture maps
Color source: Visible colors ~
Texture compression: |75% quality JFEG
Maximum texture size: 2048 | pixel
Texture sharpening: Enabled
W
< Back £ Next Submit Cancel
3MXE th=st A 0|8 ZSHE2S ECZ AEE = WE FEA022 22 s82 8 ALZ0 HEGHX
ESLILEHZ AECZ HEUWHEH AZER N E Sttt &ofs 2ELH =S 2ol ZR0= 206X €2
= A= S SE NEI ERELICL
UWEWI SESd8g IR M= Il EEE DHHO0F &Lt
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1. X B SE&2"Web ready”%EHlo'Ll Ch.OI S 0E d=otH 280 & ME0 =X atELICH Tt
K| 0il ContextCapture Web Viewer S & _EJ"—“OI ZSEHEZ B AOENA HNH=E (B)HE AISE
2= -’-\_‘-I:JIDF 2= LICL "Webready"SE 88 F 400t Rest &l 3HS ddE = UK HES

S8 = &380ot= Ul 2ol OF & LICHL

I

2. & HAIS ol M= 244 Al "Generate LOD across tiles" S&0| A& ELICLOIE SR 2 HFHUAME
AHO CIAEH0 B2 PEHE = USLICH

3. "Generate LOD across tiles"Jt & & &/ X| 242 & 2 "Include proxy 3D model"0| H§H2| AX| S2t2 LIEtH=
SoS HHSLICHOMH OI0IA &#X). M EasE 2EotEE JItel= 302 0l @401 EAIELICH O
SHS U FHASH ZAR U0 U= S0 OtF RN HAIEIX ZsUILH
Proxy models

rebgl/App/?scene=Marseille

i
| Marseille w
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We are sorry, but due to browsers’ same origin policy securty restnctions, the application cannot be
viewed by double-clicking on the file

There are two ways of solving this

1. Change security for local files in a browser (access page as file:///example),

2. Run files from a local server (access page as http://localhost/example)

Please follow the instructions here: http://www.acute3dd.com/local-webgl/

—Bentle
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‘Polygon file format (*.ply)

| Autodesk FBX (*.fbx)
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3mxVersion": 1,

"name": " YourProduction",

"description”: "Scene generated by ContextCapture, copyright <a href="http://
www.bentley.com' target='_blank'>Bentley</a>",

"logo": "logo.png",

"sceneOptions”: [{"navigationMode":"PAN"}],
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"layers": [

{

"type": "meshPyramid",
"id": "meshe",

"name": "YourProduction",

"description”: "Model generated by ContextCapture, copyright <a href="http://
www.bentley.com' target='_blank'>Bentley</a>",

"SRS": "— given SRS —-",
"SRSOrigin": [0,0,0],
"root": "Data/YourProduction.3mxb"
¥

]
}
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"description": "Scene generated by ContextCapture, &copy;<a href="http://www.bentley.com’
target="_blank'>Bentley</a>"= & T2 1 M CtS 3t 201 ZAIELICL

acute3d - \

&« C & [ localhost/S3W app/?scene=YourProduction&playBtn=o1 R =

YourProduction a

Scene generated by ContextCapture, ©

—Bentley
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configjson TFY 2 App ZC 0l ASLICHL HIIA App2 & 22 T2 O24QLICH 0| Y S AFR IS8t &0
S22 MOS0l AFRE 4 UBSLICL DRI IS =4 TAIS &0 i) B2 AFR5H0] L2I0 A S S
TOI0f A AE & ASLICH

JI2& 2 Z App Z 0 = webgl-ready Al

S0 MECH MAE=S23DOHO0IH 0 MEELICLO B
configjson2 3D HIOIEH S| & =AE L& 6t
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{
"URLs": [
{
"alias":"YourProduction",
"scene":"../Scene/YourProduction.3mx"
]
¥

& L2 JSONEAYLICL SE Z2 DA RAAS = A= 3MXEHOI ot ASS U
3MXO0l CHEF Z2= "scene" EH 12 EAIELICH EelHA= 01822 BHE AE5t= O A EE LICH

tsstEH =52 MH0HH 2 EHO &l A9 BE|HAE FI10HK configjson I = =& ol OF
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HEE DS M 2H2 CloudFronttl 4 &= LICH
{
"URLs": [
{
"alias": "Quarry",
"scene": "../DATA_3D/Quarry/Scene/Quarry.3mx"
})
{
"alias": "Marseille ",
"scene": "http://deh9aqlpmcjlj6.cloudfront.net/Marseille/Scene/Marseille.3mx"
}
]
}
AEEBEZZ UM S EHE=UE ZH MOISE MECHHAH =2 HAIS0A BIHAS ZH 0HOH
B2 N &EotH ELICLOE S8 O30 Z5LICH
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S&ot= U L3IDEHS B2 MM AlI2Sote HES 8YELICH
| S—
g2 BE= Y
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/ ] acute3d x\\

B --EN

= C A [ file//C:/Productions/WebGL/App/index.html

viewed by double-clicking on the file

There are two ways of solving this

1. Change security for local files in a browser (access page as file:///example),
2. Run files from a local server (access page as http://localhost/example)
Please follow the instructions here: http://www.acute3dd.com/local-webgl/

We are sorry, but due to browsers’ same origin policy security restnctions, the application cannot be

—~Bentley
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"Version": "2012-10-17",

"Statement": [

{
"Sid": "AllowPublicRead",

"Effect”: "Allow",
"Principal”: {
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s
"Action": "s3:GetObject",
"Resource": "YOUR_Bucket_ARN/*"
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Marseille a

, @ port city in southern France, has been a crossroads of immigration and trade since its founding by the
Phoenicians in 600 B.C.E It's a place of tranquil squares and stepped streets, bustling 19th-century avenues and souklike
markets. At its heart is the Vieux Port, where fishmongers sell their daily catch along the boat-lined quayside. La Canebiére,
the main thoroughfare, runs east from here.

| You can visit this beautiful city on-line, using our accurate 3D replica.

} The 3D reconstruction was done using our
fiexible and scalable software solution to turn simple photographs into true-to-life 3D cities.

solution, probably the most powerful,
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2t N2l Same-origin policy(SZ-EX ) 2Ot Met2 2 CloH Ot 3t X 2 2 0] TH AIAEGIA 2
SEILEeHol2let M &I LICH

| S
/ ] acute3d x\\

€« C M [ filey//C/Productions/WebGL/App/index.html =

We are sorry, but due to browsers’ same origin policy security restrictions, the application cannot be
viewed by deuble-clicking on the file

There are two ways of solving this

1. Change security for local files in a browser (access page as file:///example),

2. Run files from a local server (access page as http://local hObt/éXe!""L‘:\

Please follow the instructions here: http://www.acute3d.com/local-webgl/

= Benfley

Advancing Infrastructure

o

FXIOF ASLICH

£ U
o BURHMUA ZZ WO CHE 2o HA (file:///example= HI O] X| H Al A)
o ZZ MHOUIAM It &l & (http://localhost/example & HI O X| 4 Al A)
MU SHS MES
SZ L oM S Ao At
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Firefox

o about:configZ 0| S& L|Ct(Firefox &M ZAISH =4 ).
 security.fileuri.strict_origin_policy O B & & LICH

o false2 & ELICT

Chrome

o X &S ZOI 2= Chrome QIAHASE SSLICLHIIM'RE QAABHAE =
Windows 0l Al = Windows & & 2t2| P% AME3t0 Chrome AIAEHAE SHOIEH £~
EdI0I0ll Chrome OtO| 20| ZAIEIHAHAE HFEZN'EI'E S = USLICLOIEAH GIH B=
Chrome QI AE A I} &L

o YY UETE/HOIES AMEELICE Windows2 22 dM AKX YY IEZIEE AFS 2 20
SEUNYGH ZSZEE S H 22/ &LICHL

e Chrome &/ Z2HE F&LICEH Windows2| 2 & M| 20l Al chrome.exe I} 2 S A aFL|CH

e YUY IUZETZE HOIYWAM CIS command line 22l 1€ AFE361H0] Chrome &
path_to_chrome/ chrome --allow-file-access-from-files

Internet Explorer
O0l2& 2= Internet Explorer_ SZ MY Bt ZMO| HA S ol & LICHL Lt Windows 8.00l M=
Y SES S = A HAELJASLICH

Safari

0K

IHE 2 AME8HH D2 — "0l LHUA HEXE His 2I1"0IM HE X E HISE

LI Ch.
IS Safaril "NL A" HSHAM "22
e SafariS AMIE0I0 HE L CIHAGIEAHR
E5LICH
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P ANHE EXIE M HEeot= &€ Il S8 (Apache, Wamp = nginx)0] USLICHL E8HHE 24 MBets
0| & 0l &= http-serverE HMIHEFLICH.

=P\

e https://nodejs.org/0lA X 228 = 6tLEE AFE6H0 Node.jsE & X & LICH

e TP ETFITE/HOIES AMEELICHL Windows2| 2 M AT BB TSZES UG S 2
SN YE ZIETEZ S H 22I6HLICH

o« HOIE U A sudo npminstallnpm —g B& = A&t =S HE 2| npmO| X=Xl &l LIC
WindowsOl A= sudo IR EE A Mo T & XI0F 22| X ASICZ HY TSI ES A OF &LICH

o Y IZEITE /EHOIZ WM npm install http-server—-g & S & S8 &HL| Lt

e 3MXUIOIEIE HIRoIH 2= MBI HIOIEHE H&E Z2HE MLELICH
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https://www.apachefriends.org/index.html
http://www.wampserver.com/EN/
http://nginx.org/EN/
http://nginx.org/EN/
https://github.com/INDEXZERO/HTTP-SERVER
https://github.com/INDEXZERO/HTTP-SERVER
https://nodejs.org/
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o HOIEUWAM AMH E2EH= OlsELICH

o http-serverE & & &tLIC}.

o Ol Ect< M0l A http://localhost:8080= &S0t MHUH HUAAS = UASLICLE RH Z2HZ2 01S6HN
HMESS AMASELICL Z2E ZHU SLSt A FHE AIZot= 2EE2 "2 S0 24" ME0M =o1e 5
ASLICH
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Node AZE CHMISt), Node C 2 D= Node BE UM & LICH Node CE S3t™ Node CIt Level 42| Node E &
FOIl 2loll CHAIEl 20, Bt 0l SHE & MIQ! Node D= HE LI X &2 AEHE S XISHLICH
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HIIM 22e stda "s20l 2" S8 =50t O._* M HEAIEl =X LICH Ol Z 9 & ContextCapture(Viewer
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R 9tGHAHH ContextCapture(Viewer &= Web Viewer) GI0|E{ 2] LOD Al 2+ 30l CHSH |2 X0l /&2

CtS 2sUCh

o NEX ZZNANCZZ B2 U M= oHLIS =0 ZAIELICH

e LE=3EHA Y FH0I0I2 B HAHA) Ul AS I EAISUC

e LEEEZERY AR Sl atHAZIH &S I S22 ot 2ESLICH

o SEJIASUHBANIXN E= E=ANME ALULCH
3MX & A
3MX EAl2 & DFII 7C—)r%:l——| M2 A5 0 JSON EA19 OtAH IHY GHJ etHtoltel E4Alo 6t 2 /ot
oIt EcClYLICH EHY OtAH MY 0ll= 2 HEHIOIE It ZE 5 A2 3MX & &2 A SELICH
gtoldel It e %“é% ZL8otH 3MXB(3MX B0l el) & LICL3MXB Y 2 LBt 2 NREF3D
ElAXN Mele Oletol= 04 otLtS & H&HLICH

Cts D82 3MX S0 e 20 2E2 NE 20HSLILL ZEH E=2 FE
Ec| A2 FHE A L2 2ELICL ol E2H= 018 MEAN A £H8LOD ?ZEOH U E oa'—‘?'— =2t
L C0| 5t ECIE LIEt-HLICH
). Data — 4. Tile_p000_p000_p000 = | Tile_p000_p000_p000.3mxb
| 3MX.3mx i Tile_p000_p000_p001 || Tile_p000_p000_p000_L20_0.3mxb
1. Tile_p000_p000_p002 || Tile_p000_p000_p000_L21_00.3mxb
J. Tile_p000_p001_p000 | Tile_p000_p000_p000_L22_000.3nmxb
J. Tile_p000_p001_p001 || Tile_p000_p000_p000_L23_0000.3mxb
). Tile_p000_p001_p002 || Tile_p000_p000_p000_L24_00000.3mxb
4 Tile_p000_p002_p000 | Tile_p000_p000_p000_L24_00001.3mxb
3 Tile_p000_p002_p001 || Tile_p000_p000_p000_L24_00002.3mxb
). Tile_p000_p002_p002 |_| Tile_p000_p000_p000_L25_000000.3rmxb
4. Tile_p001_p000_p000 || Tile_p000_p000_p000_L25_000010.3mxb
|, Tile_p001_p000_p001 || Tile_p000_p000_p000_L25_000020.3mxb
). Tile_p001_p000_p002 S
L. Tile_p001_p001_p000
5 Tile_p001_p001_p001
i Tile_p001_p001_p002
i Tile_p001_p002_p000
Je Tile_p001_p002_p001
J. Tile_p001_p002_p002
3MX.3mxb

|| Tile_p000_p000_p000_1.3mxb
__| Tile_p000_p001_p000_1.3mxb
. Tile_p000_p002_p000_1.3mxb

| Tile_p001_p000_p000_1.3mxb
|| Tile_p001_p001_p000_1.3mxb
|| Tile_p001_p002_p000_1.3mxb

1&8/124: 3MX &% EL] 7 & 9 0
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3MX O

3MXOIl = ZHO10f| CHEH 28 HBOHSON HAIO 2 T & 0f AL LICLJSON HAI2 & 2210/ E 0 A &)
M2lot PE BAE & A0AN HSE RS LIC

3MX & A9 I ofl= CHS0l

e 3mxVersion - I+ 2| H§

e name- &% 0| S (utf-8

 description - 2 & 0fl (&t & H (utf-8 —‘?—IPO*)

o HTMLEi = Z&s 4= AKX M = SIotAl 23

e logo-&H AKX 21(0 EIIII(]PG CEE PNG)OIl CHEH &0 22 ¢)

 sceneOptions - EOH EH§ HA S8 244
EOotL £= A IO, B U}_= &2 0118 2Ol 0l

"*‘:”EIO'I ASLICH

sceneOptions EH 1= HAl S S T2 &0l WSO JUSLICLAMEXAE2 HEE FIolH 228
D2 2AHA gHS ZFag = ASLICH
ol Z2eE2 2 HOIHH =D SEO| AHOFELICHL SE SSUOIHE HOIH 20 F=IHE =
ASLICH

Colour code
Scene file format

UTF-8 string

bt Scene
options
mat

JSON for Path to fl|€‘

m m
Type Type-dependent — Type-dependent Lot & Type—dependent ‘
data 0 datai datap ‘

J&/125:3MX &5 I} &4/

ST 3MXE &Y FE 9| &0l 2 meshPyramidE & 1 & LICt. meshPyramid &0l = 3MXB €419l IR
3DEIAM el T2t0lE 4 S 8 HELICH

o
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Colour code

; UTF-8 string
JSON format §
( = | ' \ Path to file
pyramid <

Collection

J&126: Of+ 1/ 2t0/ = 20/ 0f

meshPyramid & 2| dI0OI0{0ll= CtS B2 MEDJH Z&HE LICH

id 0101 2l ID(utf-8 2 X+ L)

type: meshPyramid diol] =&

name dl0l] Ol S (utf-8 2XAHE)

description dIOI Ol CHEH &Y (utf-8 22X E)

SRS DI EE AAH (utf-8 2X L) HA BHE
HIOIEHOIS 22 E LICHL"S2F X AlAE
HE"E BXSIAAIL.

SRSOrigin: [0o, 01, 02] XIE & SRS(float32 HHE) 2 2 A E. XIEE

SRSOIAM B SHIE MHE=
P = Pmesh + SRSOrigin2 L| C}.
S A LICH

root FE 3MXB Il (utf-8 2o A B2

=2
i
uin

o, 02 &M 3MX & ML LICH

-~

"3mxVersion": 1,
"name" :"Marseille"
"descr1pt10n"°"Marse111e was generated using InterAtlas’ oblique imagery system. ",
"logo"’"lnteratlas logo.png",
"sceneOptions":[{"navigation_mode":"PAN"}],
"layers": [
{
"type":"meshPyramid",
"id":"meshe",
"name" :"Marseille"
“descrlptlon"'"Thls is a description of the model. It should be between

quotation marks.",
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"SRS": "EPSG:32631",
"SRSOrigin": [692625,4798280,0],
"root": "Data/Marseille.3mxb"

—_

3MXB & &f %“%8 R ASEHAM 2SELOD A S [HSLICLOH SE= 49 =52 DolaE 280l
L

Colour code
UTF-8 strin,
number
JSON format Binary data

(o]
J&/127: 3MBX I} & &4/
3MXB I} S DA St "3MXBO" 2 A& ELICH 1 CHS S SH- I 613 2 I JI(HH0I £)2ILICH SH=
Ol 2l ®AI (S W 32)2 £+ LICH

e oltd=SHUZ S0l SULCLWH=E S22 & JSON 242 SH 30| 2 A4S LICH

version: 1

nodes: [node_datao, *-., node_data m] M O0oIH < HH""(’—.L S MOl CHaH
HLHAOQILICH =S CI0IE 9
FHx=dS &80 XNEELICH

o]

I'
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resources: [resource_datao, ‘., resource
_data ]

CEMERE AelLAEAY =
S2ah)0ll CHol ot Q1 el A A
GIELCIOIE Sl BRE S LICH 2l
CilOIE = OtcHOll XtAlol € & O
USLICH

pull g

SMXBItZ2 S 22 0l 8ioluel HIHZ 2= & LICH

Buffero: BHOIU 2l CIOIE HIH Y LICH HIH =& & JIEt
sd2dlHe elaA0 X EE L

Buffern: grold el CIOIE I & LICH.

= dolH

IOl 28tE == HOIBHE LM 2 = =20 e 2= BIEIHIOIEHE 2= LICHL

I

l JSON format

Bounding box Bounding box Maximum resolution X
= e = g & z Children: file paths Resource |Ds
minimum point maximum point on screen

id: Mo IDLICH Ol= IHY LHOIl M=
DROHXNSHA ELl 2Z0HM=
1= oHX Z &L

bbMin: [mino, min 1, minz] H2Y &AQ JI&E &2 IHE LICH
HIEd 8ftA=CE Ao 50 Z3gE
Z A HH2Y e AU LICH

bbMax: [maxo, max 1, maxz] Bt SAQ & 2 BUAYLICH
HIEd 8ftA= S E Ao 50 3
Z A HH2Y et AU LICH

maxScreenDiameter: dmax 0l ==t 200t & =T
ANEE=AYLICL3HA O ADIE
HoH ol sE=dg ot E(Ue
2 2)0l 2Io CHA &I o OF & LICH

children: [file_namey, . file_namey] L oot EE L Eote I (&
d2)=s5ALIC

resources: [geometry_IDo, CEE Mol @4 s=52LIGLIDE

-+, ,geometry_ID:] Ol 2lAA MO 2| AAS

Jtel 2 LICh.
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SO 2 AA RS HIO US & U2

U 0
Aoz IIsst B3Rt E’AEEE Olzist =2 DHolOF S LICH 0l2E “E= A H A0 CHE & AL
OloH HMIEI Xl 210 BOIX &£H HSHOF &S LIEIHELICLEIHZ oI &0l 3R Y 3H EH0I
o & maxScreenDiameter I]H?H HLEZ2E X NGIHSHE S EDFstal H= 2040 &2 LIEHHLICH

claA IOl &l
BICIOl 2l A 2 E0IA = 3MXB T+ 0

ZE dM SENMES BoE 2Zot= U ERE EEClAAE
SHUICH 2 2l AA0 et GOl CHE

20| &Lt

Resource j

AJSON format
n Type-dependentdata 0 (3 Type-dependentdatas
IAAIDE REd2AAE SN HEol= U AISELICL HE =0, IDE 42 SHIE =50 £=t6t1]
oY A0 H&ot= O At=E LICH

 textureBuffer - &l A T4 It 3MXB It & Ofl & E LICH

o geometryBuffer - SMXB It 2 0l A O+ £ BIOIU |l HIHZ £ H & LICH
o textureFile - A OF 2| 2 T 2 LICH

o geometryFile - Oi It 2/ = I LI Ct

HIH RE2 <L 8I0IUH2I OI0IEHE=E HIH 24Xl S otLEOIA ol O A0l 2 ELICL HHIHE elaA ZEd
HIH Z2HEUAN SLe Ul =AZ ZASLIT

1. textureBuffer
Bl AT HIH JSON HIOIEH = CtS 13t 201 +- & LICH
{

"type":"textureBuffer",
"id": "tex@",
"format": "jpg",
"size":1513,
}
d"e EAME Y UM D78t HA 02 AHEBHAIR MA ECl 20 = L7okKl 25LICH
"format” EH D= BIA X 0|01X2] RES LIEtELICHL A BHIH 2| 00| XI= 3MXB IH 0l A BEOI LA 2l
HIHZ JEELICLUI0IHC] GIOIE 2 2D|= "size" et 2 2 HAIELICH
2. geometryBuffer

& HIH HEHOIEH = TS0 2 s LT
{

type geometryBuffer",
id": "geometryl",
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"format": "ctm",

"size":835,

"bbMin": [-1243.69,-314.572,52.6138],
"bbMax" [1243 69,314.572,52.6138],
texture : "texo"

}

"id'e @A I UM D&t etaoz AMEGHXCH &N Ell 2XRUHAME DKR0HA ESLUICH

"texture" Ef 1= M EN AL 0|0 AN BIATHI A= K0S ZAIELICHO

AEELICH 22 Olo M & A2 "Texture buffer" A& 0l &2 & "tex0" &1 A X

"bbMin" & "bbMax" /= =& HIOIE{2 S LSt LAl Z H A HI2Y 8FA
3. textureFile

A M JSONE 2 HIS IJ| HA OI0I KDt 28 & 2R W2 B2 E LIEHHT= S8 M 26D
AN HIH2 O < = AFRLICH

{

"type“'"textureFlle ,

"format": "jpg",

"id": "tex1",

"file": "subfolder/SomeTexture.jpg",
}

4. geometryFile
AN I U OF&DHX 2 Saf I JSONOI = 2 2 Saf e s Jtel3= "file” Ef 10 2 & O ASLICH
{

"type":"geometryFile",

"format": "obj",

"id": "geometryl",

"file": "subfolder/SomeMesh.obj", "texture": "texl"

IDU:I J_EI-I

3MXB It 0l = 25 & H OHXIGHOF Gh= CHSH 2| AADN ZE S UASLICH 2N ASSUHZ elAA IDes
Lo eaAE YN HE6t= U AFSELICH

=
RN EXNes =2 Ed 242 UWSYLILL =2 HO0IHN=E =20 Hote 2E g 2Ll
L

IDE
Zot=clAA S0l ZSEH USLICLAEHS elAABE2 W0l A= otLt 0142 =0 2R8
EEclAaAS UESEULL SEQ 2IAAIDE O el AA DY HXIAAM CES SIS HAY =

USLICH

OfeH 0101 K10l A Node 00l = Resource 0 & Resource 1 & 40| U SLICH Resource 02 & A TIHY & 0|12
Resource 12 &4 HIH S & 0|11, 014 = Buffer 0 &0l &= & U SLICH Node 12 Buffer 10l = Resource
2EA0 2o FAEUCLAEHNM 2lAA E =M= HIHA CHoll = X & 2 2 Resource 20| CH St Buffer

12 AS R s 2 2 ELICL
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. Image of resource p is in buffer n
Maglc He.ader Header BUﬁer o m T m
number size

Geometry of resource 1 is in buffer 0
Version m Resources

Resource 0 | Resource 1 | Resource 2

Node 0 Node2 IR s .o

(geometry) (geometry) (geometry)

é Resource p
(texture)

'Y

Geometry resources used by node 0

Geometry resource used by node 1

Texture resource used by geometries 0 and 2

—18/128: 3MXBS |4 A A& M2 B0/ 2] GIOIHE LIEHA LD I 2 SAHE L]0/ E LIEFEILICH
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{
"version":1,
"nodes": [
{

"id":"node0@",
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
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"maxScreenDiameter":118.819,
"children": [ "Tile_p000 pooe poel L2060 00.3mxb"],
"resources":[ "geometryo"]

}
1,
"resources": [
{
"type":"textureBuffer",
“"format":"jpg",
"id":"textureo",
"size":1665
s
{
"type":"geometryBuffer",
“format"'"ctm R
'id":"geometryo",
"texture":"textureo",
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
"size":1233
}
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo 1id="0">
<ImagePath>0:IMAGE 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMAGE_1060.JPG</ImagePath>
</Photo>
<Photo id="2">
<ImagePath>0:IMAGE 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\DataSets\Motos\Images</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="2">
<Definition>EPSG:32629</Definition>

</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSId>2</SRSId>
<Poses>
<Pose id="0">
<Center>
<x>758987.198998479</x>
<y>4066970.60510875</y>
<z>39.1859999997541</z>
</Center>
</Pose>
<Pose id="1">
<Center>
<x>758989.05099848</x>
<y>4066972.78710875</y>
<z>39.1749999979511</z>
</Center>
</Pose>
<Pose id="2">
<Center>
<x>758990.900998479</x>
<y>4066974.97210875</y>
<z>39.1619999995455</z>
</Center>
</Pose>
</Poses>
<Photos>
<Photo id="0">
<ImagePath>0:Track B-CAM2-236_2017.05.
<PoseId>0</PoseId>
</Photo>

<Photo id="1">

<ImagePath>0:Track B-CAM2-235 2017.05.

<PoseId>1</PoselId>
</Photo>

<Photo id="2">

<ImagePath>1:Track B-CAM3-234_2017.05.

<PoseId>2</PoseId>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Railroad\planar2</Path>
</Reference>
<Reference id="1">
<Path>Q:\Datasets\Railroad\planar3</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Devices>
<Device id="0">
<Type>perspective</Type>
<Dimensions>
<width>1920</width>
<height>1080</height>
</Dimensions>
<PrincipalPoint>
<x>959.325756354222</%x>
<y>540.064799475902</y>
</PrincipalPoint>
<FocalLength>1161.90449945652</FocallLength>
<RadialDistortion>
<k1>-0.130619227934255</k1>
<k2>0.11343372341057</k2>
<k3>-0.0194519247358129</k3>
</RadialDistortion>
<TangentialDistortion>
<pl>0</pl>
<p2>0</p2>
</TangentialDistortion>
<AspectRatio>1</AspectRatio>
<Skew>0</Skew>
</Device>
</Devices>
<Poses>
<Pose id="0">
<Center>
<x>-0.242398388617219</x>
<y>-1.31312823176956</y>
<z>-0.170965236298314</z>
</Center>
<Rotation>
<omega>-1.71248177918815</omega>
<phi>0</phi>
<kappa>0.000184858673830527</kappa>
</Rotation>
</Pose>
<Pose id="1">
<Center>
<x>-0.120339121135225</x>
<y>-1.30028905810778</y>
<z>-0.17185130833636</z>
</Center>
<Rotation>
<omega>-1.71250988284902</omega>
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<phi>-0.0117559476346202</phi>
<kappa>-0.000475042115853361</kappa>
</Rotation>
</Pose>
<Pose id="2">
<Center>
<x>0.00121763429965454</x>
<y>-1.29989155916196</y>
<z>-0.166334627769606</z>
</Center>
<Rotation>
<omega>-1.71273910713164</omega>
<phi>-0.0528726572200851</phi>
<kappa>-0.00675225403620392</kappa>
</Rotation>
</Pose>
</Poses>
<Photos>
<Photo id="0">
<ImagePath>O:vlcsnap—2015—07—24—09h50m515786_gi§‘jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoseId>0</PoseId>
</Photo>
<Photo id="1">

<ImagePath>O:vlcsnap—2015—07—24—09h51m555443_3i5.jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoselId>1</Poseld>
</Photo>
<Photo id="2">
<ImagePath>0:vlcsnap-2015-07-24-09h52m39s752. jpg</ImagePath>
<DeviceId>0</DeviceId>
<PoselId>2</Poseld>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840ceb4bf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:2193</Definition>
</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSId>0</SRSId>
<Devices>
<Device id="0">
<Type>orthotile</Type>
<Dimensions>
<width>3200</width>
<height>4800</height>
</Dimensions>
<PixelSize>
<Width>0.075</Width>
<Height>-0.075</Height>
</PixelSize>
<NoData>-9999</NoData>
</Device>
</Devices>
<Photos>
<Photo id="0">
<ImagePath>0:BX24 500 025022.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1569040</U1X>
<U1Y>5181360</UlY>
</Location>
</Photo>
<Photo id="1">
<ImagePath>0:BX24 500_025021.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568800</U1X>
<U1Y>5181360</U1Y>
</Location>
</Photo>
<Photo id="2">
<ImagePath>0:BX24 500_025020.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568560</U1X>
<U1Y>5181360</U1Y>
</Location>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>Q:\DataSets\Christchurch\Images</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:32633</Definition>
</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSTId>0</SRSIdA>
<Devices>
<Device id="0">
<Type>orthotile</Type>
<Dimensions>
<width>2000</width>
<height>2000</height>
</Dimensions>
<Band>Visible</Band>
<PixelSize>
<Width>0.1</Width>
<Height>-0.1</Height>
</PixelSize>
<NoData>-9999</NoData>
</Device>
</Devices>
<Photos>
<Photo id="0">
<ImagePath>0:rgb part 1 2.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>533550.937633621</U1lX>
<U1Y>5212434.93763362</ULlY>
</Location>
<DepthPath>0:dsm part 1 2.tif</DepthPath>
</Photo>
<Photo id="1">
<ImagePath>0:rgb part 1 1.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>533350.937633621</U1X>
<U1Y>5212434.93763362</ULlY>
</Location>
<DepthPath>0:dsm part 1 1.tif</DepthPath>
</Photo>
</Photos>
</PhotoCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840ceb4bf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<MeshCollection>
<Meshes>
<Mesh id="0">
<Path>0:Production 1 3sm.3sm</Path>
</Mesh>
</Meshes>
</MeshCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Bridge</Path>
</Reference>
</References>
</ContextScene>

<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<MeshCollection>
<Meshes>
<Mesh id="0">
<Path>0:Production 1.3mx</Path>
</Mesh>
</Meshes>
</MeshCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840ceb4bf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="1">
<Definition>EPSG:25829</Definition>
</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSIdA>1</SRSId>
<PointClouds>
<PointCloud id="0">
<Path>0:point cloud.opc</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Spain</Path>
</Reference>
</References>
</ContextScene>

<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:25829</Definition>
</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSId>0</SRSId>
<PointClouds>
<PointCloud id="0">
<Path>0:spain.las</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>Q:\Datasets\Rail</Path>
</Reference>
</References>
</ContextScene>

<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="1">
<Definition>ENU:36.7127,-6.10034</Definition>
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</SRS>
</SpatialReferenceSystems>
<PointCloudCollection>
<SRSIdA>1</SRSId>
<PointClouds>
<PointCloud id="0">
<Path>0:PointCloud.pod</Path>
</PointCloud>
</PointClouds>
</PointCloudCollection>
<References>
<Reference id="0">
<Path>rds:7c00e184-5913-423b-8b4c-840ceb4dbf616</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo id="0">
<ImagePath>0:IMG 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMG 1060.JPG</ImagePath>
</Photo>
<Photo id="2">
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<ImagePath>0:IMG 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
<Annotations>
<Labels>
<Label id="3">
<Name>car</Name>
</Label>
<Label id="4">
<Name>motorcycle</Name>
</Label>
</Labels>
<Objects2D>
<ObjectsInPhoto>
<PhotoId>0</PhotoId>
<Objects>
<Object2D id="0">
<LabelInfo>
<Confidence>0.998535</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>

<xmin>0
<ymin>0
<xmax>0
<ymax>0

.0319100581109524</xmin>
.537032723426819</ymin>
.374318599700928</xmax>
.66499537229538</ymax>

</Box2D>
</Object2D>
<Object2D id="1">
<LabelInfo>
<Confidence>0.9965625</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0.877565920352936</xmin>
<ymin>0.4940065741539</ymin>
<xmax>1</xmax>
<ymax>0.62068098783493</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
<ObjectsInPhoto>
<PhotoId>1</PhotoId>
<Objects>
<Object2D id="0">
<LabelInfo>
<Confidence>0.9978036</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0</xmin>
<ymin>0.506300926208496</ymin>
<xmax>0.29727840423584</xmax>
<ymax>0.642435193061829</ymax>
</Box2D>
</Object2D>
<Object2D id="1">
<LabelInfo>
<Confidence>0.9839146</Confidence>
<LabelId>4</LabelId>
</LabelInfo>
<Box2D>

<xmin>0
<ymin>0
<xmax>0
<ymax>0
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
<ObjectsInPhoto>

.854629874229431</xmin>
.483299434185028</ymin>
.938638925552368</xmax>
.547508895397186</ymax>

<PhotoId>2</PhotoId>

<Objects>
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<Object2D id="0">
<LabelInfo>
<Confidence>0.9977607</Confidence>
<LabelId>3</LabelId>
</LabelInfo>
<Box2D>
<xmin>0.00155594770330936</xmin>
<ymin>0.516191422939301</ymin>
<xmax>0.274634718894958</xmax>
<ymax>0.636547446250916</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
</Objects2D>
</Annotations>
<References>
<Reference id="0">
<Path>Q:\Datasets\Motos</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<PhotoCollection>
<Photos>
<Photo id="0">
<ImagePath>0:IMG 1059.JPG</ImagePath>
</Photo>
<Photo id="1">
<ImagePath>0:IMG_1060.JPG</ImagePath>
</Photo>
<Photo id="2">
<ImagePath>0:IMG 1061.JPG</ImagePath>
</Photo>
</Photos>
</PhotoCollection>
<Annotations>
<Labels>
<Label id="0">
<Name>background</Name>
</Label>
<Label id="2">
<Name>bicycle</Name>
</Label>
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<Label id="6">
<Name>bus</Name>
</Label>
<Label id="7">
<Name>car</Name>
</Label>
</Labels>
<Segmentation2D>
<PhotoSegmentation>
<PhotoId>0</PhotoId>

<Path>Segmentation2D/0.png</Path>

</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>1</PhotoId>

<Path>Segmentation2D/1.png</Path>

</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>2</PhotoId>

<Path>Segmentation2D/2.png</Path>

</PhotoSegmentation>
</Segmentation2D>
</Annotations>
<References>
<Reference id="0">

<Path>rds:7c00e184-5913-423b-8b4c-840cebdbf616</Path>

</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">

<Definition>EPSG:2193</Definition>

</SRS>
</SpatialReferenceSystems>
<PhotoCollection>
<SRSId>0</SRSId>
<Devices>
<Device id="0">
<Type>orthotile</Type>
<Dimensions>

<width>3200</width>
<height>4800</height>

</Dimensions>
<Band>Visible</Band>
<PixelSize>

<Width>0.075</Width>
<Height>-0.075</Height>

</PixelSize>
<NoData>-9999</NoData>
</Device>
</Devices>
<Photos>
<Photo id="0">

<ImagePath>0:BX24 500 025022.tif</ImagePath>
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<DeviceId>0</DeviceId>
<Location>
<U1X>1569040</U1X>
<U1Y>5181360</U1Y>
</Location>
</Photo>
<Photo id="1">
<ImagePath>0:Bx24 500_025021.tif</ImagePath>
<DeviceId>0</DeviceId>
<Location>
<U1X>1568800</UlX>
<U1Y>5181360</U1Y>
</Location>
</Photo>
</Photos>
</PhotoCollection>
<Annotations>
<Labels>
<Label id="0">
<Name>background</Name>
</Label>
<Label id="1">
<Name>building</Name>

</Label>
<Label id="2">
<Name>car</Name>
</Label>
</Labels>
<Segmentation2D>

<PhotoSegmentation>
<PhotoId>0</PhotolId>
<Path>BX24 500 025022 mask .png</Path>
</PhotoSegmentation>
<PhotoSegmentation>
<PhotoId>1</PhotoId>
<Path>Bx24 500_025021_mask_.png</Path>
</PhotoSegmentation>
</Segmentation2D>
</Annotations>
<References>
<Reference id="0">
<Path>Q:\Datasets\Christchurch</Path>
</Reference>
</References>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"7?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>ENU:36.71339,-6.10019</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels>
<Label id="30">
<Name>light signal</Name>

</Label>

<Label id="29">
<Name>pole</Name>

</Label>

<Label id="28">
<Name>manhole</Name>

</Label>
</Labels>
<Objects3D>
<Object3D id="0">
<LabelInfo>
<LabelId>28</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>
<xmin>-18.2450134852094</xmin>
<ymin>-33.4309299351174</ymin>
<zmin>35.994338294097</zmin>
<xmax>-17.6879619720465</xmax>
<ymax>-32.9339199858639</ymax>
<zmax>36.0384178477738</zmax>
</Box3D>
<Rotation>

<M _00>0.923586176565216</M 00>
<M_01>-0.38339088989913</M 01>
<M 02>0</M 02>
<M 10>0.38339088989913</M 10>
<M 11>0.923586176565216</M 11>
<M 12>0</M 12>
<M _20>0</M 20>
<M _21>0</M 21>
<M 22>1</M 22>
</Rotation>
</RotatedBox3D>
</Object3D>
<Object3D id="9">
<LabelInfo>
<LabelId>29</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>
<xmin>20.9584511724897</xmin>
<ymin>12.319399747568</ymin>
<zmin>36.1015345364395</zmin>
<xmax>21.169238198679</xmax>
<ymax>12.4793676344069</ymax>
<zmax>36.9024438572005</zmax>
</Box3D>
<Rotation>
<M_00>-0.308218298834533</M_00>
<M 01>0.951315657530951</M 01>
<M_02>0</M_02>
<M 10>-0.951315657530951</M 10>
<M 11>-0.308218298834533</M_11>
<M _12>0</M 12>
<M _20>0</M_20>
<M _21>0</M 21>
<M _22>1</M 22>
</Rotation>
</RotatedBox3D>
</Object3D>
<Object3D id="17">
<LabelInfo>
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<LabelId>30</LabelId>
</LabelInfo>
<RotatedBox3D>
<Box3D>
<xmin>-14.2911021167082</xmin>
<ymin>-12.3380719723964</ymin>
<zmin>36.6555384788507</zmin>
<xmax>-12.9469008563212</xmax>
<ymax>-11.719230718431</ymax>
<zmax>40.9274766268461</zmax>
</Box3D>
<Rotation>
<M _00>-0.635254915386682</M 00>
<M _01>0.772302526525104</M 01>
<M 02>0</M_02>
<M 10>-0. 772302526525104</M 10>
<M711> 0. 635254915386682</M711>
<M_12>0</M 12>
<M _20>0</M_20>
<M 21>0</M 21>
<M 22>1</M 22>
</Rotation>
</RotatedBox3D>
</Object3D>
</Objects3D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>ENU:49.14651925,-122.8868741</Definition>
</SRS>
<SRS id="1">
<Definition>EPSG:26910</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels>
<Label id="2">
<Name>ground</Name>
</Label>
<Label id="5">
<Name>high vegetation</Name>
</Label>
<Label id="14">
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<Name>power line</Name>
</Label>
<Label id="20">
<Name>bridge</Name>
</Label>
<Label id="6">
<Name>roof</Name>
</Label>
</Labels>
<Segmentation3D>
<Tiles>
<Tile id="0">
<Path>Segmentation3D/chunk 0.ply</Path>
<BoundingBox>
<xmin>-250.491095842922</xmin>
<ymin>-249.9415383003</ymin>
<zmin>90.6222619490663</zmin>
<xmax>-105.678507545069</xmax>
<ymax>-134.42104353207</ymax>
<zmax>110.784205847665</zmax>
</BoundingBox>
</Tile>
<Tile id="1">
<Path>Segmentation3D/chunk 1.ply</Path>
<BoundingBox>
<xmin>-250.305457114898</xmin>
<ymin>-134.421020381375</ymin>
<zmin>90.5964914399069</zmin>
<xmax>-178.217349509926</xmax>
<ymax>-10.6211155119073</ymax>
<zmax>118.655770300872</zmax>
</BoundingBox>
</Tile>
</Tiles>
</Segmentation3D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<SpatialReferenceSystems>
<SRS id="0">
<Definition>EPSG:32615</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels>
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<Label id="0">
<Name>background</Name>
</Label>
<Label id="1">
<Name>crack</Name>
</Label>
</Labels>
<Lines2D>
<Line2D id="0">
<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>
<x>479868.86</x>
<y>4980803.44157715</y>
</Position>
<Diameter>0.0202617157732701</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>479868.712150948</x>
<y>4980803.47680339</y>
</Position>
<Diameter>0.0664043075900635</Diameter>
</Vertex>
<Vertex id="2">
<Position>
<x>479868.341404493</x>
<y>4980803.67640449</y>
</Position>
<Diameter>0.0686980153798615</Diameter>
</Vertex>
<Vertex id="3">
<Position>
<x>479868.468095477</x>
<y>4980803.63543635</y>
</Position>
<Diameter>0.0762712781246574</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>1</VertexId2>
</Segment>
<Segment>
<VertexIdl>1</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
</Segments>
</Line2D>
<Line2D id="1">
<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>
<x>479874.427917961</x>
<y>4980802.47</y>
</Position>
<Diameter>0.0185410197570828</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>479874.28053349</x>
<y>4980802.75</y>
</Position>
<Diameter>0.0339112355266864</Diameter>
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ContextCapture

</Vertex>
<Vertex id="2">
<Position>
<x>479874.373927691</x>
<y>4980802.67226102</y>
</Position>
<Diameter>0.0978553816042589</Diameter>
</Vertex>
<Vertex id="3">
<Position>
<x>479874.485410865</x>
<y>4980802.89236351</y>
</Position>
<Diameter>0.0908217292202603</Diameter>
</Vertex>
<Vertex id="4">
<Position>
<x>479874.37</x>
<y>4980802.64363961</y>
</Position>
<Diameter>0.0899999999783128</Diameter>
</Vertex>
<Vertex id="5">
<Position>
<x>479874.418415482</x>
<y>4980802.71591548</y>
</Position>
<Diameter>0.0813172786177372</Diameter>
</Vertex>
<Vertex id="6">
<Position>
<x>479874.83328093</x>
<y>4980803.53223969</y>
</Position>
<Diameter>0.0816060783607562</Diameter>
</Vertex>
<Vertex id="7">
<Position>
<x>479874.612768291</x>
<y>4980803.11426725</y>
</Position>
<Diameter>0.086105905882709</Diameter>
</Vertex>
<Vertex id="8">
<Position>
<x>479874.677758315</%x>
<y>4980803.21801663</y>
</Position>
<Diameter>0.0872066516702332</Diameter>
</Vertex>
<Vertex id="9">
<Position>
<x>479874.55828698</x>
<y>4980802.99093257</y>
</Position>
<Diameter>0.0900163930024753</Diameter>
</Vertex>
<Vertex id="10">
<Position>
<x>479874.755737061</x>
<y>4980803.36709735</y>
</Position>
<Diameter>0.0900001483887829</Diameter>
</Vertex>
<Vertex id="11">
<Position>
<x>479874.456513669</x>
<y>4980802.78786825</y>
</Position>
<Diameter>0.0969726626446287</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
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<VertexId2>4</VertexId2>

</Segment>

<Segment>
<VertexIdl>1</VertexIdl>
<VertexId2>2</VertexId2>

</Segment>

<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>5</VertexId2>

</Segment>

<Segment>
<VertexIdl>2</VertexIdl>
<VertexId2>4</VertexId2>

</Segment>

<Segment>
<VertexIdl>3</VertexIdl>
<VertexId2>9</VertexId2>

</Segment>

<Segment>
<VertexIdl>3</VertexIdl>
<VertexId2>11</VertexId2>

</Segment>

<Segment>
<VertexIdl>5</VertexIdl>
<VertexId2>11</VertexId2>

</Segment>

<Segment>
<VertexIdl>6</VertexIdl>
<VertexId2>10</VertexId2>

</Segment>

<Segment>
<VertexIdl>7</VertexIdl>
<VertexId2>9</VertexId2>

</Segment>

<Segment>
<VertexIdl>7</VertexIdl>
<VertexId2>8</VertexId2>

</Segment>

</Segments>
</Line2D>
</Lines2D>
</Annotations>
</ContextScene>
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<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="3.0">
<Annotations>
<Labels>
<Label id="1">
<Name>rail</Name>
</Label>
</Labels>
<Lines3D>
<Line3D id="1">
<LabelInfo>
<LabelId>1</LabelId>
</LabelInfo>
<Vertices>
<Vertex id="0">
<Position>
<x>3.27669495408764</x>
<y>-2.38028278379669</y>
<z>8.22511614762969</z>
</Position>
<Diameter>0.210008906878983</Diameter>
</Vertex>
<Vertex id="1">
<Position>
<x>3.22462717369163</x>
<y>-1.66835993119419</y>
<z>7.77181408678633</z>
</Position>
<Diameter>0.0646228165693428</Diameter>
</Vertex>
<Vertex id="2">
<Position>
<x>3.25055948322766</x>
<y>-2.50779389081678</y>
<z>8.30674826296262</z>
</Position>
<Diameter>0.187586254181419</Diameter>
</Vertex>
<Vertex id="3">
<Position>
<x>3.24724600068194</x>
<y>-2.45077881319647</y>
<z>8.27142235557896</z>
</Position>
<Diameter>0.131823435832277</Diameter>
</Vertex>
</Vertices>
<Segments>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>3</VertexId2>
</Segment>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>1</VertexId2>
</Segment>
<Segment>
<VertexIdl>0</VertexIdl>
<VertexId2>2</VertexId2>
</Segment>
</Segments>
</Line3D>
</Lines3D>
</Annotations>
</ContextScene>
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